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Важная для пользователя информация
Так как существует множество возможностей использования продуктов, описанных в

этой публикации, лица, ответственные за применение и использование данного

оборудования управления, должны убедиться в том, что были выполнены все

необходимые действия для обеспечения того, что каждое применение и

использование удовлетворяет всем требованиям функционирования и безопасности,

включая все применимые законы, положения, кодексы и стандарты.

Иллюстрации, диаграммы, примеры программ и схем, показанные в этом руководстве,

предназначены исключительно для демонстрационных целей. Так как существует

множество отличий и требований, связанных с любой конкретной инсталляцией,

Allen-Bradley не берет на себя ответственность или обязательство (включая

обязательство интеллектуальной собственности) по фактическому использованию,

основанному на примерах, показанных в этой публикации.

Публикация Allen-Bradley SGI-1.1 «Указания по безопасности при применении,
инсталляции и обслуживании твердотельного элемента управления» (которую вы

можете получить в вашем местном офисе Allen-Bradley) описывает некоторые важные

различия между твердотельным оборудованием и электромеханическими

устройствами, которые следует принимать во внимание при применении таких

продуктов, как те, которые описаны в этой публикации.

Полное или частичное воспроизведение содержимого этой защищенной законом об

авторском праве публикации без письменного разрешения Allen-Bradley Company, Inc.

воспрещено.

На всем протяжении этого руководства мы используем примечания, осведомляющие

вас о соображениях безопасности:

ВНИМАНИЕ: Определяет информацию о действиях и обстоятельствах,

которые могут привести к травме или смерти персонала, ухудшению

свойств или экономическим потерям.

Положения «Внимание» помогают вам:

• определить опасность

• избежать опасности

• осознать последствия

Примечание: Определяет информацию, критичную для успешного применения и

понимания продукта.

MicroLogix, SLC, PLC, PanelView, PanelBuilder и PanelBuilder32 – торговые знаки Rockwell Automation.

Microsoft, Windows и Windows NT – зарегистрированные торговые знаки Microsoft Corporation.

!
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Предисловие

Программное обеспечение PanelBuilder32 позволяет вам создавать приложения

панели управления для стандартного ряда PanelView Operator Terminals (терминалов

оператора PanelView). Так как эти терминалы предоставляют гибкие опции связи, вы

можете создавать приложения для выполнения в различных коммуникационных

средах, включающих:

• Data Highway Plus

• Remote I/O

• DH-485

• RS-232 (DH-485)

• DeviceNet

• ControlNet

• DF1

• Modbus и другие доступные протоколы

Вы можете просмотреть интерактивное руководство PanelBuilder32 Quick Start

(быстрое начало работы с PanelBuilder32) перед созданием вашего приложения. Оно

проведет вас по всем необходимым этапам создания примера приложения, включая

загрузку и выгрузку приложения на терминале PanelView. Релейно-контактная логика

предоставляется для каждого из приведенных выше протоколов связи.

Кому следует использовать это руководство

Используйте это руководство, если вы имеете отношение к разработке приложений

панели управления, которые будут запускаться на терминалах PanelView.

Вам следует иметь основные представления о продуктах PLC®, ControlLogix™, SLC 500™ и

MicroLogix™, а также о сетевом окружении, в котором приложение будет запускаться.

Если это не так, свяжитесь с вашим местным представительством Allen-Bradley по

поводу надлежащей подготовки перед использованием этого продукта.
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Цель этого руководства

Это руководство предоставляет информацию о том, как использовать программное

обеспечение PanelBuilder32. Оно дополняет подробную интерактивную справочную

систему, которая доступна из самого программного обеспечения.

Содержание этого руководства

Глава

1

2

3

4

5

6

7

8

9

10

11

Название

Предисловие

Инсталляция

PanelBuilder32

Использование

PanelBuilder32

Приложения и экраны

Работа с экранными

объектами

Работа с сигналами

тревоги

Работа с текстом

Работа с графикой

Форматирование

объектов

Использование

редактора тегов

Настройки

приложения

Передача

приложений

Содержимое

Разъяснена цель и приведен обзор этого руководства, а также перечислена полезная

интерактивная документация. Кроме того, указано, кому это руководство

предназначено.

Показано, как инсталлировать PanelBuilder32 с компакт-диска.

Охвачены основы использования программного обеспечения PanelBuilder32 и

продвижения по нему.

Описаны основные действия, такие как открытие, закрытие и сохранение, которые вы

можете выполнять над файлами приложений и экранами.

Дан обзор доступных объектов управления и отображения, включающий создание и

конфигурирование объектов. Эта глава также предоставляет основную информацию

об объектах, которой вам следует владеть, включающую выбор, масштабирование,

перемещение, выравнивание и редактирование объектов.

Предоставлен обзор компонентов сигналов тревоги (окна аварийной сигнализации,

списка сигналов тревоги, сообщений сигналов тревоги, инициаторов сигналов

тревоги), и как конфигурировать эти компоненты.

Показано, как вводить и форматировать текст в объектах и непосредственно на

экране. Также описано, как использовать текстовый редактор приложения для работы

с текстовыми строками и как вводить текст на других языках.

Показано, как добавлять на экран или в объект простую графику, такую как линии,

ломаные линии, прямоугольники, эллипсы, символы ISA и растры. Также показано, как

импортировать растры, созданные с помощью других программ, и как экспортировать

растры для редактирования.

Описаны различные инструменты, которые вы можете использовать для изменения

внешнего вида объектов, например, изменения цвета.

Описано, как использовать редактор тегов для ввода и редактирования тегов вашего

приложения. Также описано, как импортировать / экспортировать теги с

использованием поддерживаемых форматов файлов.

Показано, как конфигурировать сетевые настройки, которые позволят вашему

терминалу осуществлять связь с логическим контроллером, настройки включения

терминала и настройки принтерного порта, опции дисплея и другие дополнительные

опции.

Охвачены основы загрузки и выгрузки приложений, включая доступные опции

передачи.
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Интерактивная документация

Чтобы вам было удобно, мы предоставляем вам интерактивные PDF-версии всех

руководств PanelBuilder32 и PanelBuilder в дополнение к интерактивной справочной

системе. PDF-файлы содержатся на инсталляционном компакт-диске. Для получения

информации о том, как использовать Adobe Acrobat Reader, выберите Reader Online

Guide (интерактивное руководство Reader) в меню Help (справка) при просмотре

PDF-файла.

Файлы Adobe Acrobat .PDF имеются для следующих документов:

Публикация

2711-6.19

2711-6.20

2711-6.1

Описание

Руководство «Получение результатов с помощью PanelBuilder32»

Руководство «Быстрое начало работы с PanelBuilder32»

Руководство «Терминал оператора PanelView»

Документы PanelBuilder

Публикация

2711-6.0

2711-6.1

2711-6.2

Документы PanelBuilder32

Описание

Руководство «Программное обеспечение PanelBuilder»

Руководство «Терминал оператора PanelView»

Руководство «Начало работы с PanelBuilder»

Документы PanelBuilder для протоколов связи

Публикация

2711-6.10

2711-6.0.4

2711-6.9

Описание

Связи ControlNet для терминалов PanelView

Связи DeviceNet для терминалов PanelView

Связи Modbus для терминалов PanelView
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Техническая поддержка

Если у вас возникли какие-либо вопросы по программному обеспечению

PanelBuilder32 или по терминалам PanelView, в первую очередь, пожалуйста,

обратитесь к интерактивным руководствам и интерактивной справочной системе. Если

вы не можете найти ответ, обратитесь в Международную службу технической

поддержки Rockwell Automation:

Rockwell International

Technical Support

6680 Beta Drive

Mayfield Village, Ohio 44143

Или, для получения технической поддержки, позвоните по телефону 1-440-646-7800

или отправьте факс по адресу 1-440-646-7801 с 8 до 17 часов в любой день с

понедельника по пятницу.

Представительство компании Rockwell Automation в Москве:

113054, Москва, Большой Строченовский пер., 22/25, Офис 402

Телефон: (095) 956-0464, (095) 956-0465

Факс: (095) 956-0469

E-mail: software@rockwell.ru, info@rockwell.ru

При обращении в Службу технической поддержки будьте готовы назвать серийный

номер вашей копии продукта. Его можно найти, выбрав Help (справка) > About (о

продукте) в меню PanelBuilder32.

Наиболее часто задаваемые вопросы

Документы, содержащие ответы на наиболее часто задаваемые вопросы, доступны по

следующим каналам:

• служба AutoFax по адресу 1-440-646-5436

Этот алфавитный указатель предоставляет каталог доступных документов,

отправка которых по факсу может осуществляться 24 часа в день 7 дней в неделю.

• web-сайт www.ab.com – выберите Rockwell Automation Technical Support (Служба

технической поддержки Rockwell Automation), а затем Knowledge Base (основа

знаний).

Модернизация программного и аппаратно-программного обеспечения

При появлении новых особенностей и расширений вы можете модернизировать вашу

копию программного обеспечения PanelBuilder32 и аппаратно-программного

обеспечения PanelView. Для получения модернизации программного обеспечения:

• обратитесь в ваш местный торговый офис Allen-Bradley

• обратитесь в Rockwell Software по телефону 1-440-646-7700 или по факсу

1-440-646-7701

• посетите web-сайт www.software.rockwell.com. Под Support (техническая

поддержка) выберите Software Updates (обновления программного обеспечения)

и найдите PanelBuilder32 или 2711-ND3.

Для получения модернизации аппаратно-программного обеспечения вашего

терминала PanelView:

• обратитесь в Rockwell Software по телефону 1-440-646-7700

• посетите web-сайт www.ab.com и осуществите загрузку модернизации, выбрав

Rockwell Automation Technical Support, а затем загрузку файла.
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Что нового в PanelBuilder32

Окно Application

Новое окно Application (приложение) предоставляет в графическом виде приложение

и все его элементы, так что вы можете принять необходимое решение по управлению

вашим приложением с одного взгляда. Его раскрывающиеся / закрывающиеся папки

предоставляют быстрый доступ к ключевым компонентам, включающим экраны,

настройки приложения, сигналы тревоги и др.

Диалоговое окно запуска

Для упрощения процесса запуска каждый раз при запуске вами PanelBuilder32

открывается диалоговое окно, предлагающее вам создать, открыть, загрузить или

выгрузить приложение.

Окно Exceptions

Новое улучшенное окно Exceptions (исключения) упрощает процесс исправления

ошибок во время проверки приложения. Кроме продвижения к источнику ошибки вы

теперь можете отобразить или распечатать справку по каждой ошибке или

предупреждению.

Режим блокнота

В режиме блокнота вдоль нижней части рабочего пространства расположены закладки

для всех открытых экранов. Каждая закладка помечена именем приложения, номером

и именем экрана. Эта информация будет отображена при задержке указателя мыши

над закладкой. Закладка активного экрана – всегда поверх остальных. Для

активизации экрана просто щелкните закладку.

Поддержка технологии перетаскивания

Технология перетаскивания доступна для основных операций и может сохранить ваше

время. Вы можете быстро перетаскивать объекты с экрана на экран или даже в другое

приложение. Вы можете также перетаскивать экраны между двумя различными

приложениями.

Новые инструменты выравнивания

Меню Arrange (размещение) имеет новые инструменты выравнивания объектов по их

краям или центрам, распределения объектов горизонтально или вертикально или

переворачивания объектов сверху вниз.

Новшества в панелях инструментов

Панели инструментов, окна инструментов и палитра цветов теперь могут быть

включены и выключены с помощью диалогового окна View (просмотр) > Toolbars

(панели инструментов). Панели инструментов могут свободно перемещаться как

любое другое окно или быть пристыкованы (прикреплены) к верхнему, нижнему,

левому или правому краю окна PanelBuilder32.

Подсказки инструментов и данных

Подсказки инструментов помогают вам найти и распознать инструменты на панелях

инструментов, в окнах инструментов или в палитрах. Чтобы увидеть назначение

инструмента, просто задержите на нем указатель мыши.

Подсказки данных предоставляют быстрый доступ к информации об объектах,

включающей их тип, имя / адрес тега, имя узла, количество состояний, описание, их

глобальный и групповой статус. Чтобы увидеть выбранную пользователем подсказку

данных некоторого объекта, просто задержите указатель мыши на этом объекте.
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Меню, появляющиеся при нажатии правой кнопки

Меню, появляющиеся при нажатии правой кнопки, теперь доступны практически в

любой точке приложения для выполнения наиболее часто используемых действий.

Просто щелкните правой кнопкой мыши некоторый элемент и выберите нужную

опцию в контекстном меню.

Опции настройки PanelBuilder32

Вы можете теперь настроить или установить значения по умолчанию многим

действиям в диалоговом окне Tools (инструменты) > Options (опции). Например, вы

можете настроить режим по умолчанию для опускаемых экранных объектов, задать

содержимое и формат отчетов приложений и изменить местоположения по

умолчанию сохраняемых файлов приложений. Для получения более подробной

информации щелкните кнопку Help (справка) этого диалогового окна.

Просмотр размера приложения

Используйте команду Application > Application Size (размер приложения) для

проверки размера вашего приложения перед загрузкой его на терминал PanelView. Эта

команда производит сравнение размера в байтах и использования оперативной

памяти вашего приложения с размером в байтах и пределом размера оперативной

памяти терминала PanelView.

Модернизация 16-разрядных приложений

16-разрядные приложения, созданные с помощью любой ранней версии PanelBuilder,

легко модернизируются до 32-разрядного формата файла с использованием команды

File (файл) > Open (открыть). Вы можете также сохранять 32-разрядные приложения в

16-разрядном формате файла, используя File > Save As (сохранить как). Эти файлы,

однако, не поддерживают новые особенности PanelBuilder32, так как вы сохраняете в

формате более ранней 2.60 версии PanelBuilder.

Выгрузка и загрузка

Диалоговые окна Upload (выгрузка) и Download (загрузка) были упрощены для вашего

удобства. Эти диалоговые окна в WinPFT File Transfer Utility (утилите передачи файлов

WinPFT), которая может использоваться без запуска PanelBuilder32, почти одинаковы,

что делает процесс передачи более легким.

Доступна подробная интерактивная справочная система

Подробная интерактивная справочная система доступна практически в любой
точке приложения.

• Контекстно-зависимая справка меню и пиктограмм – перетащите пиктограмму

контекстной справки (стрелку с вопросительным знаком) поверх команды меню

или кнопки панели инструментов для получения краткого описания команды меню

или кнопки.

• Справка диалогового окна – контекстно-зависимая справка доступна для

отдельных элементов диалогового окна, кроме того, вы можете получить справку

по диалоговому окну в целом, нажав кнопку Help.

• Основная справочная система – доступна при выборе Contents (содержание) в

меню Help. Используйте закладку Contents для просмотра содержания

справочной системы. Используйте закладку Index (алфавитный указатель) для

поиска тем в алфавитном указателе справочной системы. Используйте закладку

Find (поиск) для поиска слов или фраз в темах справочной системы.
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1 Инсталляция PanelBuilder32

В этой главе объясняется, как инсталлировать PanelBuilder32 с компакт-диска на

жесткий диск.

• системные требования

• инструкции по инсталляции

• запуск и останов PanelBuilder32

Обзор

PanelBuilder32 инсталлируется непосредственно с компакт-диска на жесткий диск.

Компакт-диск также содержит процедуру инсталляции 16-разрядной версии 2.60

PanelBuilder. Обращайтесь к PDF-версии публикации 2711-6.0 для получения более

подробной информации об инсталляции.

Системные требования

• PC-совместимый процессор Pentium® II с тактовой частотой 100 МГц или лучший

• Операционная система Windows® 95, Windows 98 или Windows NT® 4.0 или более

поздняя

• 65 Мб свободного дискового пространства требуется для минимальной

инсталляции

• 85 Мб свободного дискового пространства требуется для инсталляции полного

пакета

• 32 Мб инсталлированной оперативной памяти (рекомендуется 48 Мб)

• Устройство чтения компакт-дисков

• 500 Кб свободной обычной (conventional) памяти
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Инсталляция PanelBuilder32

Перед началом инсталляции закройте все активные приложения.

Для инсталляции PanelBuilder32:

1. Вставьте компакт-диск в устройство чтения компакт-дисков. Программа

инсталляции настроена на автоматический запуск. Если автоматического запуска

не происходит, запустите Setup.exe на компакт-диске.

2. Следуйте инструкциям на экране. По умолчанию PanelBuilder32 инсталлируется в

C:\Program Files\Allen-Bradley\PanelBuilder.

3. Программа инсталляции предлагает вам выбрать тип установки:

Typical: Типичная – Инсталлирует все опции PanelBuilder32 и предназначена для

типичного пользователя.

Typical (without RSLinx): Типичная (без RSLinx) – Инсталлирует PanelBuilder32 без

RSLinx. Выберите эту опцию, если вы уже инсталлировали необходимую версию

RSLinx.

Compact: Компактная – Инсталлирует PanelBuilder без RSLinx, External Fonts или

Support Files . Выберите эту опцию, если вы осуществляете инсталляцию на

компьютер с ограниченными ресурсами.

Custom: Заказная – Выберите эту опцию, если вы опытный пользователь и желаете

настроить выбор опций инсталляции. Дисковое пространство, требуемое для

каждой опции, приводится вместе с доступным дисковым пространством.

Выбираемые компоненты

Program Files

(программные файлы)

RSLinx

External Fonts

(внешние шрифты)

Debug Symbols

(отладочные символы)

Support Files

(файлы поддержки)

Описание

Все файлы, необходимые для запуска PanelBuilder32.

Инсталлирует RSLinx, что необходимо для

конфигурирования драйверов связи для передачи

приложений.

Инсталлирует FontTool Utility (утилиту FontTool),

используемую для создания шрифтовых файлов для

приложений PanelBuilder32.

Инсталлирует диагностические файлы, используемые

для технической поддержки.

Инсталлирует демонстрационные файлы, файлы

примеров, библиотечные файлы и файлы

документации, включая интерактивную справочную

систему.

4. По окончании инсталляции программы PanelBuilder32 появляются в меню Start

(пуск) под Programs (программы) > PanelBuilder32.

Программы RSLinx появляются в меню Start под Programs > Rockwell Software.
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Запуск и останов PanelBuilder32

Для запуска PanelBuilder32:

1. В меню Start (пуск) щелкните Programs (программы).

2. Выберите PanelBuilder32, а затем щелкните PanelBuilder.

Появляется экран запуска с информацией об авторском праве и о реализации, за

которым следует диалоговое окно, которое позволяет вам создавать, открывать,

загружать или выгружать приложение.

Для останова PanelBuilder32:

1. В меню File (файл) щелкните Close (закрыть). Все открытые экраны текущего

приложения закрываются.

Если вы сделали какие-либо изменения в приложении после последнего

сохранения, вам будет предложено сохранить приложение перед закрытием.

2. Выберите Exit (выход) в меню File.
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2 Использование PanelBuilder32

Как большинство приложений Windows, PanelBuilder32 использует меню, панели

инструментов, диалоговые и рабочие окна для выполнения операций. В этой главе

охватываются:

• диалоговое окно запуска

• окно приложения

• окно экрана

• панели инструментов

• строка статуса

• меню, появляющиеся при нажатии правой кнопки

• настройка установок и значений по умолчанию

• интерактивная справочная система

Диалоговое окно запуска

Каждый раз, когда вы запускаете PanelBuilder32, открывается диалоговое окно запуска,

осведомляющее вас о доступных для выполнения операциях: создание, открытие,

загрузка или выгрузка приложения. Это равносильно выбору команды в меню File

(файл).

Указание: Вы можете сделать недоступным это диалоговое окно на закладке

General (основные) диалогового окна Tools (инструменты) > Options

(опции).

Равносильно File > New (новый)

Равносильно File > Open (открыть)

Равносильно File > Upload (выгрузить)

Равносильно File > Download (загрузить)
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Окно Application

Всякий раз когда вы открываете новое или существующее приложение, появляется

окно Application (приложение). Это окно предоставляет полный обзор приложения.

Его раскрывающиеся / закрывающиеся папки предоставляют быстрый доступ к

ключевым компонентам приложения. Просто дважды щелкните пиктограмму в папке

для открытия экрана, диалогового окна или таблицы. Операции, доступные в окне

Application, также доступны и в меню.

Окно Application может быть пристыковано или зафиксировано с левой стороны окна

PanelBuilder32, чтобы оно не мешало обзору экранов приложений. Когда оно

отстыковано (или свободно перемещается) вы можете перемещать или

масштабировать окно Application как и любое другое окно. Окно Application

пристыковывается или отстыковывается в меню View (просмотр).

Если открыто несколько приложений, окно Application появляется для каждого

приложения.

Щелкните + для открытия папки

Щелкните - для закрытия папки

Для открытия пиктограммы дважды

щелкните или щелкните правой кнопкой

эту пиктограмму и выберите Open

(открыть) в контекстном меню

Каждая пиктограмма представляет

закладку диалогового окна Application

Settings

Каждая пиктограмма представляет экран

приложения
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Папки приложения

System

(системная)

Application Settings

(настройки приложения)

Alarms

(сигналы тревоги)

Screens

(экраны)

Дважды щелкните эту пиктограмму:

Description (описание)

Print Only Objects

(печатать только объекты)

Exceptions (исключения)

Text Editor (текстовый редактор)

Tag Database (база тегов)

Terminal Setup (настройка терминала)

Communications Setup

(настройка связей)

Display Maintenance

(поддержка дисплея)

External Fonts (внешние шрифты)

Printer (принтер)

Status Tags (теги статуса)

Control Tags (теги управления)

Time / Date (время / дата)

Advanced (дополнительные)

Power-Up (включение)

Setup (настройка)

Alarm Triggers

(инициаторы сигналов тревоги)

Alarm Messages

(сообщения сигналов тревоги)

Например:

Alarm Banner

1 –Motor Speed 1

2 –Motor Status 2

Для:

Ввода описания или переименования приложения.

Конфигурирования объекта, который печатает

инициированные сообщения (для терминалов,

которые поддерживают печать).

Открытия окна Exceptions, которое показывает

ошибки и предупреждения, возникающие при

проверке приложения.

Открытия редактора Text Editor, который содержит

все текстовые строки, определенные в приложении.

Открытия таблицы Tag Editor (редактора тегов),

которая определяет все теги чтения и записи в

приложении.

Изменения выбранного терминала для приложения.

Определения настроек терминала / контроллера для

сетевого функционирования в процессе выполнения.

Настройки графика восстановления экрана

конкретных терминалов PanelView.

Предоставления возможности использования

внешнего шрифтового файла, который используется

для ввода текста приложения на другом языке.

Шрифтовые файлы создаются с помощью утилиты

FontTool.

Конфигурирования принтерного порта и опций

печати терминала с портом RS-232.

Определения тегов, используемых контроллером для

контроля номера текущего экрана, времени или даты.

Определения тегов, используемых контроллером для

изменения текущего экрана, времени или даты.

Определения формата, в котором дата / время будут

появляться на терминале. Все объекты, которые

отображают время или дату, используют этот формат.

Конфигурирования таких опций как хранитель

экрана, настройки дисплея, настройки автоповтора

клавиш / сенсорных ячеек.

Конфигурирования таких значений по умолчанию при

включении терминала как экран запуска.

Конфигурирования глобальных параметров всех

сигналов тревоги.

Определения инициаторов сообщений сигналов

тревоги.

Конфигурирования сообщений сигналов тревоги.

Открытия экрана. Пиктограмма с именем и номером

появляется для каждого экрана приложения. Экраны

появляются в последовательном порядке в папке

Screens.
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Окно Screen

Окно Screen (экран), напоминающее лицевую панель терминала, появляется, когда вы

открываете новый или существующий экран. В заголовке показывается имя и номер

экрана. Экраны перемещаются и масштабируются подобно любому другому окну.

Вы можете опускать объекты внутрь области отображения экрана или на

функциональную клавишу в зависимости от типа терминала. Форма указателя мыши

изменяется на перекрестие (+), объекты опускаются в любую из этих областей. Доступ

к объектам осуществляется в меню Objects (объекты) или Toolbox (окно инструментов),

доступных в диалоговом окне View > Toolbars (панели инструментов). Выберите объект

и щелкните в экране для размещения объекта с размером по умолчанию, или

перетащите указатель для масштабирования объекта.

Сенсорная сетка

В терминалах с сенсорным экраном используется сенсорная сетка для выравнивания

таких объектов управления как кнопки по сенсорным ячейкам. Кнопки перемещаются

и масштабируются с шагом сенсорных ячеек. Размер сенсорной сетки (количество

сенсорных ячеек) различен для каждого терминала. Чтобы показать или спрятать

сетку выберите View > Touch Grid (сенсорная сетка). Сенсорная сетка активна для

объектов ввода, даже если ее просмотр выключен.

Для выравнивания дисплея или графических объектов на терминалах с сенсорным

экраном используйте Grid (сетку).

Сетка

Сетка также доступна на терминалах Keypad (с малой клавиатурой) для выравнивания

объектов. Шаг сетки по умолчанию настроен для экранов в соответствии с типом

терминала. Вы можете изменить шаг сетки при создании нового экрана или при

изменении свойств экрана. Чтобы показать или спрятать сетку, выберите View > Grid.

Указание: Для терминалов с малой

клавиатурой вы можете показать или

спрятать малую клавиатуру с помощью

меню View (просмотр).
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Панели инструментов

В PanelBuilder32 доступно 8 панелей инструментов. Они предоставляют доступ к

командам и диалоговым окнам с помощью простого щелчка кнопки. Изначально

большинство панелей инструментов пристыкованы (или прикреплены) под строкой

меню.

Все панели инструментов могут свободно перемещаться или быть пристыкованы. Для

отстыковки панели инструментов щелкните один из ее краев и перетащите панель в

середину экрана. Отстыкованная панель инструментов выглядит так же, как любое

другое окно. Для пристыковки панели инструментов перетащите ее к любому краю

экрана – верхнему, нижнему, левому или правому. Вы также можете дважды щелкнуть

панель инструментов, чтобы пристыковать ее или сделать свободно перемещаемой.

Как показать или спрятать панели инструментов

Для доступа к панелям инструментов выберите View (просмотр) > Toolbars (панели

инструментов), а затем выберите опции рядом с панелями инструментов, которые вы

хотите отображать. Чтобы спрятать панель инструментов, отмените выбор

соответствующей опции.

Подсказки инструментов

Если вы поместите указатель мыши на пиктограмму (панели инструментов, окна

инструментов или палитры цветов), не щелкая, под пиктограммой появится

вспомогательная подсказка, упоминаемая как подсказка инструмента. Подсказки

инструментов можно сделать доступными или недоступными в диалоговом окне View >

Toolbars.

Если вы хотите получить дополнительную справку, выберите пиктограмму стрелки на

панели инструментов или нажмите SHIFT+F1, а затем щелкните любую пиктограмму.

Панели инструментов,

пристыкованные к верхней

части окна

Панель инструментов,

пристыкованная к нижней

части окна

Панель

инструментов,

пристыкован-

ная к левому

краю окна

Свободно

перемещаю-

щаяся панель

инструментов
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Standard Toolbar (панель стандартных инструментов)

Обеспечивает управление файлами / экранами и предоставляет инструменты

редактирования.

State Toolbar (панель инструментов состояния)

Обеспечивает доступ к объекту с несколькими состояниями или объекту списка,

режиму внутреннего текста и режиму внутренней графики. Также содержит

пиктограммы масштабирования для увеличения или уменьшения обзора экрана.

Inner Text Toolbar (панель инструментов внутреннего текста)

Обеспечивает ввод, форматирование и выравнивание текста в объектах. С помощью

этой панели инструментов вы также можете вставлять в текст переменные или

открывать Text Editor (текстовый редактор) приложения.

Format Toolbar (панель инструментов форматирования)

Обеспечивает применение форматирования к объектам, такого как тип линии, заливка,

форма, реверсивное изображение и мерцание. Также содержит пиктограммы

группировки / разгруппировки объектов и порядка размещения объектов.

Graphics Toolbar (панель инструментов графики)

Предоставляет список растров и символов ISA, которые вы можете вставлять в объект.

Вы можете также импортировать графику с помощью этой панели инструментов.

ISA Symbols Toolbox (окно инструментов символов ISA)

Содержит стандартные символы ISA. Вы можете опускать эти объекты

непосредственно на экран или вставлять их в объект в режиме Inner Graphic

(внутренняя графика).

Это окно инструментов изначально

открывается как свободно перемещаемое

окно.
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Toolbox (окно инструментов)

Содержит объекты (элементы управления, дисплеи, сигналы тревоги, графику),

которые вы можете опускать на экран. К этим объектам также можно обращаться в

меню Objects (объекты).

Color Palette (палитра цветов)

Обеспечивает применение цветов переднего и заднего плана к объектам, тексту или

графике. Для цветных терминалов палитра поддерживает 16 стандартных цветов EGA.

Для полутоновых терминалов палитра поддерживает 4 цвета (градаций серого).

Щелкните левой кнопкой в ячейке цвета для применения цвета переднего плана к

выделению. Щелкните правой кнопкой в ячейке цвета для применения цвета заднего

плана к выделению.

Окно обновляется в соответствии с выбранными цветами переднего и заднего плана

Строка статуса

Строка в нижней части окна отображает информацию о команде или кнопке панели

инструментов, о выполняемой операции или местоположении точки вставки.

При создании или выборе объекта на экране приложения строка статуса отображает

следующую информацию:

                               

Идентификационный номер объекта (назначаемый PanelBuilder32)

Координаты верхнего левого угла объекта (в пикселах) относительно верхнего левого угла экрана (X=0, Y=0)

Окно инструментов изначально

открывается как свободно

перемещаемое окно.

Ширина и высота объекта (в пикселах) Местоположение точки вставки Выбранный объект
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Меню, появляющиеся при нажатии правой кнопки

Меню, появляющиеся при нажатии правой кнопки, доступны для наиболее часто

используемых задач. Просто щелкните правой кнопкой мыши некоторый элемент и

выберите нужную опцию в меню. Меню, появляющиеся при нажатии правой кнопки,

доступны, когда вы:

• Редактируете объект. Выберите объект, а затем щелкните правой кнопкой для

копирования, вырезания, вклеивания, удаления объекта или для редактирования

свойств объекта.

• Редактируете экран. Выберите экран в папке Screens (экраны) окна Application

(приложение). Затем щелкните правой кнопкой для создания, открытия,

копирования, вырезания, удаления или редактирования свойств экрана.

• Прячете или показываете панель инструментов. Щелкните правой кнопкой в

области панели инструментов, чтобы спрятать или показать панель инструментов,

окно инструментов или палитру.

• Редактируете состояния объектов с несколькими состояниями. Щелкните правой

кнопкой в таблице States (состояния) диалогового окна объекта для добавления,

удаления или редактирования состояний объекта, или для вставки переменной в

текстовое поле.

• Редактируете сообщения и инициаторы сигналов тревоги. Щелкните правой

кнопкой в таблице Alarm Messages (сообщения сигналов тревоги) или Alarm

Triggers (инициаторы сигналов тревоги) диалогового окна Alarms (сигналы

тревоги) для добавления, удаления и редактирования сигналов тревоги или

инициаторов.

• Редактируете текст приложения. Щелкните правой кнопкой в таблице Text Editor

(текстового редактора) для добавления, удаления или редактирования текстовых

строк в приложении.

• Исправляете ошибки проверки. Выберите ошибку или предупреждение в окне

Exceptions (исключения), а затем щелкните правой кнопкой для продвижения к

источнику ошибки, исправления, печати ошибки или получения по ней справки.

Вы можете также спрятать или пристыковать окно Exceptions.

• Редактируете теги. Щелкните правой кнопкой в Tag Editor (редакторе тегов) для

копирования, вырезания, вклеивания, вставки, дублирования, удаления или

сортировки тегов.
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Настройка установок и значений по умолчанию

Вы можете настроить или установить предопределения для многих операций

PanelBuilder32, выбрав Options (опции) в меню Tools (инструменты).

Для получения более подробной информации о

настройке установок в основной справочной

системе откройте книгу Customizing

PanelBuilder32 (настройка PanelBuilder32) на

закладке Contents (содержание).

Выберите эту закладку:

General

(основные)

Default Terminal Selection

(выбор терминала по

умолчанию)

Report Setup

(настройка отчета)

Objects

(объекты)

Save

(сохранение)

Tag Edit

(редактирование тегов)

Tag Defaults

(значения по умолчанию

для тегов)

Для:

• Разрешения / запрещения отображения диалогового окна запуска при запуске

PanelBuilder32.

• Разрешения / запрещения автоматического создания экрана 1 при создании нового

приложения.

• Изменения количества последних использованных файлов, появляющихся в последней

секции меню File (файл).

• Разрешения или запрещения создания резервных (.BAK) файлов приложений

PanelBuilder32.

• Разрешения / запрещения автоматического назначения функциональных клавиш объектам

при их создании.

Выбора терминала PanelView для использования в качестве терминала по умолчанию для всех

новых приложений, которые создаются.

• Определения тем или атрибутов для включения в отчеты приложений.

• Определения формата титульной страницы и колонтитулов страниц для отчетов

приложений.

• Конфигурирования режима размещения объектов (размещение одного объекта или

нескольких объектов одинакового типа и дополнительное отображение свойств объекта

при его размещении).

• Разрешения / запрещения отображения подсказок данных для объектов при задержании

курсора мыши на объекте и задания того, что будет отображаться в подсказках данных.

• Сохранения файлов .PBA и .PVA при загрузке приложения.

• Изменения местоположений по умолчанию для сохранения файлов приложений

PanelBuilder32 и файлов проектов. Начальные значения по умолчанию определяются при

инсталляции.

Определения значений по умолчанию атрибутов тегов. Эти значения используются при

создании вами новых тегов или при импорте тегов в Tag Editor (редакторе тегов).

Определения значений по умолчанию для использования при дублировании тегов в Tag Editor с

использованием команды Duplicate Once (однократное дублирование) или Duplicate Several

(многократное дублирование).
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Использование интерактивной справочной системы PanelBuilder32

PanelBuilder32 предоставляет подробную интерактивную справочную систему для

содействия в разработке вами приложения. Интерактивная справочная система

включает обзорную информацию, поэтапные алгоритмы и контекстно-зависимую

справку. Для просмотра интерактивной справочной системы при использовании

PanelBuilder32:

• выберите Help (справка) в меню PanelBuilder32

• щелкните кнопку Help любого диалогового окна

• нажмите F1 или щелкните правой кнопкой и выберите What's This? (Что это?) в

любом поле диалогового окна, элементе меню или виде окна.

Основная справочная система

Выберите Help > Contents (содержание) в окне PanelBuilder32.

• щелкните закладку Contents для просмотра содержания файла справочной

системы.

• щелкните закладку Index (алфавитный указатель) для поиска тем с помощью

алфавитного указателя справочной системы. Либо введите интересующее вас

слово (или тему), либо пролистайте список.

• щелкните закладку Find (поиск) для поиска по словам или фразам.

Дважды щелкните книгу, чтобы ее

открыть или закрыть. Дважды

щелкните тему книги для

отображения справки.
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Справка диалогового окна

В каждом диалоговом окне PanelBuilder32 имеется кнопка Help, которую вы можете

нажать для получения информации. Эта информация включает обзор и поэтапные

алгоритмы. В приведенном ниже примере показана справка, появляющаяся при

конфигурировании вами кнопки.

Контекстно-зависимая справка

Вы можете также получить справку о полях в диалоговом окне.

Щелкните кнопку для

отображения нужной темы

Щелкните X, чтобы закрыть

окна Help

Щелкните во временном

окне, чтобы его закрыть

Если в диалоговом окне

имеется ?, щелкните ?, а

затем щелкните элемент, о

котором вы хотите получить

информацию, или щелкните

правой кнопкой элемент и

выберите What's This?

Если в диалоговом окне нет

?, щелкните правой кнопкой

элемент и выберите What's

This? или нажмите F1
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3 Приложения и экраны

В этой главе рассказывается о том, как

• создавать новое приложение

• открывать приложение

• работать с экранами приложения

• сохранять и закрывать приложения

• генерировать отчеты приложений

• проверять размер приложения

Для получения дополнительной информации о приложениях в основной справочной

системе откройте книгу Working with Applications (работа с приложениями) на

закладке Contents (содержание).

Для получения дополнительной информации о экранах в основной справочной

системе откройте книгу Working with Screens (работа с экранами) на закладке

Contents.

О типах файлов

Файлы PanelBuilder32 могут быть следующих типов:

• .PBA – относится к приложению, сконфигурированному и сохраненному в

PanelBuilder32.

• .PVA – относится к приложению, сохраненному в формате PanelView Terminal

(терминала PanelView).

• .BAK – относится к резервному файлу, автоматически создаваемому

PanelBuilder32.
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Создание нового приложения

Существует 2 способа создания нового приложения:

• Выберите Create a New Application (создание нового приложения) в диалоговом

окне запуска.

• Выберите File (файл) > New (новый) или щелкните инструмент New на

стандартной панели инструментов.

Открывается диалоговое окно Create a New Application.

Окно Application (приложение) открывается с чистым экраном.

Указание: Вы можете переименовать приложение или ввести для него описание в

диалоговом окне Application > Description (описание).

Выберите тип терминала

Настраивает текущие

значения в качестве

значений по умолчанию для

новых приложений

Введите имя приложения (от 1 до 255

символов)

Выберите протокол терминала

Выберите тип ввода оператора

Щелкните для доступа к ранним версиям

аппаратно-программного обеспечения

терминала

Звездочка (*), появляющаяся после имени

приложения, указывает на то, что файл не

сохранен

Для переименования экрана выберите

Screen (экран) > Properties (свойства)
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Открытие приложения

Существует 2 способа открытия существующего приложения:

• Выберите Open an existing application (открытие существующего приложения) в

диалоговом окне запуска.

В диалоговом окне показаны все приложения .PBA, сохраненные в папке

приложений по умолчанию. Выберите файл и щелкните OK, или дважды щелкните

файл.

• Выберите File (файл) > Open (открыть) или щелкните инструмент Open на

стандартной панели инструментов.

Указание: Если вы открываете 16-разрядное приложение, созданное с помощью

ранней версии PanelBuilder, приложение автоматически обновляется. Когда вы

сохраняете приложение, оно сохраняется в 32-разрядном формате.

Для приложения открывается окно Application (приложение). В папке Screens

(экраны) показаны все экраны в приложении.

Дважды щелкните экран, чтобы его открыть
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Работа с экранами

Каждый экран приложения имеет следующие свойства:

• имя (по умолчанию – Screen 1, Screen 2, Screen 3, …)

• номер (порядковый номер 1-255)

• задний план (цвет экрана цветных / полутоновых терминалов)

• дополнительное описание

• шаг сетки по умолчанию

Когда вы создаете новый экран: Screen (экран) > New (новый), или изменяете свойства

экрана: Screen > Properties (свойства), открывается диалоговое окно, в котором вы

можете изменить значения по умолчанию.

Когда вы покидаете это диалоговое окно, открывается экран с именем и номером,

показанными в заголовке. Также создается пиктограмма экрана в папке Screens

(экраны) с тем же именем и номером.

Указание: Закладка Power-Up (включение) диалогового окна Application

(приложение) > Settings (настройки) является тем местом, где вы

выбираете экран запуска для приложения.

Введите описательное имя (до 32 символов)

Появляется только для цветных или полутоновых

терминалов

Описание появляется в отчете приложения

Вы можете изменить шаг сетки для каждого

экрана. Для применения текущих настроек ко

всем новым экранам, созданным для некоторого

типа терминала, щелкните Set as Defaults

(установить в качестве значений по умолчанию).

Для восстановления последних сохраненных

значений по умолчанию щелкните Restore

Defaults (восстановить значения по умолчанию).
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Основные экранные операции

Для:

Создания нового

экрана

Открытия экрана

Изменения свойств

экрана

Активизации экрана

Закрытия экрана

Удаления экрана

Копирования или

вырезания экрана

      

Выполните следующее:

Выберите Screen (экран) > New (новый).

Дважды щелкните экран в папке Screens (экраны) или щелкните

экран и выберите Screen > Open (открыть).

Щелкните экран в папке Screens, а затем выберите Screen >

Properties (свойства), или щелкните правой кнопкой и выберите

Properties.

Если открыто несколько экранов, выберите экран в нижней секции

меню Window (окно) или щелкните где-нибудь внутри окна. В меню

Window активный экран появляется в начале списка открытых

экранов.

Щелкните X в верхнем левом углу окна или щелкните экран и

выберите Screen > Close (закрыть).

Щелкните экран в папке Screens, затем выберите Edit

(редактирование) > Delete (удалить) или нажмите клавишу Delete.

Удаленные экраны оставляют брешь в нумерации. Новые экраны

создаются с наименьшим доступным номером.

• Выберите экран в папке Screens, затем выберите Edit > Copy

(копировать) или Cut (вырезать).

• Выберите Edit > Paste (вклеить)

Экраны вклеиваются в папку с тем же именем и номером. Если этот

номер уже используется, экран вклеивается с наименьшим

доступным номером. Бреши нумерации заполняются.

Вы можете также копировать или перемещать экраны между

приложениями щелкая правой кнопкой папку Screens целевого

окна Application (приложение) и выбирая Paste.

Указание: Другой путь выбора экранных команд состоит в щелчке правой кнопкой

на экране в папке Screens и выборе команды в контекстном меню.

Выбор группы экранов

• Для выбора группы экранов в папке Screens (экраны) нажмите клавишу Shift,

щелкните первый экран, а затем – последний экран группы.

• Для выбора нескольких экранов, расположенных не подряд, нажимайте клавишу

Ctrl, когда вы щелкаете каждый экран.
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Перетаскивание и размещение экранов

Вместо использования команд Copy (копировать) и Paste (вклеить) вы можете

перетаскивать и опускать экраны между двумя открытыми приложениями. Вы можете

перетаскивать отдельные экраны или папку Screens (экраны) целиком. Разместите

окна Application (приложение) рядом. Откройте папку Screens в исходном

приложении. Перетащите папку Screens или отдельный экран поверх папки Screens

целевого окна Application. Экраны вклеиваются с использованием тех же номеров

экранов, за исключением тех случаев, когда эти номера недоступны (тогда

используются наименьшие доступные номера).

Использование режима блокнота

В режиме блокнота закладки равномерно распределены вдоль нижней части рабочей

области экрана для всех открытых экранов. Каждая закладка помечена именем

приложения, номером и именем экрана. При задержании указателя мыши поверх

закладки эта информация отображается. Закладка активного экрана находится поверх

остальных. Для активизации экрана просто щелкните закладку.

Режим блокнота включается или выключается в меню View (просмотр). Если окно

Application (приложение) отстыковано, оно также будет иметь закладку.
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Сохранение приложения

Вы имеете 2 варианта сохранения приложения.

• Выберите File (файл) > Save (сохранить) или щелкните инструмент Save на

стандартной панели инструментов. Приложение сохраняется в местоположении

по умолчанию, замещая предыдущую версию.

• Выберите File > Save As (сохранить как). Приложение сохраняется под новым

именем, оставляя оригинал неизменным.

При первом сохранении открывается диалоговое окно Save As. Имя файла по

умолчанию – это имя приложения. Тип файла .PBA добавляется к имени файла.

Резервный (.BAK) файл автоматически создается для приложения с тем же именем

файла. Каждый раз при сохранении вами приложения .BAK файл обновляется. Для

отображения номера версии или даты сохранения приложения щелкните Application

(приложение) > Description (описание).

Сохранение в других форматах

Типы сохранения

PanelBuilder32 (*.PBA)

PanelView Terminal (*.PVA)

PanelBuilder 2.6 (*.PBA)

PanelView 2.6 (*.PVA)

Описание

Сохраняет приложение в 32-разрядном файле .PBA. Это –

значение по умолчанию.

Сохраняет приложение в формате терминала PanelView

(.PVA), который можно загрузить на терминал.

Сохраняет приложение в 16-разрядном формате,

совместимом с версией 2.60 (или более поздней)

PanelBuilder.

Сохраняет приложение в 16-разрядном формате .PVA,

совместимом с предыдущими версиями

аппаратно-программного обеспечения терминала PanelView.

Единственным способом загрузки 16-разрядного файла .PVA

на терминал является использование WinPFT File Transfer

Utility (утилиты передачи файлов WinPFT).
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Закрытие приложения

Для закрытия приложения и всех открытых экранов выберите File (файл) > Close

(закрыть) или щелкните X в верхнем левом углу окна Application (приложение). Если

вы сделали изменения в приложении со времени последнего сохранения, вам

предоставляется возможность сохранения файла перед его закрытием.

Генерирование отчета приложения

Вы можете сгенерировать отчет, документирующий все или характерные аспекты

приложения. Отчеты полезны для прослеживания обновлений и изменений

приложения.

Закладка Report Setup (настройка отчетов) диалогового окна Tools (инструменты) >

Options (опции) определяет информацию для включения в отчет и формат

колонтитулов страниц и титульной станицы. Вы можете настроить отчет для ваших

нужд.

Чтобы распечатать отчет, основанный на приведенных выше настройках, выберите File

> Reports (отчеты). Перед тем как щелкнуть Print (печать) в диалоговом окне, вы

можете задать, генерировать ли отчет для:

• всех экранов

• группы экранов

Вы можете также распечатать образы каждого экрана со сводкой объектов.
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Проверка размера приложения

Для сравнения размера оперативной памяти приложения с размером файла и

пределом оперативной памяти терминала PanelView выберите Application

(приложение) > Application Size (размер приложения).

В диалоговом окне показан размер приложения с информацией о выгрузке и без нее.

Информация о выгрузке включает количество байт, необходимое для выгрузки

следующих компонентов приложения.

• объектов

• тегов и устройств

В диалоговом окне также показан размер приложения без приведенной выше

информации о выгрузке. Вы можете выгрузить приложение без приведенных выше

данных, но вам придется заново создать приложение, включая все экраны, объекты,

теги и настройки связи для устройств.





Работа с экранными объектами

4-1

4 Работа с экранными объектами

В этой главе охвачены:

• обзор объектов экрана

• необходимая информация об объектах

• создание объектов

• конфигурирование свойств объекта

• конфигурирование состояний объектов с несколькими состояниями или объектов

списков

• кнопки

• селекторы списков управления

• элементы ввода числовых данных

• элементы ввода данных ASCII

• селекторы экранов

• дисплеи сообщений

• дисплеи данных

• глобальные объекты
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Обзор объектов

Объекты – это графические образы, отображаемые на терминале PanelView. Объекты

могут быть простой строкой текста, графикой, элементом управления или окном

аварийной сигнализации. Некоторые объекты – статические, они предоставляют

визуальную информацию, но не предоставляют никаких функциональных

возможностей. Другие объекты, такие как селекторы списков управления, –

динамические, и взаимодействуют как с оператором терминала, так и с логическим

контроллером. Динамические объекты связаны с логическим контроллером

посредством тега. Тег содержит адрес объекта и другие параметры, такие как тип

данных, что позволяет осуществлять с логическим контроллером операции чтения или

записи данных.

Для получения исчерпывающей информации о различных доступных объектах в

основной справочной системе откройте книгу Creating Control and Display Objects

(создание объектов управления и отображения) на закладке Contents (содержание).

Push Buttons (кнопки)

Тип

Momentary

(кратковременная)

Maintained

(сохраняемая)

Latched

(фиксированная)

Multistate

(многопозиционная)

Описание

Изменяет состояние при нажатии и возвращается в исходное

состояние при отпускании.

Изменяет состояние при нажатии и остается в измененном

состоянии при отпускании.

Изменяет состояние при нажатии и остается в фиксированном

состоянии, пока не будет освобождена логическим контроллером.

Поддерживает 2-16 позиций. Переходит в следующую позицию

каждый раз при нажатии на кнопку.

Control List Selectors (селекторы списков управления)

Тип

Standard

(стандартный)

Piloted

(контролируемый)

Описание

Селектор типа списка, позволяющий оператору выбирать

состояние из прокручиваемого списка до 255 состояний.

Аналогичен стандартному списку управления, но доступ к списку

может быть ограничен логическим контроллером, оператором или

и тем и другим.

Numeric Data Entry Objects (объекты ввода числовых данных)

Тип

Cursor Point

(указание курсора)

Keypad Enable

(разрешение малой

клавиатуры)

Описание

Отображает текущее значение по некоторому адресу логического

контроллера. При выборе открывает числовой блокнот,

позволяющий оператору отправить новое значение контроллеру.

При нажатии открывает числовой блокнот, позволяющий

оператору отправить новое значение контроллеру.
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Описание

Отображает текущее время и дату в текстовой строке или объекте.

Отображает переменную ASCII в текстовой строке или объекте.

Отображает числовое значение в текстовой строке или объекте.

ASCII Data Entry Objects (объекты ввода данных ASCII)

Тип

Cursor Point

(указание курсора)

Keypad Enable

(разрешение малой

клавиатуры)

Описание

Отображает строку символов по некоторому адресу логического

контроллера. При выборе открывает блокнот ASCII, позволяющий

оператору отправить строку символов контроллеру.

При нажатии открывает блокнот ASCII, позволяющий оператору

ввести и отправить строку символов контроллеру.

Indicators and Data Displays (индикаторы и дисплеи данных)

Тип

Multistate Indicator

List Indicator

Bar Graph

Numeric Data Display

Message Display

Print Only Message

Object

Описание

Индикатор с несколькими состояниями – Отображает до 2000

уникальных состояний в зависимости от значения по некоторому

адресу контроллера объекта.

Списковый индикатор – Отображает до 256 элементов в

прокручиваемом списке. Выделенный в данный момент элемент

определяется значением по некоторому адресу контроллера

объекта.

Столбиковая диаграмма – Отображает изменение данных в виде

вертикальной или горизонтальной полосы.

Дисплей числовых данных – Показывает текущее значение по

некоторому адресу контроллера (двоичное, двоично-десятичное,

целочисленное, вещественное).

Дисплей сообщений – Отображает статусную информацию или

инструкции для оператора.

Объект сообщений для печати – Похож на Message Display, за

исключением того, что сообщение распечатывается, а не

отображается на экране.

Screen Selectors (селекторы экранов)

Тип

Goto Screen Button

Goto Config Screen

Button

Return Screen Button

Screen List Selector

Описание

Кнопка перехода к экрану – Отображает заданный экран

приложения.

Кнопка перехода к экрану конфигурации – Отображает меню

Configuration Mode (режим конфигурации) терминала.

Кнопка возвращения к экрану – Возвращает к предыдущему

экрану.

Селектор списка экранов – Отображает экран, выбранный из

списка экранов.

Variables (переменные)

Тип

Time, Date

ASCII Variable

Numeric Variable
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Статические объекты, не выполняющие никаких управляющих
или отображающих функций

Линия, прямоугольник, окружность, эллипс – Графические формы.

Произвольное изображение – Произвольный контурный рисунок.

Шкала – Применяется для масштабирования столбиковых

диаграмм и других объектов.

Текст заднего плана – Текст с различными шрифтовыми размерами

и стилями.

Символы ISA – Стандартные символы ISA.

Импортированная графика – Растровые изображения.

List Keys (клавиши списков)

Тип

Move Up, Move Down

Page Up, Page Down

Home, End

Backspace

Enter

Описание

Управляет перемещением курсора в элементе управления или в

селекторе списка экранов.

Перемещает курсор на страницу вверх или вниз в прокручиваемом

элементе управления или в селекторе списка экранов.

Перемещает курсор к первому или последнему элементу в

элементе управления или в селекторе списка экранов.

Возвращает курсор на его предыдущую позицию в элементе

управления или в селекторе списка экранов.

Отображает или подтверждает выбор в списке.

Alarms (сигналы тревоги)

Тип

Alarm Banner

Acknowledge Button

Clear Button

Print Button

Acknowledge All

Button

Alarm List

Print Alarm List Button

Clear Alarm List Button

Описание

Окно аварийной сигнализации – Определяет область экрана в

которой появляются сигнал тревоги и кнопки управления

сигналом тревоги.

Кнопка подтверждения – Подтверждает отображенный сигнал

тревоги.

Кнопка очистки – Удаляет, но не подтверждает сигнал тревоги.

Кнопка печати – Распечатывает отображенное в данный момент

сообщение сигнала тревоги.

Кнопка подтверждения всех – Подтверждает все сигналы тревоги

(текущие и обрабатываемые).

Список сигналов тревоги – Отображает список инициированных

сигналов тревоги.

Кнопка печати списка сигналов тревоги – Распечатывает все

сигналы тревоги в списке сигналов тревоги.

Кнопка очистки списка сигналов тревоги – Очищает список

сигналов тревоги и окно аварийной сигнализации.

Graphics and Text (графика и текст)

Тип

Line, Rectangle, Circle,

Ellipse

Freeform

Scale

Background Text

ISA Symbols

Imported Graphic



Работа с экранными объектами

4-5

Что следует знать об объектах

Для получения исчерпывающей информации в основной справочной системе откройте

книгу Working with Objects (работа с объектами) на закладке Contents (содержание).

Выбор и отмена выбора объектов

Для:

Выбора объекта

Отмены выбора

объекта

Выбора нескольких

объектов

Выбора всех объектов

Выполните следующее:

Щелкните на любой части объекта. Вокруг объекта появятся

манипуляторы.

Щелкните где-нибудь вне объекта или на другом объекте.

Щелкните и перетащите указатель, очерчивая прямоугольник

вокруг объектов. Или нажимайте клавишу Shift при выборе

каждого объекта.

Выберите Edit (редактирование) > Select All (выбрать все).

Масштабирование и перемещение объектов

Для:

Масштабирования

объекта

Перемещения объекта

Выполните следующее:

Выберите объект, затем поместите указатель мыши поверх

манипулятора для показа направления, в котором вы можете

изменить размеры объекта. Перетаскивайте указатель до тех пор,

пока объект не примет нужные размеры.

Объекты не могут быть меньше графики внутри них.

Поместите указатель поверх объекта, а затем перетащите объект на

новое место.
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Группировка и разгруппировка объектов

Для:

Группировки набора

объектов

Разгруппировки

объектов

Повторной

группировки

объектов

Выполните следующее:

Выберите объекты, которые вы хотите сгруппировать, затем

выберите Arrange (размещение) > Group (сгруппировать). Вокруг

сгруппированных объектов появится контур.

При выборе объекта в группе выбирается вся группа. Вы можете

перемещать, масштабировать, вырезать/копировать/вклеивать или

удалять объекты одним действием. Вы можете также

масштабировать объект, сохраняя его групповой статус.

Выберите группу, а затем выберите Arrange > Ungroup

(разгруппировать). Отмените выбор группы перед выбором

отдельного объекта.

Для восстановления прежней группы объектов выберите Arrange >

Regroup (повторно сгруппировать).

Порядок размещения объектов

Вы можете изменять порядок размещения объектов, перекрывающихся на экране,

используя команды меню Arrange.

Указание: Выберите Arrange > Bring Dynamic Objects to Front (вынести

динамические объекты на передний план) для вынесения всех объектов,

взаимодействующих с контроллером, на передний план по отношению к

другим объектам на экране.

Вынести на

передний план

Исходное

размещение

Отправить на

задний план
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Выравнивание объектов в горизонтальной или вертикальной плоскости

Вы можете выравнивать объекты по горизонтали или по вертикали по их левым,

правым, верхним или нижним краям или по центрам, используя меню Arrange. Для

выравнивания 2 или более объектов по их центральным точкам, так, чтобы они

перекрывали друг друга, используйте команду Align Center Points (выравнивание

центральных точек).

Распределение объектов по горизонтали или по вертикали

Для выравнивания расстояний между 3 или более объектами, чтобы между ними были

равные промежутки, используйте команды Space Horizontal (распределение по

горизонтали) или Space Vertical (распределение по вертикали) в меню Arrange.

Переворачивание объектов по горизонтали или по вертикали

Вы можете поменять расположения 2 или более объектов по горизонтали (слева

направо) или по вертикали (сверху вниз), используя меню Arrange.

Увеличение или уменьшение масштаба

Вы можете увеличить вид экрана, чтобы объекты выглядели большими или меньшими,

чем их реальные размеры. Выберите View (просмотр) > Zoom In (увеличение

масштаба) для увеличения вида и Zoom Out (уменьшение масштаба) для уменьшения

вида. Вид может быть увеличен или уменьшен несколько раз. Для возврата экрана к

его нормальному размеру выберите View > Full Size (полный размер).

Выравнивание объектов по вертикали

Align left

(по левым

краям)

Align right

(по правым

краям)

Align centers

(по центрам)

Выравнивание объектов по горизонтали

Align top

(по верхним краям)

Align middle

(по серединам)

Align bottom

(по нижним краям)

Распределение по вертикали Распределение по горизонтали
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Копирование или перемещение объектов

Вы можете копировать или перемещать объекты:

• на том же экране

• на другой экран

• на экран другого приложения

Используйте команды Edit > Copy (копировать), Cut (вырезать) и Paste (вклеить) или

инструменты для копирования или перемещения объектов. Когда вы копируете или

вырезаете объект, появляется контур объекта. Переместите контур на другое место, а

затем вклейте его. При использовании этих команд целевой экран должен быть

открыт. Если целевой экран в другом приложении, то должны быть открыты и целевое

окно Application (приложение) и целевой экран.

Указание: Другой способ выбора этих команд состоит в щелчке правой кнопкой на

объекте.

Еще проще вы можете перетаскивать объекты между открытыми или закрытыми

экранами. При перетаскивании объекта на закрытый экран в папке Screens (экраны)

этот экран автоматически открывается. Вы затем можете переместить объект. Чтобы

скопировать объект, а не переместить, нажмите клавишу Ctrl при перетаскивании.

Объекты сохраняют все свойства во время копирования и перемещения.

Показ подсказок данных для объектов

Подсказки данных предоставляют быстрый доступ к информации об объектах, включая

их тип, имя / адрес тега, имя / адрес узла логического контроллера, количество

состояний, их глобальный и групповой статус. Для просмотра подсказок данных для

объекта просто задержите указатель мыши на объекте.

Для настройки типа информации, которую вы хотите показать для объекта, или для

запрещения подсказок данных выберите закладку Objects (объекты) диалогового окна

Tools (инструменты) > Options (опции).
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Создание экранных объектов

Все объекты помещаются на экран одинаковым способом.

1. Выберите объект в меню Objects (объекты) или в Toolbox (окне инструментов).

2. Поместите указатель мыши (+) в том месте экрана, где вы хотите опустить объект.

Опускается один объект.

Указание: Для изменения режима размещения объектов выберите закладку

Objects диалогового окна Tools (инструменты) > Options (опции). Вы

можете опускать один объект, несколько объектов одинакового типа и /

или открывать диалоговое окно объекта после размещения объектов.

3. Щелкните для размещения объекта с размером по умолчанию или перетащите

указатель для масштабирования объекта.

Многие объекты имеют внутренний текст по умолчанию, который вы можете

изменить. Вы увидите звездочку (*), если объект слишком мал для вмещения

всего текста. Просто промасштабируйте объект.

                

Указание: Вы можете опускать некоторые объекты на функциональные клавиши, а

не отображать их на экране. Это полезно, если функциональные

клавиши выполняют одни и те же операции независимо от того, какой

экран отображен. Поместите указатель (+) поверх функциональной

клавиши и щелкните. На функциональной клавише появится

графический образ объекта. Для удаления объекта с клавиши выберите

эту клавишу, а затем выберите Edit (редактирование) > Delete (удалить).

Для каждого объекта, помещаемого вами на экран, статусная строка показывает:

• идентификационный номер объекта (назначаемый PanelBuilder32)

• координаты X и Y верхнего левого угла объекта (в пикселах)

• ширина и высота объекта (в пикселах)

• тип объекта (в строке справа)

Push Button

(кнопка)

Screen Button

(экранная

кнопка)

Screen List Selector

(селектор списка

экранов)
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Конфигурирование свойств объектов

Большинство объектов, исключая графику и текст, обладают свойствами,

определяющими их функционирование и то, как они взаимодействуют с терминалом

PanelView и логическим контроллером. Для доступа к свойствам объекта дважды

щелкните объект. Вы также можете щелкнуть левой кнопкой объект, а затем выбрать

Edit (редактирование) > Object Properties (свойства объекта).

                                     

Свойства уникальны для каждого объекта. Для объектов управления область Input

(ввода) определяет, будет ли объект активизирован функциональной клавишей или

сенсорной ячейкой терминала PanelView. Сенсорная ячейка автоматически разрешена

для терминалов с сенсорным экраном.

Указание: Для терминалов с малой клавиатурой функциональные клавиши

автоматически назначены объектам. Для запрещения этой особенности

выберите закладку General (основные) диалогового окна Tools

(инструменты) > Options (опции).

Используйте закладку Options для:

• ввода дополнительного описания объекта.

• придания объекту доступности для глобального использования, чтобы вы могли

повторно использовать его на других экранах. См. стр. 4-26 для получения более

подробной информации о глобальных объектах.

• того, чтобы спрятать объект управления, если пространство экрана ограничено

(функциональная клавиша или сенсорная ячейка остается активной).

Для сенсорных экранов вы должны поместить графику поверх скрытого объекта,

чтобы оператор не мог нечаянно дотронуться до этой области экрана и

активизировать соответствующую функцию.

Control Object (объект управления) Display Object (объект отображения)

После ввода имени тега

щелкните кнопку Edit Tag

(редактирование тега) для

редактирования определения

тега, или вы можете ввести

определения всех тегов сразу

в Tag Editor (редакторе тегов).

Объекты управления имеют Write Tag (тег записи). Этот

тег определяет адрес логического контроллера, по

которому терминал осуществляет запись данных для

объекта. Объекты могут иметь более одного тега.

Объекты отображения имеют Read Tag (тег

чтения). Этот тег определяет адрес логического

контроллера, по которому терминал

осуществляет чтение данных для объекта.



Работа с экранными объектами

4-11

Конфигурирование состояний объектов с несколькими

состояниями или объектов списков

Диалоговые окна для объектов с несколькими состояниями или объектов списков

имеют закладку States (состояния). Эта закладка появляется в виде таблицы и

предоставляет удобный способ для ввода текста и других опций форматирования для

каждого состояния.

Каждая строка таблицы представляет отдельное состояние или запись. Поля каждой

строки определяют текст и другие опции форматирования для каждого состояния.

Некоторые поля требуют ввод текста, некоторые предоставляют выпадающие списки

доступных опций, а другие имеют опции для включения или выключения некоторой

особенности. Поля каждой строки характерны для определенного объекта.

                                                      

Многие операции состояния выполняются при выборе команды в контекстном меню.

Когда вы щелкаете правой кнопкой или нажимаете Ctrl+M на закладке States,

открывается меню.

Например, для добавления или удаления состояний или записей щелкните правой

кнопкой закладку States и выберите Append State (добавить состояние) или Delete

State (удалить состояние) в контекстном меню. Используйте только необходимое для

приложения количество состояний или записей. Неиспользуемые состояния занимают

память приложения.

Другие команды меню позволяют вам перемещать состояния, редактировать

состояния, удалять состояния или внедрять переменные в поле Text (текст) состояния.

Вы даже можете копировать текст, уже существующий в приложении, используя

команду Use Existing Text (использование существующего текста).

Multistate Push Button
(кнопка с несколькими состояниями)

Screen List Selector
(селектор списка экранов)
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Кнопки

Экранные кнопки функционируют подобно механическим кнопкам, причем логическое
значение 0 представляет разомкнутые контакты, а логическое значение 1
представляет замкнутые контакты. Каждой кнопке может быть назначено состояние
контактов нормально разомкнутое / нормально замкнутое, или вы можете назначить
числовое значение каждому состоянию кнопки.

Momentary Push Button (кратковременная кнопка) изменяет состояние при нажатии и
возвращается в исходное состояние при отпускании. Эта кнопка находится в нажатом
состоянии 500 миллисекунд (1/2 секунды). Вы можете задать другое время на
закладке Properties (свойства) диалогового окна Push Buttons (кнопки).

Maintained Push Button (сохраняемая кнопка) изменяет состояние при нажатии и
остается в измененном состоянии при отпускании. Повторное нажатие и отпускание
кнопки возвращает ее в первоначальное состояние. Сохраняемые кнопки сохраняют
их последнее состояние при изменениях экрана. Закладка Power-Up (включение)
диалогового окна Application Settings (настройки приложения) определяет
первоначальное состояние при включении.

Latched Push Button (фиксированная кнопка) изменяет состояние при нажатии и
остается в измененном состоянии при отпускании. Кнопка не возвращается к ее
первоначальному состоянию, пока не будет освобождена посредством установки бита
квитирования или некоторого значения. Статус фиксирования не сохраняется после
включения питания, но сохраняется при изменениях экрана. Такая кнопка не будет
освобождена до тех пор, пока экран показывает эту фиксированную кнопку.

Фиксированные кнопки требуют тег квитирования для освобождения кнопки. Кнопка
освобождается, когда по адресу этого тега содержится ненулевое значение.

OFF OFFON ON

Multistate Push Button (многопозиционная кнопка) имеет 2-16 позиций. Каждой
позиции назначен некоторый бит или некоторое значение. Переходит на следующую
позицию каждый раз при нажатии на кнопку. После последней позиции кнопка
возвращается к первоначальной позиции. Позиции кнопки сохраняются при
изменениях экрана. Закладка Power-Up диалогового окна Application Settings
определяет первоначальное состояние при включении.

Первоначальное
состояние кнопки

Кнопка
нажата

Кнопка
отпущена

Программа контроллера
устанавливает бит квитирования в 1

Бит квитирования = 0
Бит данных = 0

Бит квитирования = 0
Бит данных = 1

Бит квитирования = 0
Бит данных = 1

Бит квитирования = 1
Бит данных = 0

Программа контроллера
устанавливает бит
квитирования в 0
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Текст и графика кнопок

Кнопки могу иметь внутренний текст и / или внутреннюю графику. Вы можете

назначить различный внутренний текст / графику каждому состоянию. Внутренний

текст также может содержать переменные времени, даты, числовую переменную или

переменную ASCII. При первом создании кнопки внутренний текст по умолчанию – это

ST 0 – ST 3.

ON

OFF

Low

Medium

High

Редактирование состояний кнопок

Текст и другие опции форматирования состояний вводятся на закладке States

(состояния) диалогового окна объекта. Для добавления или удаления состояний

многопозиционной кнопки щелкните правой кнопкой закладку States и выберите

Append State (добавить состояние) или Delete State (удалить состояние) в

контекстном меню.

Обсуждение мер безопасности

 !
ВНИМАНИЕ: Не помещайте кнопки экстренного останова или

элементы управления, критичные к безопасному функционированию,

на экран. Используйте отдельные устройства интерфейса оператора

с фиксированным монтажом. Обращайтесь к внутренней обложке

этого руководства за соответствующими стандартами.

• Не помещайте важные кнопки в середину сенсорных экранов. Они могут быть

временно блокированы сообщениями сигналов тревоги, окном аварийной

сигнализации или блокнотом.

• Помещайте кнопки на достаточно большом расстоянии друг от друга на сенсорных

экранах, чтобы оператор не мог ошибочно нажать два объекта, результатом чего

может быть нежелательное функционирование.

• Кнопки заблокированы в течение 1/2 секунды после изменения экрана. Терминал

не будет реагировать на нажатие кнопок на новом экране, пока не будут отпущены

кнопки предыдущего экрана.

Кнопка Включено /
Выключено

Текст состояния 0

Текст состояния 1

Многопозиционная кнопка

Текст состояния 0

Текст состояния 1

Текст состояния 2

Кнопка Включено /
Выключено

Графика состояния 0

Графика состояния 1

Поле Value (значение) появляется,

только если Value выбрано на

закладке Properties (свойства)
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Селекторы списков управления (Control list selectors)

Селекторы списков управления выполняют много тех же функций, что и кнопки,

включая настройку значений и включение / выключение элементов управления.

Список управления – это прокручивающийся список, который может содержать до 255

различных состояний. Значение первоначального состояния устанавливается на

закладке Properties (свойства) диалогового окна. Это значение отправляется

логическому контроллеру при включении.

Стандартные списки управления (Standard Control Lists)

В стандартных списках управления курсор перемещается для выбора состояния из

списка. На терминалах с малой клавиатурой оператор использует клавиши со

стрелками вверх и вниз для перемещения курсора, а клавишу Enter для отправления

состояния логическому контроллеру.

1/4 Fill Level
1/2 Fill Level

Empty Tank

Fill Tank

1/4 Fill Level
1/2 Fill Level

Empty Tank

Fill Tank

Терминалы с сенсорными экранами требуют клавиш списка на экране для

предоставления оператору возможности перемещать курсор и отправлять состояние

контроллеру.

Если экран содержит несколько списков управления, вертикальная полоса появляется

слева от активного списка. Оператор выбирает список управления, нажимая на

сенсорный экран, назначенную функциональную клавишу или на клавиши со

стрелками влево и вправо.

Контролируемые списки управления (Piloted Control Lists)

Используйте контролируемые списки управления для ограничения доступа к списку

управления. Для каждого состояния вы можете ограничить доступ, чтобы он

осуществлялся только контроллером, только пользователем, пользователем и

контроллером, или не осуществлялся вовсе. Первоначальное состояние должно

разрешать доступ пользователю.

Логический контроллер выбирает состояние, устанавливая значение Control Tag (тега

управления) в 1 с последующей записью значения состояния по адресу Search Tag

(тега поиска). PanelView считывает значение Search Tag и выделяет соответствующее

состояние списка управления. Затем PanelView записывает значение состояния в Write

Tag (тег записи), назначенный списку управления.

Indicator Bar (индикаторная полоса)

показывает активный (выбранный) список

Tank Level Control Tank Level Control

Клавиши списка
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Block Write Data (данные блочной записи), только для контролируемого списка
управления

Используйте тег Block Write (блочной записи) для записи всех состояний,

отображенных в списке управления, по блоку адресов логического контроллера. Тег

Block Write Start (начало блочной записи) определяет начальный адрес для этой

операции. Зарезервируйте один адрес, следующий за адресом тега Block Write, для

каждого состояния списка управления. Количество состояний, поддерживаемое тегом

блочной записи различно для каждого терминала (максимум – 29).

Stage 1 (100)
Stage 2 (200)
Stage 3 (300)
Stage 4 (400)
Stage 5 (500)
Stage 6 (600)
Stage 7 (700)
Stage 8 (800)
Stage 9 (900)
Stage 10 (1000)

400
500
600
700
800

Inactive States (неактивные состояния), только для контролируемого списка
управления

Неактивные состояния списка не могут быть выбраны оператором. Курсор полый при

перемещении к неактивному состоянию. Неактивные состояния включены в данные

блочной записи, отправляемые логическому контроллеру.

State 1
State 2
State 3
State 4
State 5

State 1
State 2
State 3
State 4
State 5

Редактирование состояний списка управления

Текст и другие опции форматирования для каждого состояния определяются на

закладке States (состояния) диалогового окна объекта. Для добавления или удаления

состояний, щелкните правой кнопкой закладку States и выберите Append State

(добавить состояние) или Delete State (удалить состояние) в контекстном меню.

Используйте только необходимое количество состояний. Каждое состояние

ограничено одной строкой. Любые изменения текстовых размеров применяются ко

всему списку.

Список управления Данные блочной записи, отправляемые

логическому контроллеру

Начальный тег блочной записи

до 29 последовательных адресов

Активное

состояние Неактивное

состояние

Текст, появляющийся для каждого

состояния

Поле доступа появляется только для

контролируемых списков управления
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Элементы ввода числовых данных (Numeric data entry controls)

Элементы управления Keypad Enable (разрешение малой клавиатуры) и Cursor Point

(указание курсора) позволяют оператору вводить и отправлять числовое значение по

некоторому адресу логического контроллера. Оба элемента числового ввода

открывают блокнот числового ввода, с помощью которого оператор вводит числовое

значение.

Начальное значение элементов числового ввода настраивается в редакторе тегов. Это

значение отправляется контроллеру при включении. Начальное значение не

масштабируется, поэтому должно быть введено в единицах, используемых логическим

контроллером. Например, терминал использует °C, а контроллер °F. Для

инициализации терминала значением 32 °F в качестве начального значения в

редакторе тегов должно быть введено 32, а не 0.

Кнопка разрешения малой клавиатуры (Keypad Enable Button)

Кнопка разрешения малой клавиатуры – это кратковременная кнопка, которая может

отобразить значение по некоторому адресу логического контроллера. При нажатии

эта кнопка открывает числовой блокнот и разрешает ввод числовых данных на малой

клавиатуре терминала.

TANK #1 PID HEA T LO O P

CV PV SP
0° F

75° F

150° F

0%

50%

100%

20 35 26

SP =

CV =

10
Enter Temp

50
Enter Deg

Указание курсора (Cursor Point)

Указание курсора – это окно данных, которое может отображать значение,

сохраняемое по некоторому адресу контроллера. При выборе указания курсора и

нажатии клавиши Enter или числовой клавиши открывается числовой блокнот и

разрешается ввод данных на малой клавиатуре терминала.

TANK #1 PID HEA T LO O P

CV PV SP
0° F

75° F

150° F

0%

50%

100%

20 35 26

SP =

CV =

50

10 %

°F

Оператор выбирает указания курсора, нажимая на сенсорный экран, назначенную

функциональную клавишу или клавиши со стрелками влево / вправо на терминале.

Индикаторная полоса слева от объекта показывает активное указание курсора.

Кнопки разрешения малой клавиатуры

Указания курсора
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Числовой блокнот (Numeric scratchpad)

Числовой блокнот открывается в центре экрана терминала при выборе элемента

числового ввода. В верхней части блокнота показывается текущее введенное

значение. Ниже текущего значения находится диапазон значений, которые оператор

может ввести. Пределы ввода данных для значений устанавливаются в редакторе

тегов.

Вид числового блокнота зависит от терминала PanelView.

                

Масштабирование данных

Данные, вводимые оператором, могут быть промасштабированы с использованием

следующей формулы:

Значение, сохраняемое контроллером    =

Значения коэффициента масштабирования и смещения вводятся в редакторе тегов.

Если промасштабированное значение выходит за пределы выбранного типа данных,

терминал отображает сообщение об ошибке.

Precision and Rounding (точность и округление) – За исключением вещественных

значений, логический контроллер сохраняет все значения в виде целых чисел. Цифры

справа от десятичной точки округляются. Однако, терминал может масштабировать

десятичные значения по отношению к целочисленным значениям.

Только 550 Touch Screen

Текущее значение

Малая клавиатура и малая

клавиатура / сенсорный экран

900/1000/1400 Touch Screen

Введенное значение – Смещение

Коэффициент масштабирования

Введенное значение = 7.5

Значение контроллера = 8

(округленное)

Отображенное значение = 8
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Элементы ввода данных ASCII (ASCII data entry controls)

Элементы ввода ASCII позволяют оператору отправлять буквенно-цифровые строки

(до 128 символов) логическому контроллеру. Подобно элементам числового ввода,

элементы ввода ASCII могут появляться на экране терминала либо как кнопка

разрешения малой клавиатуры, либо как указание курсора.

Начальное значение для элементов ввода ASCII устанавливается в редакторе тегов.

Это значение отправляется контроллеру при включении и может также быть

сконфигурировано для отображения в объекте.

Кнопка разрешения малой клавиатуры (Keypad Enable Button)

Кнопка разрешения малой клавиатуры – это кратковременная кнопка, которая может

отобразить строку символов ASCII по некоторому адресу логического контроллера.

При нажатии кнопка разрешения малой клавиатуры открывает блокнот ASCII,

позволяющий оператору вводить и отправлять новую строку символов логическому

контроллеру.

A123-BZO

Указание курсора (Cursor Point)

Указание курсора – это окно данных, которое отображает строку символов ASCII по

некоторому адресу контроллера. На экране могут появляться несколько указаний

курсора. Индикаторная полоса слева от объекта указывает на активное указание

курсора. Оператор выбирает указание курсора, нажимая на сенсорный экран,

назначенную функциональную клавишу или клавиши со стрелками влево / вправо

терминала.

##########

При вводе в блокноте такой строки, как пароль, доступно свойство защиты,

позволяющее вам маскировать каждый символ. Например, если оператор ввел пароль

LETMEIN, символы в блокноте будут появляться в виде #######. Каждый символ

заменяется на #.

Введите номер части:

Введите пароль:
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Блокнот ASCII (ASCII Scratchpad)

Вид блокнота ASCII зависит от терминала PanelView.

                

Символы, выбранные на клавиатуре блокнота, вводятся в области дисплея. Эта область

прокручивается, поэтому не все символы в строке могут быть видимы. Все символы

отправляются контроллеру, видимы они или нет. Элементы ввода символов различны

для каждого блокнота. См. интерактивную справочную систему.

Когда оператор нажимает на клавишу Enter на малой клавиатуре терминала или на

сенсорном экране, строка отправляется логическому контроллеру. Самый левый

символ помещается в старший байт первого слова (используя адрес тега записи),

следующий символ – в младший байт и т.д. Протокол DeviceNet позволяет

осуществлять перестановку байтов.

Поддержка других языков блокнотом

Доступны блокноты ASCII с символьными клавиатурами на французском, немецком,

итальянском и испанском языках. Если терминал PanelView сконфигурирован для

функционирования на одном из этих языков, блокнот ASCII автоматически отображает

символьную клавиатуру на соответствующем языке.

Только 550 Touch Screen Малая клавиатура и малая

клавиатура / сенсорный экран

900/1000/1400 Touch Screen
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Селекторы экранов (Screen selectors)

Селекторы экранов позволяют оператору перемещаться между экранами приложений.
Когда пространство экрана ограничено, используйте экранные кнопки.

Экранные кнопки (Screen Buttons)

Помещайте экранные кнопки в одном и том же месте на экранах, чтобы операторы
могли быстро перемещаться от экрана к экрану. Доступны следующие экранные
кнопки:

• Goto Screen Button (кнопка перехода к экрану) – это кратковременная кнопка,
отображающая конкретное окно приложения при нажатии.

• Return Screen Button (кнопка возврата к экрану) – это кратковременная кнопка,
возвращающая к предыдущему экрану при нажатии. Этот элемент управления
осуществляет переход назад только на один экран. Он не предоставляет
последовательный обратный переход к первому экрану приложения.

• Goto Config Screen Button (кнопка перехода к экрану конфигурации) – это
кратковременная кнопка, отображающая меню Configuration Mode (режим
конфигурации) терминала при нажатии. Это меню осуществляет доступ к таким
функциям терминала, как настройки связей, текущий формат времени / даты и
языковые настройки.

Селектор списка экранов (Screen List Selector)

Screen List Selector (селектор списка экранов) – это элемент списка, содержащий
меню (или список) экранов, в котором оператор может осуществлять выбор. Курсор
указывает текущий выбор. Оператор использует клавиши курсора вверх и вниз малой
клавиатуры терминала для перемещения курсора, а клавишу Enter для выбора экрана.

Терминалы с сенсорным экраном требуют клавиш списка на экране для
предоставления оператору возможности управлять курсором и выбирать экран.

Pump Controls
Heater Controls

Conveyor Controls

Pump Controls
Heater Controls

Conveyor Controls

Несколько экранных списков могут быть использованы на одном экране. Для
активизации списка оператор нажимает назначенную функциональную клавишу
сенсорного экрана. Другой способ выбора списка состоит в использовании стрелок
влево и вправо малой клавиатуры терминала.

Индикаторная полоса показывает
активный (выбранный) список

Клавиши списка
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Редактирование записей экранного списка

Записи экранного списка определяются на закладке States (состояния) диалогового

окна объекта. Экранный список поддерживает до 255 записей. Используйте только

необходимое приложению количество записей.

Для добавления или удаления записей экранного списка щелкните правой кнопкой

закладку States и выберите Append State (добавить состояние) или Delete State

(удалить состояние) в контекстном меню. Каждая запись ограничена одной строкой.

Любое изменение текстового размера влияет на все записи списка.

Клавиши списка (List Keys)

Клавиши списка позволяют оператору выполнять над элементами списков операции,

характерные для элемента управления или селектора экранного списка. Клавиши

списка необходимы на терминалах с сенсорным экраном, но могут также быть

использованы на терминалах с малой клавиатурой. Клавиши списка доступны в меню

Objects (объекты) > List Keys (клавиши списка) или в окне инструментов.

Изменения экрана логического контроллера

Ваш логический контроллер может управлять изменениями экрана и возвращать

экранное значение контроллеру. Теги управления и статуса используются для

выполнения этих функций логического контроллера. См. стр. 10-7 главы 10 для

получения более подробной информации.

Экран связан с элементом списка Текст, появляющийся в списке каждого экрана

Move Up

Move Down

Home

End

Page Up

Page Down

Backspace

Enter
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Дисплеи сообщений (Message displays)

Дисплеи сообщений предоставляют статусную информацию или инструкции

оператору. Дисплеи сообщений могут показывать различную информацию,

включающую:

• статус процесса

• запросы оператору

• время / дату

• числовую переменную или переменную ASCII

0

50

50

0

gal

gal

***Tank Level High***

In

Out

In

Out

ClosedOpen

OutflowInflow

Tank #1

Tank #1

ClosedOpen

OutflowInflow

***Tank Level Low***

Дисплеи сообщений могут быть инициированы:

• отдельным битом

• наименее значимым разрядом

• значением

Пример

сообщения

Пример

сообщения
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Редактирование сообщений

Текст и другие опции форматирования сообщений вводятся на закладке States

(состояния) диалогового окна объекта. Для добавления или удаления сообщений

дисплея сообщений щелкните правой кнопкой закладку States и выберите Append

State (добавить состояние) или Delete State (удалить состояние) в контекстном меню.

Используйте только необходимое для приложения количество сообщений.

Дисплей сообщений резервирует одно сообщение как состояние ошибки для указания

оператору, когда данные выходят из допустимого диапазона или недоступны. Вы

можете изменить текст состояния ошибки по умолчанию или использовать графику.

Вы не можете удалить состояние ошибки.

Создание объектов для печати сообщений

Вы можете создать объект только для печати, отправляющий все инициированные

сообщения на принтер, а не отображающий эти сообщения на экране. Любые

переменные в сообщениях также распечатываются. Объекты печати не связаны с

конкретными экранами как дисплеи сообщений, поэтому сообщения могут быть

инициированы в любой момент выполнения приложения. Для создания объекта

печати выберите Application (приложение) > Print Only Object Setup (настройка

объектов только для печати).

Объекты печати поддерживаются только терминалами, оборудованными

последовательным принтерным портом RS-232. Вы вводите сообщения тем же

способом, что и для дисплеев сообщений, но без каких-либо опций форматирования.

Состояние ошибки Текст сообщения
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Дисплеи данных (Data displays)

Столбиковые диаграммы, многопозиционные индикаторы, индикаторы списка и

дисплеи числовых данных показывают числовое значение или графическое

представление данных, хранимых по некоторому адресу логического контроллера.

Индикаторы не имеют «зоны нечувствительности», в которой диапазон значений

интерпретируется как одно состояние. Для большинства приложений релейно-

контактная логика должна допускать интерпретацию диапазона значений для

заданного значения как одного состояния.

Многопозиционные индикаторы (Multistate Indicators)

Многопозиционные индикаторы могут отображать до 2000 различных состояний.

Каждое состояние может отображать уникальное числовое значение или графику.

Состояния могут быть инициированы битом, наименее значимым разрядом или

значением.

Error

Столбиковые диаграммы (Bar Graphs)

Столбиковые диаграммы предоставляют визуальное представление числового

значения по некоторому адресу контроллера. Вы можете задать направление

заполнения столбиковой диаграммы и диапазон представимых значений. К

столбиковым диаграммам могут быть добавлены шкалы для показа диапазонов

данных. Используйте объект Text (текст) для создания временных меток шкалы.

0

25

50

75

100

0

25

50

75

100

Состояние 0

Состояние 1

Состояние 2

Состояние E

Состояние ошибки указывает на выход данных из

допустимого диапазона или инициализацию

нескольких состояний

Заполняется сверху,

шкала слева

Заполняется снизу,

шкала справа

Заполняется слева,

шкала снизу

Заполняется справа,

шкала сверху

Сгруппированная столбиковая диаграмма

Значение равно или

превышает

максимальный

диапазон данных

Значение ниже минимального диапазона

Если значение превышает диапазон

набора данных, столбиковая

диаграмма появляется пустой или

заполненной
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Списковые индикаторы (List Indicators)

Списковые индикаторы – это прокручиваемые списки, содержащие до 255 записей с

выделенной текущей записью списка. Записи списка могут быть инициированы битом,

наименее значимым разрядом или значением.

Empty

Full

1/4

1/2

Off
Temperature Low

Temperature ControlsTank Level

Temperature High
Normal

Дисплеи числовых данных (Numeric Data Displays)

Дисплеи числовых данных показывают действительные или масштабированные

значения по некоторому адресу программируемого контроллера. Для этого значения

вы можете задать ширину поля (1-12 знаков), фиксированную или плавающую

десятичную точку, дополнение нулями или его отсутствие. Вы можете даже добавить

текст возле значения.

no zero fill decimal point

PSI PSI PSI ***** PSI90 090 90.25
zero fill

О масштабировании

Данные контроллера могут быть промасштабированы PanelView перед их

отображением. Это позволяет вам получать необработанные числовые значения от

таких устройств, как датчики или термопары, и приводить их к стандартным единицам,

таким как галлоны, литры, фунты, градусы Фаренгейта. Данные масштабируются с

помощью следующей формулы:

Масштабированное значение = (Коэффициент масштабирования x Значение контроллера) + Смещение

Значения коэффициента масштабирования и смещения вводятся в Tag Editor

(редакторе тегов) объекта дисплея. Значения могут быть сохранены как целые при

масштабировании терминалом для отображения десятичного числа с фиксированной

или плавающей точкой.

Error State (состояние ошибки) – нет

выделенного состояния. Это происходит,

если данные выходят за пределы

допустимого диапазона, или

инициализировано несколько состояний

Если значение превышает заданную ширину поля,

то вместо значения появляются звездочки
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Использование глобальных объектов

Глобальный объект – это отдельный объект, к которому может производится несколько

обращений в приложении с сохранением свойств объекта. Этот объект создается и

сохраняется в PanelView только один раз, независимо от количества его

использований. Использование глобальных объектов не только сохраняет время, но

также уменьшает расход памяти приложением.

Вы можете редактировать свойства глобального объекта из любого экрана. Все другие

экземпляры глобального объекта при этом автоматически обновляются.

Указание: Каждый объект элемента управления должен иметь уникальный тег

записи, если этот объект не используется как глобальный объект. Если

объекты элементов управления, не являющиеся глобальными

объектами, используют одинаковые теги записи, проверка приложения

пройдет с ошибкой.

Может быть использован только один экземпляр глобального объекта на экран.

Однако вы можете использовать различные глобальные объекты на одном экране. Не

осуществляйте копирование или вклеивание глобальных объектов.

Чтобы сделать объект доступным для глобального использования:

1. Дважды щелкните объект.

2. Выберите закладку Options (опции).

3. Выберите опцию Mark for Global Selection (пометить для глобального выбора).

Указание: Группа объектов может быть помечена для глобального использования

двойным щелчком этой группы и выбором закладки Options. Если вы

вводите описание объекта, первые несколько символов будут

появляться в диалоговом окне Global Objects (глобальные объекты) при

повторном использовании вами этого объекта.

Для повторного использования глобального объекта:

1. Выберите Objects (объекты) > Global Object (глобальный объект) или щелкните

инструмент Global Object в окне инструментов.

Откроется диалоговое окно Global Objects, определяющее каждый глобальный

объект посредством имени тега, идентификационного номера и типа.

2. Дважды щелкните объект, который вы хотите повторно использовать.

3. Щелкните в том месте экрана, где вы хотите опустить объект.

Глобальный объект не должен появляться в одном и том же месте каждого экрана.

Кроме того, вы можете назначить другую функциональную клавишу глобальному

объекту при его повторном использовании.

Любые изменения глобального объекта, за исключением местоположения на экране и

назначения функциональной клавиши, применяются ко всем экземплярам этого

объекта.
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5 Работа с сигналами тревоги

В этой главе охвачены

• обзор сигналов тревоги

• окно аварийной сигнализации и списки сигналов тревоги

• кнопки сигналов тревоги

• конфигурирование сигналов тревоги (включая значения по умолчанию,

инициаторы и сообщения)

• примеры инициирования сигналов тревоги

Для получения исчерпывающей информации о сигналах тревоги в основной

справочной системе откройте книгу Working with Alarms (работа с сигналами тревоги)

на закладке Contents (содержание).

Обзор сигналов тревоги

Сигналы тревоги предоставляют оператору визуальное или печатное уведомление о

том, что инициирующее значение вышло из допустимого диапазона. Это значение

может быть связано через контроллер с различными датчиками или программами

контроля. Однако, при осуществлении этого следует пользоваться следующими

соглашениями по безопасности:

 !
ВНИМАНИЕ: Не полагайтесь на терминал PanelView как на первичное

устройство предупреждения в приложениях, которые могут вызвать

физическое повреждение, порчу продукта или значительное

замедление процесса. Все критичные индикации сигналов тревоги и

любые критичные отклики логического контроллера должны

использовать избыточные блокирующие устройства с жестким

монтажом / механические блокирующие устройства.

Каждый сигнал тревоги связан с сообщением и инициирующим значением. Для

каждого сигнала тревоги вы можете задать, должен сигнал тревоги быть подтвержден

или нет, отображен или распечатан.

Alarm Lists (списки сигналов тревоги) – при инициализации сигналы тревоги

добавляются в Alarm List (список сигналов тревоги). Alarm List позволяет оператору

просматривать и управлять несколькими сигналами тревоги.

Alarm Banner (окно аварийной сигнализации) – определяет область на экране, в

которой сообщения и элементы управления сигнала тревоги могут быть доступны для

оператора. Это окно появляется при возникновении сигнала тревоги, независимо от

того, какой экран активен.
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Окно аварийной сигнализации

Далее иллюстрируется окно аварийной сигнализации с сообщением сигнала тревоги,

списком сигналов тревоги и элементами управления сигнала тревоги. Многие из

показанных элементов необязательны. Вы можете настраивать функции сигнала

тревоги под свои нужды.

Oven Temperature Too High!

Clear Ack Print
Alarm

List

Print
Alarm

List

Clear
Alarm

Ack
All

06/19/99 16:55 Oven T *
06/19/99 16:30 LS101 *

06/19/99 15:00 06/19/99 15:05 Oven T *

06/19/99 14:50 06/19/99 14:52 Tank O *

Alarm Alarm

Окно аварийной сигнализации (показано выше) определяет область экрана, в которой

отображаются сообщения и элементы управления сигнала тревоги. Сообщения

сигнала тревоги отображаются в хронологическом порядке их инициирования.

Окно аварийной сигнализации – это глобальный дисплей, создаваемый в приложении

только один раз, но появляющийся на той же самой позиции каждого экрана. Эта окно

появляется только при инициализации сигнала тревоги. Так как окно аварийной

сигнализации может открываться поверх объектов управления и отображения, вы

можете задать, запрещать ли доступ или нет ко всем или только к перекрытым

экранным объектам при отображении окна аварийной сигнализации. Это окно

удаляется с дисплея, когда:

• оператор нажимает кнопки Acknowledge (подтверждение), Clear (удаление) или

Ack All (подтверждение всех)

• контроллер удаляет или подтверждает сигнал тревоги

• терминал входит в Configuration Mode (режим конфигурации)

Сообщение сигнала тревоги

Кнопки сигнала тревоги

(необязательны)

Задний план окна

аварийной сигнализации

Список сигналов тревоги

(необязателен)
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Создание окна аварийной сигнализации

Для создания окна аварийной сигнализации выберите Screen (экран) > Create Alarm

Banner (создать окно аварийной сигнализации). Окно аварийной сигнализации

появляется как отдельный экран в папке Screens (экраны) окна Application

(приложение). В отличие от других экранов окно аварийной сигнализации не может

быть переименовано и не имеет номера.

Окно аварийной сигнализации по умолчанию открывается с:

• однострочным дисплеем сообщений (который не может быть удален)

• кнопкой Clear Alarm (удалить сигнал тревоги)

Окно аварийной сигнализации можно перемещать и масштабировать, но оно не

должно быть меньше объектов на нем. Отмените выделение окна аварийной

сигнализации перед добавлением или выбором объекта внутри него. Добавляйте

кнопки сигналов тревоги в окно выбором объектов в меню Objects (объекты) > Alarm

Buttons (кнопки сигнала тревоги). Для добавления списка сигналов тревоги выберите

Objects > Alarm List (список сигналов тревоги).

Что необходимо знать об окнах аварийной сигнализации

Местоположение окна аварийной сигнализации – Выберите View (просмотр) > Alarm

Banner Position (позиция окна аварийной сигнализации) для показа местоположения

окна аварийной сигнализации на любом экране приложения. Это позволяет вам

увидеть, какие экранные объекты перекрыты (сделаны недоступными) при

инициализации сигнала тревоги.

Позиция / размер окна аварийной сигнализации – могут быть изменены, когда вы

находитесь на экране Alarm Banner (окно аварийной сигнализации). Для открытия

окна аварийной сигнализации дважды щелкните Alarm Banner в папке Screens

(экраны) окна Application (приложение).

Внешний вид полотна – на цветных терминалах, по умолчанию, цвет заднего плана

полотна и объектов сигнала тревоги – красный, а цвет переднего плана – белый. На

монохромных или полутоновых терминалах цвет заднего плана – черный, а цвет

переднего плана – белый. Вы можете изменять цвета переднего и заднего плана с

помощью палитры цветов меню Format (форматирование).
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Списки сигналов тревоги

Список сигналов тревоги поддерживает запись всех инициированных сигналов

тревоги. Максимальное количество сигналов тревоги в списке – 100. Однако, объем

доступной оперативной памяти терминала может ограничить количество сохраняемых

сообщений сигналов тревоги.

06/19/99 16:55 Oven T *
06/19/99 16:30 LS101 *

06/19/99 15:00 06/19/99 15:05 Oven T *

06/19/99 14:50 06/19/99 14:52 Tank O *

Каждый список сигналов тревоги может появляться на нескольких экранах в полотне

сигнала тревоги или на собственном экране. Для каждого сигнала тревоги список

может отображать:

• был ли или нет сигнал тревоги подтвержден (необязательно)

• дату и время инициирования сигнала тревоги или его подтверждения

(необязательно)

• значение инициирования сигнала тревоги (необязательно)

• текст сигнала тревоги (необходимо)

Неподтвержденный сигнал тревоги

Подтверждения не требуется

Подтвержденный сигнал тревоги

Дата / время инициализации Дата / время подтверждения Сообщение сигнала тревоги
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Создание списка сигналов тревоги

Объект списка сигналов тревоги похож на селектор списков управления, в котором

оператор использует курсор для выбора и подтверждения конкретных сигналов

тревоги.

Как и в случае селекторов списков управления, терминалы с сенсорным экраном

требуют клавиш списка на экране для предоставления оператору возможности

перемещать курсор по списку и подтверждать сигналы тревоги. Для создания клавиши

списка выберите любую опцию меню Objects (объекты) > List Key (клавиши списка).

Для создания списка сигналов тревоги выберите Objects > Alarm List (список сигналов

тревоги). Дважды щелкните объект для открытия эго диалогового окна. Свойства,

которые вы можете конфигурировать для каждого списка сигналов тревоги, таковы:

• Поля дисплея сигналов тревоги – задают отображаемые данные для каждого

сигнала тревоги в списке, включая дату / время инициализации сигнала тревоги,

дату / время его подтверждения и значение инициализации сигнала тревоги. Для

каждой записи вы можете также задать количество строк для отображения и

текстовый размер.

• Опции дисплея сигналов тревоги – задают состояния сигналов тревоги (активен и

/ или неактивен) и статусы (подтвержден, не подтвержден, подтверждения не

требуется) для отображения в списке сигналов тревоги. Вы можете создать

несколько списков сигналов тревоги для отображения конкретных типов

информации о сигналах тревоги. Например, вы можете создать отдельные списки

для отображения:

– активных сигналов тревоги, которые не были подтверждены

– активных сигналов тревоги, которые были подтверждены

– неактивных сигналов тревоги, которые были подтверждены

Что необходимо знать о списках сигналов тревоги

Печать списка сигналов тревоги – если необходимо, создайте кнопку Print Alarm List

(печать списка сигналов тревоги) для периодической печати Alarm List (списка

сигналов тревоги), или вы можете сконфигурировать конкретные сигналы тревоги для

эпизодической печати.

Заполненные списки сигналов тревоги – Если список сигналов тревоги заполнен при

инициализации сигнала тревоги, самый последний сигнал тревоги добавляется в

начало списка и:

• самый давний сигнал тревоги, не требующий подтверждения, удаляется (включая

ранее подтвержденные сигналы тревоги).

• если все сигналы тревоги, не требующие подтверждения, были удалены, удаляется

самый давний сигнал тревоги.
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Кнопки сигналов тревоги

Помещайте кнопки сигналов тревоги на окно аварийной сигнализации для

предоставления оператору возможности воздействовать на сигнал тревоги.

Некоторые из этих кнопок могут быть использованы вне окна аварийной

сигнализации. Кнопки сигналов тревоги доступны в меню Objects (объекты) > Alarm

Buttons (кнопки сигнала тревоги).

Кнопка Описание

• Подтверждает получение отображаемого в данный

момент сигнала тревоги.

• Удаляет Alarm Banner (окно аварийной сигнализации) с

дисплея, но не очищает состояние сигнала тревоги.

• Помечает сигнал тревоги как подтвержденный в Alarm

List (списке сигналов тревоги).

• Удаляет Alarm Banner с дисплея без подтверждения

сигнала тревоги.

• Не очищает состояние сигнала тревоги.

Если отдельные сигналы тревоги не сконфигурированы для

подтверждения, окно аварийной сигнализации должно

содержать кнопку очистки.

Печатает текущее сообщение сигнала тревоги в Alarm

Banner (только для терминалов с принтерным портом

RS-232). К каждому распечатываемому сообщению вы

можете добавить:

• дату и время сигнала тревоги

• дату и время подтверждения

• значение инициализации

• Подтверждает все сигналы тревоги в Alarm List.

• Удаляет Alarm Banner с экрана, но не очищает

состояние сигнала тревоги.

• Помечает сигнал тревоги как подтвержденный в Alarm

List.

• Очищает список сигналов тревоги.

• Удаляет Alarm Banner, даже если условие сигнала

тревоги существует.

Указание: Список сигналов тревоги автоматически

очищается при загрузке приложения.

Печатает все сигналы тревоги в Alarm List (только для

терминалов с принтерным портом RS-232). К каждому

распечатываемому сообщению вы можете добавить:

• дату и время сигнала тревоги

• дату и время подтверждения

• значение инициирования

Может быть
использована
вне Alarm
Banner?

Нет

Нет

Нет

Да

Да

Да

Ack

Clear

Print

Ack
All

Clear
Alarm
List

Clear
Alarm
List
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Как конфигурировать сигналы тревоги

Для каждого создаваемого вами сигнала тревоги вы должны сконфигурировать:

• сообщение сигнала тревоги и атрибуты сигнала тревоги

• тег инициирования сигнала тревоги и тип инициирования

Вы можете также модифицировать параметры по умолчанию, которые применяются ко

всем сигналам тревоги.

Изменение значений по умолчанию для сигналов тревоги

Существует несколько параметров настройки, которые применяются ко всем сигналам

тревоги, которые вы можете модифицировать. Например, вы можете задать:

• запрещать ли доступ ко всем или только к закрытым объектам при открытии Alarm

Banner (полотна сигналов тревоги). Начальное значение по умолчанию состоит в

запрещении доступа ко всем экранным объектам.

• размер списка сигналов тревоги (по умолчанию – 25), и очищать ли список

сигналов тревоги при включении.

• данные для печати с каждым сигналом тревоги (время / дата сигнала тревоги,

время / дата подтверждения, значение инициализации). Эта информация

применяется к сигналам тревоги, которые печатаются при возникновении, или при

нажатии кнопки Print Alarm List (печать списка сигналов тревоги) или кнопки Print

Alarm (печать сигнала тревоги).

• удаленные теги, используемые логическим контроллером для удаления или

подтверждения всех сигналов тревоги, или для получения текста сигнала тревоги

всех инициированных сигналов тревоги. Эти теги не активизируются, пока вы не

выберите опцию Use Optional Fields (использование дополнительных полей).

Для редактирования определения каждого тега выберите имя тега, а затем

щелкните кнопку Edit Tag (редактирование тега).

• значение времени, использованное для выполнения сканирований ввода / вывода

при инициализации сигналов тревоги и для гарантирования, что контроллер имеет

время для подтверждения сигнала тревоги (если необходимо).

Для изменения значений по умолчанию для сигналов тревоги:

• Откройте папку Alarms (сигналы тревоги) окна Application (приложение) и

дважды щелкните пиктограмму Setup (настройка) или

• Выберите Application > Alarm Setup (настройка сигнала тревоги)

Диалоговое окно Alarms откроется с выбранной закладкой Setup.
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Определение инициаторов сигналов тревоги

Каждый сигнал тревоги связан с инициатором. Для каждого инициатора вы должны

определить:

• Тег инициатора – определяет адрес логического контроллера, по которому

терминал контролирует значение или бит инициатора. Большинство приложений

используют только один тег инициатора.

• Тип инициатора – определяет какой тип данных будет инициализировать сигнал

тревоги (бит, значение, наименее значимый разряд)

Важно: Типы данных приложений ControlLogix другие. Обращайтесь к

интерактивной справочной системе.

Инициаторы назначаются отдельным сигналам тревоги на закладке Alarm Messages

(сообщения сигналов тревоги) диалогового окна Alarms (сигналы тревоги).

Для определения инициаторов сигналов тревоги:

• Откройте папку Alarms окна Application (приложение) и дважды щелкните

пиктограмму Alarm Triggers (инициаторы сигналов тревоги) или

• Выберите Application > Alarm Setup (настройка сигналов тревоги), а затем

выберите закладку Alarm Triggers.

Закладка Alarm Triggers выглядит подобно таблице. Каждая строка определяет

отдельный инициатор. Поля каждой строки определяют атрибуты инициатора.

Некоторые поля требуют от вас ввода текста, а другие – выбора опции из

выпадающего списка.

Как минимум, вы должны ввести имя тега инициатора и выбрать тип инициатора (бит,

наименее значимый разряд, значение). Вы можете предоставить дополнительные поля

тегов инициаторов, выбрав Optional Fields (дополнительные поля) в контекстном

меню.

Адрес логического контроллера для тега инициатора должен быть наименьшим

адресом соответствующего сигнала тревоги.

Многие операции инициации выполняются выбором команды в контекстном меню. Например, для

добавления инициатора щелкните правой кнопкой (или нажмите Ctrl+M) и выберите Append Trigger

(добавить инициатор) в меню. Для редактирования определения тега для тега инициации выберите поле

Trigger Tag (тег инициатора), щелкните правой кнопкой и выберите Edit Tag (редактирование тега).
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Определение сообщений сигналов тревоги

Для каждого сообщения сигнала тревоги вы можете определить следующие атрибуты:

• сообщение сигнала тревоги (до 255 символов)

• значение или бит, инициализирующие появление сигнала тревоги на Alarm Banner

(полотне сигнала тревоги) или в Alarm List (списке сигналов тревоги). Логический

контроллер записывает этот бит или значение по адресу тега инициатора. Для

типа инициатора Bit (бит) или LSBit (наименее значимый разряд) вы явно вводите

битовое смещение от адреса тега инициатора.

• тег инициатора, связанный с сигналом тревоги и определенный на закладке Alarm

Triggers (инициаторы сигналов тревоги)

• должен ли сигнал тревоги быть подтвержден оператором или логическим

контроллером

• печатается ли сигнал тревоги при инициализации

• отображается ли сигнал тревоги на Alarm Banner при инициализации

• цвета заднего / переднего плана текста сигнала тревоги

• отправлять ли сообщение сигнала тревоги удаленному устройству при

инициализации

Указание: Тег инициатора, переменные в сообщении сигнала тревоги и другие теги

сигнала тревоги (если используются) должны быть в одной группе

сканирования.

Для определения сообщений сигналов тревоги:

• Откройте папку Alarms (сигналы тревоги) окна Application (приложение) и

дважды щелкните пиктограмму Alarm Messages (сообщения сигналов тревоги) или

• Выберите Application > Alarm Setup (настройка сигналов тревоги), а затем

выберите закладку Alarm Messages

Каждая строка таблицы определяет отдельное сообщение сигнала тревоги. Поля

каждой строки определяют атрибуты, связанные с каждым сигналом тревоги.

Некоторые поля требуют текст, некоторые предоставляют выпадающие списки опций,

а другие имеют опции для переключения некоторой особенности во включенное или

выключенное состояние.

Многие операции выполняются выбором команды в контекстном меню. Например, для добавления

сообщения сигнала тревоги щелкните правой кнопкой (или нажмите Ctrl+M) и выберите Append Alarm

(добавить сигнал тревоги) в меню. Для сортировки текстовых полей сообщения выберите Sort by Message

Text (сортировать по тексту сообщения). Для отбора всех сигналов тревоги по полю инициатора выберите

Filter by Trigger (отобрать по инициатору).
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Примеры инициализации сигналов тревоги

Инициализация Bit или LSBit

Этот раздел показывает пример 3 сигналов тревоги с использованием инициатора Bit

(бит). Диапазон данных битового инициатора составляет 0 – 255 (типы данных

битовые, знаковых / беззнаковых целых чисел, двоично-десятичные). Для битового

массива диапазоном является размер массива. При использовании тега Ack

(подтверждение) диапазон данных начинается с 1, а не с 0.

В приведенном ниже примере 3 сигнала тревоги (A, B, C) назначены инициатору

alm_tag. Тип инициатора – Bit. Данные, которые вы вводите в поле Value/Bit

(значение/бит), фактически являются битовым смещением адреса (но не значения)

тега инициатора.

В редакторе тегов определение тега alm_tag таково:

Tag Name
(имя тега)

alm_tag

DataType
(тип данных)

Bit (бит)

Tag Address
(адрес тега)

N15:0/0

Node Name
(имя узла)

SLC_1

Тег манипулирует до 256 последовательными битами / сигналами тревоги (0-255), от

N15:0/0 до N15:15/15.

Адрес бита инициатора сигнала тревоги – это число в поле Value/Bit плюс адрес

инициатора:

Trigger Address + Value/Bit = Trigger Bit Address

Например, Alarm A (сигнал тревоги A) инициализируется, когда N15:1/0 изменяется от

0 до 1.

16 + N15:0/0 = N15:1/0

Alarm B (сигнал тревоги B) инициализируется, когда N15:0/2 изменяется от 0 до 1.

2 + N15:0/0 = N15:0/2

Для типа инициатора LSBit (наименее значимый разряд) сигнал тревоги

инициализируется, когда его бит инициатора изменяется от 0 до 1, и все другие биты

между адресом тега инициатора и адресом бита инициатора будут сброшены. Если

адрес тега инициатора – N7:12/4, а Value/Bit – 6, сигнал тревоги инициируется, когда

N7:12/10 изменяется от 0 до 1. В этом случае установлены только биты между N7:12/4

и N7:12/10 включительно.

Если N7:12/4 – 1, когда N7:12/10 изменяется на 1, сигнал тревоги, соответствующий

N7:12/10, не будет инициирован до тех пор, пока N7:12/4 не сбросится в 0.
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Сигнал тревоги, инициированный значением

В этом разделе показан пример 3 сигналов тревоги с использованием инициатора

Value (значение). Значение инициатора не должно превышать диапазон типа данных,

выбранного для тега инициатора (например, знаковых / беззнаковых целых чисел,

двоично-десятичных чисел).

Ниже приведены 3 сигнала тревоги (A, B, C), назначенные инициатору alm_tag. Тип

инициатора – Value. Поле Value/Bit показывает различное значение (1, 2, 3) для

каждого сигнала тревоги. Значение 0 зарезервировано.

В редакторе тегов определение тега alm_tag таково:

Tag Name
(имя тега)

alm_tag

DataType
(тип данных)

Unsigned Integer

Tag Address
(адрес тега)

N15:0

Node Name
(имя узла)

SLC_1

Каждый сигнал тревоги инициализируется, когда ему назначается значение, введенное

по N15:0. Например, значение 2 по N15:0 инициализирует Alarm B.
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6 Работа с текстом

В этой главе показано как:

• редактировать внутренний текст объектов

• добавлять переменные в текст

• вводить экранный текст

• изменять внешний вид текста

• использовать текстовый редактор приложения

• вводить текст на другом языке

Для получения более подробной информации о работе с текстом в основной

справочной системе откройте книгу Adding Text, Inner Graphics and Variables

(добавление текста, внутренней графики и переменных) на закладке Contents

(содержание).

Редактирование текста в объекте

Большинство объектов создаются с внутренним текстом по умолчанию, который может

быть отредактирован. Внутренний текст появляется внутри объекта и связан с

объектом. Когда вы перемещаете или удаляете объект, внутренний текст также

перемещается или удаляется.

Off

Medium
High

Low
Previous
Screen

Data Entry Controls
Heater Controls

Pump Controls

Conveyor Controls

Кнопки и объекты с несколькими состояниями могут иметь различный внутренний

текст для каждого состояния.

ON

OFF

Low

Medium

High

Селектор списков управления Селектор списка экранов Кнопка возврата к экрану

Включенное / выключенное
состояние кнопки

Текст состояния 0

Текст состояния 1

Многопозиционная кнопка
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Редактирование внутреннего текста (inner text) объекта без состояний

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text. Открывается панель инструментов Text (текст).

Для дисплеев числовых данных или объектов числового ввода вы увидите

метку-заполнитель переменной /*N:6 NO FILL FIX:0*/ с параметрами

форматирования в текстовом окне. Вы не можете удалить эту переменную

(символы между символами косой черты /*N…/), но вы можете добавить текст

вокруг нее.

3. Отредактируйте текст.

В то время как вы редактируете текст, он также вводится в объект. Если вы

нажимаете Enter для начала новой строки, вы увидите символы /*R*/,

указывающие на возврат каретки. Звездочка (*) появляется, если текст превышает

размер объекта.

4. Измените размер объекта, если это необходимо для соответствия с текстом.

Редактирование внутреннего текста (inner text) объекта с несколькими

состояниями или объекта списка

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text. Откроется панель инструментов Text (текст).

3. Выберите состояние в окне State (состояние) на панели инструментов State, или

выберите Format > Next State (следующее состояние) или Previous State

(предыдущее состояние).

4. Отредактируйте текст.

В то время как вы редактируете текст, он также вводится в объект. Нажимайте

Enter для начала новой строки. Звездочка (*) появляется, если текст превышает

размер объекта.

5. Повторите этапы 3 и 4 для редактирования текста для других состояний.

6. Измените размер объекта, если это необходимо для соответствия с текстом.

Указание: Для объектов с несколькими состояниями или объектов списков вы

можете вводить текст для каждого состояния на закладке State

диалогового окна объекта.

Число в левой части является внутренним номером.

Игнорируйте его



Работа с текстом

6-3

Добавление переменных в текст

Вы можете вставить переменную времени, даты, числовую или символьную

переменную в объект или в текстовую строку. Переменная времени и даты

форматируется в соответствии с настройками на закладке Time/Date (время/дата)

диалогового окна Application Settings (настройки приложения). Числовые и

символьные переменные форматируются в соответствии со свойствами, которые вы

настраиваете в диалоговом окне.

Для переменной времени или даты экранный объект показывает формат, в котором

переменная будет появляться на терминале PanelView.

The current time is
1H:MM:SS PM

The current date is
MM/DD/YY

Для числовой или символьной переменной экранный объект показывает ряд ### для

задания ширины поля переменной.

The current temperature
is ### degrees.

Добавление переменной времени или даты (time or date variable)

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text. Откроется панель инструментов Text (текст).

3. Для объекта с несколькими состояниями выберите состояние в окне State

(состояние) на панели инструментов State, или выберите Format > Next State

(следующее состояние) или Previous State (предыдущее состояние).

4. Щелкните в текстовом окне там, где вы хотите вставить переменную.

5. Выберите Time (время) или Date (дата) в меню Format > Embedded Variable

(внедренная переменная) или в меню, которое открывается, когда вы щелкаете

инструмент Embedded Variable на панели инструментов Text.

6. Метка-заполнитель времени /*T*/ или даты /*D*/ вставляется в текстовое окно, а

соответствующий формат времени или даты вставляется в объект.

7. Измените размер объекта, если это необходимо для соответствия с текстом.

Указание: Для удаления переменной просто щелкните на метке-заполнителе в

окне Text и нажмите клавишу Delete.



Работа с текстом

6-4

Добавление числовой переменной (numeric variable)

Числовая переменная отображает числовое значение, прочитанное по некоторому

адресу контроллера. Переменная может отображать до 12 знаков с использованием

чисел с фиксированной или плавающей десятичной точкой, с ведущими нулями или

без них.

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text. Открывается панель инструментов Text (текст),

показывая существующий текст.

3. Для объекта с несколькими состояниями выберите состояние в окне State

(состояние) на панели инструментов State, или выберите Format > Next State

(следующее состояние) или Previous State (предыдущее состояние).

4. Щелкните в текстовом окне там, где вы хотите вставить переменную.

5. Выберите Variable (переменная) в меню Format > Embedded Variable (внедренная

переменная) или в меню, которое открывается, когда вы щелкаете инструмент

Embedded Variable на панели инструментов Text.

Диалоговое окно открывается для задания ширины поля, формата числа с

десятичной точкой и адреса тега, по которому будет осуществляться чтение

переменной. Когда вы выйдете из диалогового окна, метка-заполнитель будет

вставлена в окно Text с параметрами форматирования.

Строка символов ###### представляет длину поля, вставляемого в экранный

объект.

6. Измените размер объекта, если это необходимо для соответствия с текстом.

Указание: Для редактирования числовой переменной щелкните

метку-заполнитель переменной в текстовом окне и выберите Edit

(редактирование) в меню Embedded Variable. Для удаления переменной

просто выберите ее и нажмите клавишу Delete.
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Добавление символьной переменной (character variable)

Переменная ASCII отображает строку символов (максимум 12 символов) прочитанную

по некоторому адресу контроллера. Переменная обновляется всякий раз, когда

изменяется эта строка. Переменная может отображать любой символ расширенного

символьного набора ASCII. Символы обрабатываются последовательно, пока не будет

достигнут символ Null (все биты 0).

Строка сохраняется в таблице данных как последовательные символы. Формат строки

должен быть следующий:

Бит

1-е слово

2-е слово

15

1-й символ

3-й символ

…

8 7

2-й символ

4-й символ

…

0

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text. Открывается панель инструментов Text (текст),

показывая существующий текст.

3. Для объектов с несколькими состояниями выберите состояние в окне State

(состояние) на панели инструментов State, или выберите Format > Next State

(следующее состояние) или Previous State (предыдущее состояние).

4. Щелкните в текстовом окне там, где вы хотите вставить переменную.

5. Выберите Character (символ) в меню Format > Embedded Variable (внедренная

переменная) или в меню, которое открывается, когда вы щелкаете инструмент

Embedded Variable на панели инструментов Text.

Открывается диалоговое окно, позволяя вам задать ширину поля и адрес тега,

предназначенного для чтения строки символов. Когда вы выходите из

диалогового окна, метка-заполнитель вставляется в текстовое окно с параметрами

форматирования.

Строка символов ###### указывает на длину поля, вставляемого в объект.

6. Измените размер объекта, если это необходимо для соответствия с текстом.

Указание: Для редактирования символьной переменной щелкните переменную в

текстовом окне, а затем выберите Edit (редактирование) в меню

Embedded Variable. Для удаления переменной просто выберите ее и

нажмите клавишу Delete.
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Добавление текста на задний план экрана

Вы можете добавить текст на экран так, что он не будет прикреплен к объекту или

связан с ним. Примерами этого типа текста являются заголовки экрана, метки

объектов или метки шкал столбиковых диаграмм.

ON

Empty Tank

1/2 Fill Level
Fill Tank

1/4 Fill Level

Tank Level Controls

0 lbs

25 lbs

50 lbs

75 lbs

100 lbs

Pump #3

Текст заднего плана может содержать до 255 символов с использованием текстового

размера по умолчанию и может появляться где угодно на экране. Вы можете изменить

текстовый размер и использовать различные типы выделения, такие как

подчеркивание, мерцание или применение цвета.

1. Щелкните инструмент Screen Text (экранный текст) или выберите Objects

(объекты) > Text (текст).

2. Щелкните на экране, где вы хотите опустить текстовое окно или перетащите

указатель для задания размера этого объекта.

Откроется панель инструментов Text, позволяя вам ввести текст.

3. Введите ваш текст в пустое окно на панели инструментов.

В то время как вы вводите текст, он также вводится в текстовое окно на экране.

Если вы нажимаете Enter для начала новой строки, вы увидите символы /*R*/,

указывающие на возврат каретки. Звездочка (*) появляется, если текст превышает

размер объекта.

Указание: Если текст разрывается в середине слова, выберите Format

(форматирование) > Word Wrap (перенос слов). Текст будет

переноситься по границам слов.

4. Измените размер текста, блока, если это необходимо для соответствия с текстом.

Примеры экранного текста



Работа с текстом

6-7

Изменение внешнего вида текста

Вы можете изменить способ отображения текста, используя комбинации размера,

выделения и выравнивания. В режиме внутреннего текста вы можете выбирать

инструменты на панели Text (текст) или в меню Format (форматирование). Некоторые

из этих команд переключаются во включенное или выключенное состояние, другие

открывают меню.

Панель инструментов Text автоматически активизируется, когда вы вводите режим

внутреннего текста. Вы можете также показать или спрятать ее с помощью меню View

(просмотр) > Toolbars (панели инструментов).

Для получения более подробной информации о форматировании текста в основной

справочной системе откройте книгу Formatting Objects and Text (форматирование

объектов и текста) на закладке Contents (содержание).

Щелкните этот
инструмент:

Blink

Underline Text

Toggle Fore /

Background

Size Text

Align Text

Для:

Активизации мерцания внутреннего текста или внутренней графики

объекта. Мерцание применяется ко всей текстовой строке. Мерцание не

применимо для объектов списков.

Частота мерцания составляет .5 секунд и не активизируется, пока

приложение не будет загружено на терминал PanelView.

Включения или выключения подчеркивания внутреннего текста.

Подчеркивание применяется ко всей текстовой строке.

Для реверсирования цветов переднего и заднего плана внутреннего

текста. Эта опция не применима для объектов списков.

Цвета переднего / заднего плана текста переключаются независимо от

цветов переднего / заднего плана объекта.

Изменения текстового размера внутреннего текста объекта. В объектах

списков изменения текстового размера влияют на все элементы списка.

Применимость определенных текстовых размеров различается для

каждого терминала.

Если внешний шрифт доступен, текстовые размеры внешнего текстового

файла появляются в скобках в нижней части меню текстового размера.

Выравнивания внутреннего текста объекта влево, по центру или вправо.

Указание: Для объектов с несколькими состояниями вы можете применять опции

форматирования текста к отдельным состояниям.
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Для применения опций форматирования к тексту:

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) на панели инструментов State

(состояние) или выберите Format > Inner Text.

3. Если у объекта несколько состояний, выберите состояние в окне State, или

выберите Next State (следующее состояние) или Previous State (предыдущее

состояние) в меню Format.

4. Щелкните инструменты на панели инструментов Text, которые вы хотите

применить, или выберите соответствующие команды в меню Format.

5. Щелкните инструмент Inner Text для выхода из режима внутреннего текста.

Указание: Для объектов с несколькими состояниями и объектов списков вы

можете настроить многие опции форматирования текста на закладке

State диалогового окна объекта.
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Использование текстового редактора приложения

Текстовый редактор – это таблица, которая сохраняет все текстовые строки в

приложении. Вы можете использовать этот редактор для:

• ввода или редактирования текста (с внедренными переменными)

• удаления неиспользуемого текста

• копирования текста в объекты

• изменения нумерации текста

• отбора или сортировки текста

• печати всего текста приложения

Для открытия Text Editor (текстового редактора):

• дважды щелкните пиктограмму Text Editor в папке System (системная)

• выберите Text Editor в меню Tools (инструменты)

Поле

Text ID

(идентификатор текста)

Count

(счетчик)

Type

(тип)

Message Text

(текст сообщения)

Описание

Уникальный числовой идентификатор строки.

Поле только для чтения, которое задает, как долго строка

используется в приложении. Величина 0 означает, что

строка не используется.

Поле только для чтения, которое показывает, использовался

текст в объекте или в сигнале тревоги.

Текст с внедренными переменными или без них.
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Добавление или редактирование текста

Вы можете добавлять текстовую строку как последнюю строку в таблице или в

конкретном местоположении.

• Для добавления текста в конец таблицы дважды щелкните в поле Text (текст)

последней строки и замените текст по умолчанию «New Text» (новый текст) вашим

текстом.

• Для вставки текстовой строки над некоторой строкой, выберите эту строку, затем

щелкните правой кнопкой и выберите Insert Text Item (вставить текстовый

элемент) в меню. Дважды щелкните в поле Text и замените текст по умолчанию

вашим текстом.

Для ввода возврата каретки нажмите клавишу Enter. Появятся символы /*R*/,

указывая на новую строку.

Поле Text ID автоматически обновляется следующим доступным номером. Поле

Count остается 0 до тех пор, пока строка не будет использована каким-либо

объектом.

Если вы редактируете текстовую строку, текст автоматически обновляется, где бы он

ни использовался в приложении.

Вставка переменных в текст

Вы можете вставить переменную времени, даты, числовую или строковую переменную

в текстовую строку, как описано на стр. с 6-3 по 6-5.

Дважды щелкните в поле Message Text (текст сообщения), а затем расположите курсор

там, где вы хотите вставить переменную. Щелкните правой кнопкой и выберите опцию

в меню Embedded Variable (внедренная переменная). Когда вы выбираете Variable (для

числовой переменной) или Character, открывается диалоговое окно для задания

формата переменной по конкретному адресу тега для чтения.

Следующие метки-заполнители вставляются в текстовую строку для каждой

переменной.

Для этой переменной:

Time (время)

Date (дата)

Variable (переменная)

Character (символ)

Вставляется эта метка-заполнитель

/*T*/

/*D*/

/*V:8 NOFILL FIX:0*/

/*A:6 Read_Tag_Name*/

Для редактирования числовой или символьной переменной просто выберите

метку-заполнитель, щелкните правой кнопкой и выберите Embedded Variable > Edit

(редактирование). Для удаления переменной выберите метку-заполнитель и нажмите

клавишу Delete.
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Сортировка текста

Вы можете сортировать данные в столбцах по числовому значению или по алфавиту в

зависимости от содержимого столбца. Например, если вы сортируете по полю Message

Text (текст сообщения), все строки выстраиваются по алфавиту. Идентичные строки

появляются вместе.

Для сортировки столбца данных выберите какую-нибудь опцию в окне Sort By

(сортировка по). Опция None указывает на отсутствие сортировки столбца.

Отбор текста

Вы можете отбирать текст для отображения или работы лишь с подмножеством строк в

приложении. Список отбора может быть отсортирован и распечатан.

Для отбора текста щелкните кнопку Filter (отбор). Откроется диалоговое окно,

показывая опции рядом с объектами, использующие текст в приложении. Опции также

доступны для отбора неиспользованного текста, сигналов тревоги, или печати только

объектов.

Первоначально все опции выбраны. Для работы лишь с подмножеством текста,

выберите или отмените соответствующие опции. Например, для просмотра всех

неиспользуемых текстовых строк в приложении (Count=0) отмените все опции, за

исключением опции Unused (неиспользуемый).

Изменение нумерации текста

Вы можете объединить память, если имеются бреши в последовательности номеров.

Вы можете легко осуществить проверку на наличие брешей нумерации, осуществив

сортировку по полю Text ID (идентификатор текста).

Для изменения нумерации:

отдельной текстовой строки

всех текстовых строк

блока текстовых строк

Выполните следующее:

Дважды щелкните в поле Text ID и введите уникальный

номер. При обнаружении повторения номеров вы получите

сообщение, когда покинете Text Editor (текстовый

редактор).

Щелкните кнопку Select All (выбрать все), а затем кнопку

Renumber (изменить нумерацию). Нумерация всех строк

будет изменена начиная с значения Text ID строки 1.

Нажмите левую кнопку мыши на первой строке блока и

перетащите указатель для включения всех нужных строк в

блок. Или щелкните первую строку, а затем нажмите

клавишу Shift и выберите последнюю строку.

Нумерация всех текстовых строк в блоке будет изменена

начиная с номера первой строки. Например, блок текста,

пронумерованный: 80, 84, 85, 88; будет перенумерован: 80,

81, 82, 83.
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Перемещение текста

Вы можете изменить размещение текста, перемещая текстовые строки вверх или вниз

или в конкретное местоположение.

Для перемещения
текстовой строки:

вверх или вниз на одну

строку

в конкретное

местоположение

Выполните следующее:

Выберите строку, щелкните правой кнопкой и выберите

Move Text (переместить текст) или Move Text Item Down

(переместить текстовый элемент вниз).

Выберите строку, щелкните правой кнопкой и выберите

Move Text Item To: (переместить текстовый элемент в:). В

открывшемся диалоговом окне, введите номер строки, куда

вы хотите переместить текст.

Текст перемещается и нумерация всех остальных строк

изменяется.

Удаление текста

Вы можете удалить неиспользуемый текст. Если поле Count (счетчик) для некоторой

строки содержит 0, эта строка не была использована. Для создания подмножества

всего неиспользуемого текста:

• Осуществите сортировку по полю Count. Все текстовые строки со значением

счетчика 0 появятся в блоке в конце таблицы.

• Осуществите отбор всего текста за исключением неиспользуемых текстовых строк.

Щелкните кнопку Filter (отбор). Отмените все опции за исключением опции

Unused (неиспользуемый).

После сортировки или отбора неиспользуемого текста вы можете удалить

неиспользуемый текст.

Щелкните кнопку Select All (выбрать все), а затем кнопку Purge (удалить). Весь

неиспользуемый текст (с Count=0) безвозвратно удаляется из таблицы.

Для удаления одной или нескольких неиспользуемых текстовых строк выберите эти

строки (с Count=0), а затем щелкните кнопку Purge, или щелкните правой кнопкой и

выберите Purge Text Item (удалить текстовый элемент).

Печать текста

Вы можете распечатать весь текст или фрагмент текста в Text Editor (редакторе

текста). Создайте фрагмент текста для печати, используя опцию отбора. Вы можете

также отсортировать список отбора или фрагмент текста перед печатью. Для каждой

текстовой строки печатается Text ID (идентификатор текста) и Message Text (текст

сообщения). Колонтитул печатается в верхней части каждой страницы.

Для печати текста приложения выберите текст, который вы хотите распечатать, а затем

щелкните кнопку Print (печать). В диалоговом окне Print выберите набор элементов

для печати: All (все) или Selection (выборка).
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Копирование текста непосредственно в объекты

Текст, сохраненный в текстовом редакторе, может быть скопирован в объекты. Если вы

повторно используете один и тот же текст несколько раз, сохраняется только одна

копия текстовой строки.

Приведенные ниже алгоритмы показывают различные способы копирования в

объекты текста, сохраненного в текстовом редакторе.

Для копирования текста из текстового редактора в объект:

1. Выберите объект, в который будет копироваться текст.

2. Щелкните инструмент Inner Text (внутренний текст) или выберите Format

(форматирование) > Inner Text.

3. Для объектов с несколькими состояниями выберите состояние в окне State

(состояние) на панели инструментов State, или выберите Format > Next State

(следующее состояние) или Previous State (предыдущее состояние).

4. Щелкните инструмент Existing Text (существующий текст) на панели инструментов

Text (текст) или выберите Edit (редактирование) > Use Existing Text

(использование существующего текста). Текстовый редактор откроется в режиме

только для чтения.

5. Выберите строку, которую вы хотите скопировать.

6. Щелкните кнопку Update (обновить). Текст объекта замещается выбранным

текстом.

Для копирования текста из текстового редактора на закладку состояния объекта с
несколькими состояниями:

1. Дважды щелкните объект.

2. Выберите закладку State.

3. Выберите строку текста, которую вы хотите заменить текстом из текстового

редактора.

4. Щелкните правой кнопкой и выберите Use Existing Text в меню. Текстовый

редактор откроется в режиме только для чтения.

5. Выберите строку, содержащую текст, который вы хотите скопировать.

6. Щелкните кнопку Apply (применить), а затем кнопку Close (закрыть). Поля Text ID

(идентификатор текста) и Message Text (текст сообщения) обновляются с текстом

из текстового редактора.
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Ввод текста на других языках

В основной справочной системе см. Translating Applications in other Languages

(преобразование приложений на других языках) под Working with Applications (работа

с приложениями) на закладке Contents (содержание).

Терминал PanelView поддерживает английские, французские, немецкие, испанские и

итальянские символы. Для других языков на шрифт, совместимый с Windows, может

быть осуществлена ссылка в приложении PanelBuilder32.

Вы можете создать шрифтовой файл (*.OTF) для конкретного языка, используя утилиту

FontTool, а затем активизировать этот файл в PanelBuilder32. Шрифтовой файл должен

располагаться в блоке памяти терминала PanelView при выполнении приложения.

Терминал использует символы шрифтового файла для отображения символов на

экране. Блок памяти с шрифтовым файлом не требуется для английского,

французского, немецкого, испанского и итальянского языков, так как терминал

поддерживает их.

С помощью FontTool вы можете создавать шрифтовые файлы для любого

инсталлированного набора языков (или кодовых страниц), поддерживаемых Windows.

Кодовая страница для восточно-европейских языков – 1252. Arial и Times Roman –

шрифты, поддерживаемые кодовой страницей 1252. Набор символов языка, который

вы хотите использовать, должен располагаться на вашем компьютере.

Для ввода текста в PanelBuilder32 на языках, которые используют двухбайтовые

символы, ваша система должна отвечать любому из следующих требований:

• Являться интернациональной версией Windows для конкретного языка

• Выполнять Input Method Editor (IME)

Для однобайтовых языков, вы можете вводить текст приложения, используя:

• шрифтовой файл, доступный в PanelBuilder32

• символьную клавиатуру в Windows

• утилиту отображения символов в Windows или нажатие клавиши Alt + 4-значный

десятичный эквивалент расширенного символа ASCII. На закладке Index

(алфавитный указатель) основной справочной системы ищите enter ASCII

characters (ввод символов ASCII).
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Использование FontTool

Для использования утилиты FontTool выберите Programs (программы) > PanelBuilder32

> FontTool в меню Start (пуск). Эта утилита имеет свое собственное меню и панель

инструментов.

Создание шрифтового файла

1. Выберите File (файл) > New Font (новый шрифт) или щелкните инструмент New

Font на панели инструментов.

2. Выберите шрифт в окне Locale (место действия). Если шрифт имеет подтип, его

имя появляется в скобках, например, Chinese (Simplified).

3. Под Available Sizes (доступные размеры) выберите размеры символов, которые вы

хотите сохранить в шрифтовом файле.

Указание: Отмена размеров уменьшит размер приложения.

Ширина доступных текстовых размеров кратна 8.

Размеры, которые вы выбираете, будут появляться в

меню PanelBuilder32 со стандартными текстовыми

размерами. Текстовые размеры шрифтового файла будут

появляться в скобках

Для следующих однобайтовых языков

выберите MS LineDraw под Font (шрифт):

-English (английский)

-French (французский)

-Italian (итальянский)

-German (немецкий)

-Spanish (испанский)
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4. В диалоговом окне Font выберите стиль шрифта. Стиль должен быть совместим с

определением шрифта. Например, если вы выбираете Chinese (Simplified):

– шрифт Chinese должен располагаться на вашем компьютере

– соответствующая кодовая страница должна располагаться на вашем

компьютере

– запустите программу IME с выбранным соответствующим языком.

Если система выполняется как китайская версия Windows, IME не требуется:

кодовая страница доступна автоматически.

5. Щелкните OK для генерации файла. Время, необходимое для генерации

шрифтового файла, зависит от количества символов / размеров в определении и

скорости вашего компьютера.

6. Образец текста выбранного стиля отображается для определения шрифта.

Проверьте, что текст выглядит правильно.

На этом этапе шрифтовой файл *.OTF располагается в памяти, но не сохраняется на

диск.



Работа с текстом

6-17

Сохранение шрифтового файла

Вы можете сохранить шрифтовой файл на диске и / или в блоке памяти. Шрифтовой

файл должен размещаться в блоке памяти на терминале PanelView при выполнении

приложения. Терминал использует шрифтовой файл для отображения

соответствующих символов на экране.

Для сохранения шрифтового файла на диске:

1. Выберите File (файл) > Save As (сохранить как).

2. В окне File Name (имя файла) введите описательное имя файла с типом файла

.OTF.

PanelBuilder32 ожидает найти этот файл в местоположении по умолчанию: Program

Files (программные файлы) > Allen-Bradley > PanelBuilder > Applications (приложения)

> Font (шрифт).

Для сохранения шрифтового файла в блоке памяти:

1. Вставьте только блок ATA (Каталог № 2711-NM24, -NM28) в устройство для блоков

ATA на вашем компьютере.

Блоки ATA рекомендуются для двухбайтовых языков, так как они имеют

дополнительную память.

2. Выберите File > Save to Memory Card (сохранить в блоке памяти) или щелкните

инструмент Memory Card (блок памяти) на панели инструментов.

3. В окне Save in (сохранить в) выберите местоположение устройства для блоков

ATA.

4. В окне File name введите или выберите имя .OTF для сохранения в блоке.

Указание: Для сохранения шрифтового файла в устройстве для блоков ATA в

PanelBuilder32 используйте команды File > Copy Font File (копировать

шрифтовой файл), Save As или Download (загрузить).

Для копирования шрифтового файла в блок flash-памяти (Каталог № 2711-NM11,

-NM12, -NM13, -NM14) используйте команду File > Save As или Download в

PanelBuilder32.



Работа с текстом

6-18

Использование шрифтового файла в PanelBuilder32

Перед тем как вы сможете использовать шрифтовой файл в PanelBuilder32, вы должны

сделать доступными внешние шрифты и выбрать шрифтовой файл на закладке External

Fonts (внешние шрифты) диалогового окна Application Settings (настройки

приложения). См. стр. 10-9 главы 10 для получения более подробной информации о

том, как это сделать.

Текстовые размеры в шрифтовом файле (*.OTF) появляются в скобках в нижней части

меню текстового размера PanelBuilder32.

Если вы выбираете эти текстовые размеры, PanelBuilder32 использует символы в

шрифтовом файле для генерации текста, который появляется на экране приложения.

Если вы выбираете текстовый размер не в скобках, PanelBuilder32 использует его

стандартный шрифт.

Вы не можете использовать текстовые размеры шрифтового файла и стандартного

шрифта в одной и той же текстовой строке. Вы можете, тем не менее, использовать их

комбинацию по всему приложению.

Для ввода двухбайтовых символов, сохраненных в шрифтовом файле, ваш компьютер

должен выполнять интернациональную версию Windows или IME с корректно

выбранным языком (кодовой страницей). Если вы не используете ни один из этих

вариантов, ваш компьютер будет отображать двухбайтовые символы как 2

однобайтовых символа.

Выполнение приложения с шрифтовым файлом

Загрузите приложение на терминал PanelView, как описано в главе 11. Убедитесь, что

блок памяти, содержащий шрифтовой файл, вставлен в соответствующий слот

терминала. Используйте держатель блока памяти, входящий в комплект поставки

вашего терминала, для обеспечения надежного удержания блока памяти в слоте.

Преобразование текста приложения в Excel

Вы можете копировать текст из приложения PanelBuilder32 в Excel, преобразовывать

текст в Excel, а затем копировать преобразованный текст обратно в PanelBuilder32.

Этот процесс полезен, если лицо, преобразующее текст, не знакомо с PanelBuilder32.

Для получения исчерпывающей информации о преобразовании текста приложения в

Excel в основной справочной системе откройте книгу Working with Applications

(работа с приложениями) на закладке Contents (содержание).

Текстовые

размеры для

шрифта по

умолчанию

Текстовые

размеры

шрифтового

файла
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7 Работа с графикой

В этой главе охвачены:

• использование графических инструментов

• добавление символов ISA на экран

• добавление растровой графики на экран

• вставка графики в объект

• импорт и экспорт графики

Для получения дополнительной информации о графике в основной справочной

системе откройте книгу Adding Drawings and Importing Graphics (добавление

изображений и импорт графики) на закладке Contents (содержание).

Использование графических инструментов

PanelBuilder32 предоставляет графические инструменты для создания простых линий,

форм и изображений. Эта графика доступна в меню Objects (объекты) > Graphics

(графика) или в Toolbox (окне инструментов). В отличие от объектов управления и

отображения графика может перекрываться на экране.

Щелкните этот инструмент: Для:

Вычерчивания прямой линии. Щелкните и перетащите

указатель там, где вы хотите вычертить линию.

Вычерчивания незамкнутых ломаных линий или простых

многоугольников, таких как треугольники. Щелкните там, где

вы хотите начать и закончить каждую линию. Когда вы

закончите вычерчивание линий, щелкните дважды.

Вычерчивания прямоугольника. Щелкните и перетащите

указатель там, где вы хотите вычертить прямоугольник. Для

вычерчивания квадрата при перетаскивании указателя

удерживайте клавишу Shift.

Вычерчивания окружности. Щелкните и перетащите

указатель там, где вы хотите вычертить окружность.

Окружности обрабатываются более эффективно чем

эллипсы на PanelView.

Вычерчивания эллипса. Щелкните и перетащите указатель

там, где вы хотите вычертить эллипс.

Вычерчивания произвольного изображения. Произвольные

изображения интенсивно расходуют память. Для сложных

изображений создайте растр с помощью другой программы,

а затем импортируйте эту графику.

Помещения графического образа на экран.
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Добавление символов ISA

Вы можете поместить стандартные символы ISA на экран. Для доступа к этим

символам выберите опцию ISA Symbols (символы ISA) диалогового окна View

(просмотр) > Toolbars (панели инструментов).

Выберите символ в окне инструментов и щелкните там, где вы хотите поместить

символ на экран. Символы ISA могут быть перемещены, но не масштабированы.

Добавление графики на экран

Кроме графики ISA вы можете поместить на экран другую растровую графику, которая

импортируется из других программ или предоставляется PanelBuilder32.

Для помещения графики на экран:

1. Щелкните инструмент Graphic Image (графический образ) на панели инструментов

или выберите Graphic Image в меню Objects (объекты) > Graphics (графика).

2. Щелкните для размещения временной границы для содержания образа.

Открывается панель инструментов Graphic.

3. Выберите графику в списке Graphics.

Граница масштабируется по объекту, а затем удаляется.

Пока образ выбран (список Graphics появляется в реверсивном виде), вы можете

просматривать другую графику в пределах границы, щелкая клавиши со стрелками

вверх и вниз.

4. Отмените выбор объекта для выхода из режима графики.
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Вставка графики в объект

Вы можете вставить графику в объект (но не в объекты списков). Для объектов с

несколькими состояниями вы можете вставить различную графику для каждого

состояния. Графика может быть символом ISA или растром, созданным в другой

программе.

Графика связана с объектом точно так же как внутренний текст. Если вы перемещаете

или удаляете объект, графика также перемещается или удаляется.

Для вставки растра или символа ISA в объект:

1. Выберите объект.

2. Если объект с несколькими состояниями, выберите состояние в окне State

(состояние), или выберите Next State (следующее состояние) или Previous State

(предыдущее состояние) в меню Format (форматирование).

Указание: Для удаления текста из объекта щелкните инструмент Inner Text

(внутренний текст) и удалите текст.

3. Щелкните инструмент Inner Graphic (внутренняя графика) на панели

инструментов State или выберите Format > Inner Graphic. Открывается панель

инструментов Graphic (графика).

4. Выберите графику или ISA Symbol (символ ISA) в списке Graphics.

Просмотр другой графики при выделенном окне списка Graphics осуществляется

использованием клавиш со стрелками вверх и вниз.

Указание: Для удаления графики из объекта выберите None в списке.

5. Разместите графику в объекте, перетаскивая ее. Вы не можете масштабировать

графику.

6. Осуществите масштабирование объекта (но не графики), если это необходимо.

7. Отмените выбор объекта для выхода из режима графики.

Указание: Вы не можете редактировать размер или содержимое растра или

символа ISA в PanelBuilder32. Вы должны экспортировать графику в

файл, видоизменить ее в другой программе, такой как Paint, а затем

повторно импортировать эту графику. См. следующий раздел.

Включенное / выключенное состояние кнопки

Состояние 0

Внутренняя

графика

Состояние 1

Внутренняя

графика
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Импорт и экспорт графики

Вы можете импортировать монохромные и цветные растры из других программ. Эти

растры могут быть помещены на экран или вставлены в объект.

Импортированные растры не могут превышать количество пикселов, поддерживаемое

терминалом. Излишне большие растры обрезаются при импорте.

Полноцветные растры преобразуются к 16-цветным при импорте. Для полутоновых

терминалов полноцветные растры преобразуются к 4-цветным (4 градации серого).

Эти файлы экспортируются с тем же количеством цветов как при импорте.

Вы можете также экспортировать графику в файл или в буфер обмена,

отредактировать их в другой программе, а затем повторно импортировать. При

повторном импорте PanelBuilder32 обновляет все экземпляры образа в приложении.

Терминал сохраняет только одну копию графики, даже если она используется

несколько раз в приложении.

Для импорта или экспорта растровой графики выберите File (файл) > Import/Export

Graphics (импорт/экспорт графики).

Показывает вид выбранной

графики

Используйте клавиши со

стрелками вверх и вниз для

просмотра доступной графики
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Для импорта растра:

1. Щелкните кнопку Import (импорт) диалогового окна Import/Export Graphics.

2. В открывшемся диалоговом окне выберите файл *.bmp, который вы хотите

импортировать.

3. В следующем открывшемся диалоговом окне замените имя файла уникальным

именем графики. Вводимое вами имя появляется под Currently Imported Graphics

(графика, импортированная в данный момент).

Вы можете импортировать графику как 16-цветный или монохромный растр. Цвет

нельзя выбрать, если импортируется монохромный растр. Если импортируется

цветной растр для полутонового терминала, количество цветов уменьшается до 4.

Когда вы выходите из этого диалогового окна, графика появляется под Currently

Imported Graphics с назначенным именем.

Для вклеивания растра из буфера обмена:

1. В другой программе, такой как Paint, скопируйте или вырежьте растр в буфер

обмена.

2. В PanelBuilder32 выберите File > Import/Export Graphics.

3. Щелкните кнопку Paste (вклеить).

4. В открывшемся диалоговом окне введите уникальное имя для графики. Это имя

будет появляться под Currently Imported Graphics.

Вы можете импортировать графику как 16-цветный или монохромный растр. Цвет

нельзя выбрать, если импортируется монохромный растр. Если импортируется

цветной растр для полутонового терминала, количество цветов уменьшается до 4.

Когда вы выходите из этого диалогового окна, графика появляется под Currently

Imported Graphics.

Для копирования растра в буфер обмена:

1. Выберите графику в списке Currently Imported Graphics.

2. Щелкните кнопку Copy (копировать).

Вы можете теперь вклеить графику в другую программу, такую как Paint.
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Для экспорта растра в файл:

1. Выберите имя графики, которую вы хотите экспортировать.

2. Щелкните кнопку Export (экспорт).

3. В открывшемся диалоговом окне введите имя файла для сохранения графики.

Добавляется тип файла .BMP.

Для удаления графики:

1. Выберите графику в списке Currently Imported Graphics.

2. Щелкните кнопку Delete (удалить).

Вы не можете удалить никакой из символов ISA.
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8 Форматирование объектов

В этой главе показано как:

• изменять внешний вид объектов

• использовать цвет для изменения внешнего вида объектов и текста

 !
ВНИМАНИЕ: Некоторые комбинации опций форматирования могут

привести к тому, что объекты управления станут невидимыми

(объекты сольются с задним планом экрана). Все элементы

управления сенсорного экрана должны быть видимы или иметь

графическое представление расположения объекта. Небрежность в

выполнении этого может привести к непредусмотренному и

непредсказуемому функционированию.

Для получения более подробной информации о форматировании объектов в основной

справочной системе откройте книгу Formatting Objects and Text (форматирование

объектов и текста) на закладке Contents (содержание).
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Изменение внешнего вида объектов

Вы можете изменять визуальные характеристики объекта с помощью панели

инструментов Format (форматирование) или меню Format. Некоторые из команд

переключаются во включенное или выключенное состояние, другие открывают меню.

Панель инструментов Format включается и выключается в меню View (просмотр) >

Toolbars (панели инструментов).

Щелкните этот инструмент:

Shape

Line Type

Fill Type

Blink

Toggle Fore /

Background

Для:

Изменения формы кнопки или графики. Окружности

требуют меньше памяти и обрабатываются лучше чем

эллипсы на терминале PanelView.

Форма масштабируется для подгонки внутренней области

исходного объекта. При изменении формы на окружность

или эллипс поддерживаются только белые, черные или

нулевые заливки.

Изменения типа границы или края объекта.

На монохромных терминалах опциями типа линии являются

черная, белая или нулевая. На цветных или полутоновых

терминалах этими опциями являются сплошная или нулевая.

Изменения заливки внутренней области прямоугольного

объекта. Заливка по умолчанию – белая.

На цветных / полутоновых терминалах окружности и

эллипсы не могут иметь заливки. На монохромных

терминалах заливками для окружностей и эллипсов

являются черная, белая или нулевая.

Активизации мерцания объекта (включая заливку и

границу). Мерцание недоступно для объектов списков.

Частота мерцания составляет .5 секунд и не активизируется

до тех пор, пока приложение не будет загружено на

терминал PanelView.

Мерцание для текста настраивается независимо от объекта.

Реверсирования цветов переднего / заднего плана объекта

или графики в объекте. Эта опция недоступна для объектов

списков.

Для монохромных терминалов передний / задний план

переключается между черным и белым. Для цветных и

полутоновых терминалов передний / задний план

переключается между набором цветов.

Передний / задний план объектов переключается

независимо от текста.

Указание: Для объектов с несколькими состояниями вы можете настроить

различные заливку, переключение переднего / заднего плана и

активизацию мерцания для отдельных состояний.
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Для применения опций форматирования к объекту:

1. Выберите объект.

2. Если объект имеет несколько состояний, выберите состояние в окне State

(состояние), или выберите Next State (следующее состояние) или Previous State

(предыдущее состояние) в меню Format.

3. Щелкните на панели инструментов Format тот инструмент, который вы хотите

применить, или выберите соответствующие команды в меню Format.

Указание: Для объектов с несколькими состояниями и объектов списков вы

можете настроить заливку и активизацию мерцания для отдельных

состояний на закладке State диалогового окна объекта.

Указание: Для объектов с несколькими состояниями вы можете применить опции

форматирования текста к отдельным состояниям.

Использование цвета

Для цветных и полутоновых терминалов используйте палитру цветов для применения

цветов переднего и заднего плана к объектам, тексту или графике. Палитра цветов

поддерживает 16 стандартных цветов EGA. Палитра полутонов поддерживает 4 цвета

(4 градации серого). Эта палитра включается и выключается в диалоговом окне View

(просмотр) > Toolbars (панели инструментов).

На цветных терминалах по умолчанию цвет заднего плана – синий; переднего плана –

белый. На полутоновых терминалах по умолчанию цвет заднего плана – черный;

переднего плана – белый.

Цвета переднего плана влияют на текст, линии, границы объектов, курсор списков,

заливку. Цвета заднего плана влияют на область, содержащую текст, и сплошную

область заполнения объектов.

RESET STOP

Off

Medium
High

Low

Окно обновляется с выбранными цветами переднего и заднего плана

передний план объекта

задний план объекта

передний план графики

задний план графики

передний план текста

задний план текста

передний план текста

задний

план объекта
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Применение цвета к объектам

1. Выберите объект.

2. Если объект имеет несколько состояний, выберите состояние в окне State

(состояние), или выберите Next State (следующее состояние) или Previous State

(предыдущее состояние) в меню Format (форматирование).

3. Для изменения цвета переднего плана щелкните левой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Foreground Color (цвет переднего

плана).

4. Для изменения цвета заднего плана щелкните правой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Background Color (цвет заднего плана).

Вы не можете изменять цвет заднего плана текста объектов списков.

Указание: Для объектов с несколькими состояниями вы можете настроить цвета

переднего / заднего плана объектов на закладке State диалогового окна

объекта.

Применение цвета к тексту

1. Выберите объект.

2. Щелкните инструмент Inner Text (внутренний текст) на панели инструментов State

(состояние) или выберите Format (форматирование) > Inner Text.

3. Если объект имеет несколько состояний, выберите состояние в окне State, или

выберите Next State (следующее состояние) или Previous State (предыдущее

состояние) в меню Format.

4. Для изменения цвета переднего плана щелкните левой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Foreground Color (цвет переднего

плана).

5. Для изменения цвета заднего плана щелкните правой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Background Color (цвет заднего плана).

6. Отмените выбор объекта для выхода из режима внутреннего текста.

Если вы хотите, чтобы задний план текста совпадал с задним планом объекта, вы

должны настроить одинаковый цвет заднего плана для объекта и текста.

                                                 ON ON

Указание: Для объектов с несколькими состояниями вы можете настроить цвета

переднего / заднего плана текста на закладке State диалогового окна

объекта.

Цвета заднего плана текста и

объекта различны

Цвета заднего плана текста и объекта

одинаковы
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Применение цвета к графике

Вы можете настроить цвета переднего и заднего плана для монохромных, но не для

цветных растров.

1. Выберите объект.

2. Щелкните инструмент Graphic (графика) на панели инструментов State

(состояние) или выберите Format (форматирование) > Inner Graphic (внутренняя

графика).

3. Если объект имеет несколько состояний, выберите состояние в окне State, или

выберите Next State (следующее состояние) или Previous State (предыдущее

состояние) в меню Format.

4. Для изменения цвета переднего плана щелкните левой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Foreground Color (цвет переднего

плана).

5. Для изменения цвета заднего плана щелкните правой кнопкой ячейку палитры

цветов или выберите цвет в меню Format > Background Color (цвет заднего плана).

6. Отмените выбор объекта для выхода из режима внутренней графики.

Если вы хотите, чтобы задний план объекта совпадал с задним планом графики, вы

должны настроить одинаковый цвет заднего плана для объекта и графики.

Указание: Для реверсирования цветов переднего и заднего плана монохромных

растров щелкните инструмент Toggle Fore/Background (переключение

переднего/заднего плана) в режиме Inner Graphic.

Настройка цветов по умолчанию для объектов

Вы можете применить цвета по умолчанию к объектам одного и того же типа.

Например, вы можете пожелать, чтобы все кнопки использовали одинаковые цвета.

Создайте кнопку, примените цвета и форматирование, которые вы хотите

использовать, затем выберите Edit (редактирование) > Set Object Color Defaults

(настройка цветов по умолчанию для объекта). Каждая новая кнопка, которую вы

создаете, будет появляться с цветами по умолчанию.

Цвета по умолчанию поддерживаются во всех приложениях и во всех сеансах

PanelBuilder32.
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9 Использование редактора тегов

В этой главе охвачены:

• таблица редактора тегов и диалоговое окно Tag Form (форма тегов)

• вставка или добавление тегов

• копирование / вырезание, вклеивание и удаление тегов

• дублирование, сортировка и поиск тегов

• печать тегов

• импорт и экспорт тегов

Для получения исчерпывающей информации об использовании редактора тегов в

основной справочной системе откройте книгу Working with the Tag Editor (работа с

редактором тегов) на закладке Contents (содержание).

Что такое редактор тегов?

Редактор тегов – это таблица для ввода тегов приложения. Теги связывают объекты с

адресами в таблице данных. Каждый тег определяет адрес и атрибуты данных, которые

терминал PanelView использует для чтения и записи данных. Например, тег для чтения

назначен столбиковой диаграмме. Терминал считывает данные по адресу тега для

чтения для заполнения столбиковой диаграммы.

Атрибуты тега зависят от протокола. Теги сохраняются и загружаются вместе с

приложением на терминал PanelView.

Для открытия редактора тегов:

• дважды щелкните пиктограмму Tag Database (база тегов) в папке System

(системная)

• или щелкните Tools (инструменты) > Tag Editor (редактор тегов)
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Таблица редактора тегов

Важно: Для таких протоколов как DeviceNet вы должны вводить теги в

диалоговом окне Tag Form (форма тегов), так как не все поля

показываются в таблице.

Редактор тегов имеет свою собственную строку меню и панель инструментов, которые

активизируются, когда редактор тегов открывается. Деактивизируются они, когда вы

выходите из редактора тегов.

Фиксация столбцов

Вы можете зафиксировать один или более столбцов с левой стороны окна для

предотвращения ухода их с экрана в результате прокрутки. Щелкните заголовок

столбца, затем щелкните инструмент Freeze Columns (фиксация столбцов) или

выберите View (просмотр) > Freeze Columns. Столбец выделяется. Щелкните

инструмент снова для отмены фиксации столбца. Для фиксации более чем одного

столбца, щелкайте заголовки столбцов, нажимая клавишу Ctrl.

Перемещение столбцов

Для перемещения столбца щелкните заголовок столбца, а затем перетаскивайте

столбец в новое местоположение. Красная линия появляется в позициях (между

столбцами), где вы можете опустить столбец.

Выход из редактора тегов

Дважды щелкните    в левом верхнем углу окна или щелкните X в верхнем правом

углу окна. Все теги автоматически сохраняются с приложением. Если имеются

какие-либо неверные теги, вам выдается запрос, хотите ли вы отказаться от них. File

(файл) > Close (закрыть) или Save (сохранить) закрывает редактор тегов и

приложение, сохраняя теги с приложением.

Перетащите влево или вправо

для масштабирования столбцов

Перетащите вверх или вниз для

масштабирования строк

Столбец статуса

Ошибка в строке

Редактируемая в данный

момент строка
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Диалоговое окно Tag Form

Другой способ для ввода тегов состоит в вводе одного тега за один раз, используя

диалоговое окно Tag Form (форма тегов). Вы можете обращаться к этому диалоговому

окну непосредственно из диалогового окна объекта или из редактора тегов.

• На закладке Properties (свойства) диалогового окна объекта введите имя тега, а

затем щелкните кнопку Edit Tag (редактирование тега).

• В редакторе тегов выберите строку тегов, затем щелкните Edit (редактирование) >

Edit Tag.

Любые теги, которые вы вводите в диалоговом окне Tag Form автоматически

добавляются в таблицу.

 !
ВНИМАНИЕ: Для некоторых протоколов, таких как DeviceNet, вы

должны вводить теги в диалоговом окне Tag Form, так как не все поля

показываются в таблице. Небрежный ввод этих тегов в диалоговом

окне Tag Form приведет к потере данных.

Указание: Если вы щелкаете на кнопке Edit Tag после ввода имени тега для чтения

или записи в диалоговом окне объекта (даже если вы не вводите

атрибуты тега), имена тегов будут появляться в таблице редактора

тегов.

Имена тегов, используемые

объектами, должны быть

введены в диалоговом окне

объекта

Поля Scaling

(масштабирование)

и Data Entry

(запись данных)

появляются только

для особых типов

данных
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Описание полей тега

Поля, которые появляются в таблице и в диалоговом окне Tag Form (форма тегов),

зависят от протокола и характерны для конкретного протокола связи, выбранного для

терминала.

Поле

Tag Name

(имя тега)

Data Type

(тип данных)

Description

(описание)

Array Size

(размер массива)

Node Name

(имя узла)

Address

(адрес)

Initial Value

(начальное значение)

Описание

Уникальное имя тега. Столбец статуса будет указывать на неверное имя тега. Вы должны

ввести то же самое имя тега в диалоговом окне объекта, использующего этот тег.

Формат данных тега. Щелкните выпадающий список этого поля для просмотра доступных

опций. Тип данных, который вы выбираете, должен быть совместим с форматом данных,

выбранным в диалоговом окне объекта.

Описание назначения этого тега.

Размер массива для типов данных Bit Array (битовый массив) или Character Array

(символьный массив). Размер битового массива составляет 1 – 16. Размер символьного

массива зависит от протокола.

Имя узла контроллера, связанного с тегом. Node Name должно совпадать с именем узла,

введенным в диалоговом окне Communication Setup (настройка связи).

Адрес таблицы данных внутри процессора для тега. Например, B3:0/1 или N7:9 для SLC, или

I:010/10 или O:010/10 для PLC-5 Remote I/O.

Некоторые контроллеры используют точку (.) вместо косой черты (/) при адресации битов.

Для получения более подробной информации об адресации обращайтесь к руководству

вашего контроллера.

Начальное значение тега в инженерных единицах. Обеспечивает предустановленное

значение только для объектов числового ввода. Корректные символы – 0 - 9, e, E, +, - и

точка. Максимальная точность значений с фиксированной точкой составляет 6 разрядов

справа от десятичной точки.

Дополнительные атрибуты, появляющиеся только для выбранных типов данных  

Scaling

Scale:

'm' in y = mx + b

Offset:

'b' in y = mx + B

Data Entry Limits

Minimum

Maximum

Значение, предназначенное для конвертирования целочисленного значения процессора

тегов (x) в инженерные единицы (y). Корректные символы – 0 - 9, e, E, +, - и точка.*

Минимальные / максимальные значения, которые могут быть назначены тегу. Вы можете

ввести максимум 12 символов, включающих 0 - 9, e, E, +, - и точку.*

* Максимальная точность составляет 6 разрядов справа от десятичной точки. Если присутствуют, + или - должны быть впереди числа

(+ – подразумевается по умолчанию). Если присутствует, знак экспоненты должен быть непосредственно перед e или E.
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Вставка или добавление тегов

1. Щелкните инструмент Insert Tag (вставить тег) или выберите Edit

(редактирование) > Insert Tag.

Новая строка добавляется перед всеми другими строками в таблице. Для

добавления строки перед конкретной строкой сначала выберите эту строку, а

затем щелкните инструмент Insert Tag.

2. Дважды щелкните в поле для ввода, редактирования или выбора данных.

Нажимайте Tab для продвижения по полям в строке, а Shift+Tab для обратного

продвижения.

Слово Modified (модифицировано) появляется в столбце Status (статус) по мере того,

как вы модифицируете поля для тега. Когда вы покидаете поле, новые данные

автоматически сохраняются. Если вы вводите некорректные данные или оставляете

необходимое поле, такое как Tag Name (имя тега), пустым, столбце Status появляется

сообщение, указывающее на ошибку.

Указание: Новые теги создаются с значениями по умолчанию, настроенными на

закладке Tag Defaults (значения по умолчанию для тегов) диалогового

окна Tools (инструменты) > Options (опции).

Выбор тегов

Для выбора:

одного столбца

последовательных столбцов

непоследовательных

столбцов

одной строки

последовательных строк

непоследовательных строк

всех строк и столбцов

Выполните следующее:

Щелкните заголовок столбца.

Щелкните заголовок первого столбца. Нажмите клавишу

Shift и щелкните заголовок последнего столбца. Или

нажмите левую кнопку мыши на заголовке первого столбца

и перетащите указатель к последнему столбцу.

Щелкните заголовок первого столбца. Нажмите клавишу Ctrl

и щелкайте заголовки других столбцов.

Щелкните столбец статуса строки.

Нажмите левую кнопку мыши на столбце статуса первой

строки и перетащите указатель к последней строке. Или

щелкните столбец статуса первой строки, затем нажимайте

клавишу Shift в процессе выбора других строк.

Щелкните столбец статуса первой строки. Нажмите клавишу

Shift и щелкайте заголовки других столбцов. Нажимайте

клавишу Shift в процессе выбора других строк.

Выберите Edit (редактирование) > Select All (выбрать все)

или щелкните пустое окно в верхнем левом углу таблицы.
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Копирование / вырезание, вклеивание и удаление тегов

Для:

копирования тега

вырезания тега

вклеивания тега

вставки и вклеивания тега

удаления

Выберите строку, а затем:

Щелкните    или выберите Edit (редактирование) > Copy

(копировать). Данные тега или выборка копируются в буфер

обмена.

Щелкните    или выберите Edit > Cut (вырезать). Данные

тега или выборка перемещаются в буфер обмена, оставляя

строку нетронутой.

Щелкните    или выберите Edit > Paste (вклеить).

Данные тега или выборка заменяются содержимым буфера

обмена.

Выберите Edit > Insert and Paste (вставить и вклеить).

Строка с содержимым буфера обмена вставляется над

выбранной строкой.

Щелкните    или выберите Edit > DeleteTag (удалить

тег). Нумерация всех строк изменяется.

Дублирование тегов

Вы можете дублировать теги со сходными атрибутами вместо создания новых тегов с

нуля. Теги могут быть продублированы один или несколько раз.

Когда тег дублируется, к новому имени тега добавляется суффикс (_01), чтобы

отличить его от исходного тега. Если тег дублируется несколько раз, 2-значный

суффикс увеличивается с каждым новым тегом. Теги, являющиеся результатом

дублирования, создаются под выбранным тегом.

Для дублирования тега:

один раз

несколько раз

Выберите строку, которую вы хотите продублировать,
затем:

Щелкните    или выберите Edit (редактирование) >

Duplicate Once (дублировать один раз).

Щелкните    или выберите Edit > Duplicate Several

(дублировать несколько раз).

Указание: Приращение тегов происходит в соответствии с настройками по

умолчанию на закладке Tag Edit (редактирование тега) диалогового

окна Tools (инструменты) > Options (опции).
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Сортировка тегов

Вы можете сортировать данные в одном столбце, или вы можете производить

сортировку до 3 столбцов в заданном порядке. Данные заново размещаются в полях

по алфавиту или по значению. При сортировке нескольких столбцов данные могут

быть отсортированы в возрастающем или убывающем порядке.

Для сортировки данных в:

одном столбце

нескольких столбцах

Выберите что-нибудь в столбце и:

Щелкните правой кнопкой и выберите Edit

(редактирование) > Sort By Current Column (сортировка по

текущему столбцу).

Щелкните    или View (просмотр) > Sort (сортировка).

Открывается диалоговое окно, где вы можете задать порядок

сортировки до 3 столбцов. Данные могут быть

отсортированы в возрастающем или убывающем порядке.

Поиск тегов

Вы можете осуществлять поиск текста или значения в конкретном столбце. Щелкните

где-нибудь в столбце, по которому вы хотите осуществить поиск, затем щелкните

инструмент Find (поиск) или выберите Edit (редактирование) > Find in Current Column

(поиск в текущем столбце). В открывшемся диалоговом окне введите символы для

поиска и направление поиска (вверх или вниз). При поиске регистр символов может

учитываться или игнорироваться.

Печать тегов

Выберите в таблице все теги или набор тегов, которые вы хотите распечатать.

Щелкните правой кнопкой и выберите Print (печать) в контекстном меню. Вы можете

изменить порядок столбцов или настроить их ширину перед печатью.

Вы можете также печатать теги, включая их в ваш отчет приложения. На закладке

Report Setup (настройка отчетов) диалогового окна Tools (инструменты) > Options

(опции) выберите опцию Tag Attributes (атрибуты тега). Для печати отчета с тегами

выберите Reports (отчеты) в меню File (файл).
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Импорт и экспорт тегов

Вы можете импортировать теги в редактор тегов или экспортировать их в следующих

форматах файлов:

• Allen-Bradley APS Format (*.txt)

• Allen-Bradley 6200 Format (*.txt)

• RSI AI Format (*.eas)

• RS-Logix-5 ASCII (*.eas) или CSV Format (*.csv)

• RSLogix 500 ASCII (*.eas) или CSV Format (*.csv)

• PanelBuilder CSV Format (*.csv)

• PanelBuilder Selected Tags Format (*.tag)

Важно: Если вы экспортируете теги RS-Logix 5000 в файл *.csv, вы можете

затем импортировать их в PanelBuilder32, используя формат PanelBuilder

CSV (*.csv).

Для получения более подробной информации об этих форматах файлов обратитесь к

документации вашего логического контроллера.

Импорт тегов

Для импорта тегов из файла поддерживаемого формата выберите Edit

(редактирование) > Import Tags (импорт тегов).

Теги импортируются в редактор тегов с использованием порядка столбцов, заданного

в первой строке импортируемого файла. Если во время импорта обнаруживаются

повторяющиеся имена тегов, тег не импортируется из исходного файла.

Введите имя файла для импорта

Щелкните для запуска импорта

Выберите формат файла с типом файла,

который соответствует имени файла

Введите или выберите имя для ввода в

поле Node Name (имя узла) редактора

Tag Editor (редактора тегов) для тегов,

предназначенных для импорта
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По завершении импорта открывается диалоговое окно, показывающее количество

обработанных строк и тегов вместе с ошибками или предупреждениями. В этом

диалоговом окне вы можете просмотреть сводку импортированных тегов, которая

может также быть распечатана в файл.

Другие способы манипулирования повторяющимися тегами

Вы можете изменить способ, которым повторяющиеся теги (теги с одинаковым именем

в исходном файле и в редакторе тегов) обрабатываются, выбрав кнопку Advanced

(дополнительные) диалогового окна Import (импорт).

Вы имеете возможность:

• игнорировать повторяющиеся теги, оставляя исходные теги нетронутыми в

редакторе тегов (по умолчанию)

• замещать повторяющиеся теги в редакторе тегов импортированным тегом

• получать запрос каждый раз при обнаружении повторяющегося тега
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Импорт тегов с использованием PanelBuilder Selected Tags Format (*.tag)

Теги обычно импортируются в порядке, заданном в первой строке исходного файла. С

помощью PanelBuilder Selected Tags Format (*.tag) вы можете задать порядок импорта

тегов. Если исходный файл не содержит первой строки параметров форматирования,

вы можете импортировать теги в порядке по умолчанию или в существующем порядке

столбцов в редакторе тегов.

Порядок по умолчанию редактора тегов

Для импорта тегов с использованием порядка столбцов по умолчанию в редакторе

тегов выберите приведенные ниже опции диалогового окна Advanced Settings

(дополнительные настройки).

Следующая таблица показывает порядок по умолчанию столбцов (1 – 11) в редакторе

тегов.

Щелкните кнопку Advanced диалогового окна Import

для доступа к этим настройкам

Столбец

1

2

3

4

5

6

Данные

Tag Name (имя тега)

Data Type (тип данных)

Array Size (размер массива)

Description (описание)

Node Name (имя узла)

Address (адрес)

Столбец

7

8

9

10

11

Данные

Initial Value (начальное

значение)

Scale (масштаб)

Offset (смещение)

Minimum (минимум)

Maximum (максимум)

Следующие ключевые слова вставляются в первую строку исходного файла для показа

порядка столбцов по умолчанию.

Name,TagType,ArrayLenght,Description,Node,Address,Initial,Scale,Offset,Min,Max

Motor_Start,Bit,0,Starts motor,LC_1,B3:0/0,0,1,0,0,0

Motor_Stop,Bit,0,Stops motor,LC_1,B3:0/1,0,1,0,0,0

Motor_Speed,UnsignedInteger,0,Controls motor speed,LC_1,N7:1,0,1,0,0,65535

Motor_Speed_Ind,UnsignedInteger,0,Indicates motor speed,LC_1,N7:2,0,1,0,0,65535

Каждая строка данных тега в исходном файле импортируется в редактор тегов на

основе порядка ключевых слов, заданных в первой строке.
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Существующий порядок редактора тегов

Вы можете изменить порядок столбцов в редакторе тегов, а затем импортировать теги,

основанные на новом порядке столбцов. Выберите приведенную ниже опцию

диалогового окна Advanced Settings.

Например, если вы измените порядок столбцов следующим образом:

Щелкните кнопку Advanced диалогового окна Import для доступа

к этим настройкам

Столбец

1

2

3

4

5

6

Данные

Tag Name (имя тега)

Description (описание)

Data Type (тип данных)

Array Size (размер массива)

Node Name (имя узла)

Address (адрес)

Столбец

7

8

9

10

11

Данные

Initial Value

(начальное значение)

Scale (масштаб)

Offset (смещение)

Minimum (минимум)

Maximum (максимум)

В первой строке исходного файла порядок ключевых слов изменяется следующим

образом:

Name,Description,TagType,ArrayLenght,Node,Address,Initial,Scale,Offset,Min,Max

Motor_Start,Starts motor,Bit,0,LC_1,B3:0/0,0,1,0,0,0

Motor_Stop,Stops motor,Bit,0,LC_1,B3:0/1,0,1,1,0,0,0

Motor_Speed,Controls motor speed,UnsignedInteger,0,LC_1,N7:1,0,1,0,0,65535

Motor_Speed_Ind,Indicates motor speed,UnsignedInteger,0,LC_1,N7:2,0,1,0,0,65535

Данные из исходного файла импортируются в редактор тегов в соответствии с новым

порядком.
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Экспорт тегов

Для экспорта тегов из редактора тегов в один из поддерживаемых форматов файлов

выберите Edit (редактирование) > Export Tags (экспорт тегов). Откроется диалоговое

окно, схожее с диалоговым окном Import (импорт).

Когда вы щелкаете Save (сохранить), теги экспортируются в файл в порядке и формате,

предусмотренном форматом файла. По завершении экспорта откроется диалоговое

окно, показывающее количество обработанных строк и тегов вместе с ошибками и

предупреждениями. В этом диалоговом окне вы можете просмотреть сводку

экспортированных тегов или сохранить параметры в файле.

Экспорт тегов с использованием PanelBuilder Selected Tags Format (*.tag)

PanelBuilder Selected Tags Format (*.tag) позволяет вам экспортировать теги с

использованием порядка столбцов по умолчанию в редакторе тегов или только

выбранные столбцы.

Существующий порядок редактора тегов

Например, для экспорта только полей Tag Name, Description и Address выберите эти

столбцы в редакторе тегов.

Введите имя файла для экспорта

Щелкните для экспорта тегов в файл

Выберите формат файла. Убедитесь в

том, что формат имеет тип файла,

совпадающий с именем файла

Введите или выберите имя узла для

связи с каждым экспортируемым тегом

Нажимайте клавишу Ctrl в

процессе щелканья каждого

заголовка столбца
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Выберите Edit > Export Tags. В диалоговом окне Export (экспорт) выберите

PanelBuilder Selected Tags Format (*.tag), а затем щелкните кнопку Advanced

(дополнительные). Выберите приведенные ниже опции.

По завершении экспорта файл .tag будет содержать данные только для выбранных

полей.

Name,Description,Address

Motor_Speed_Ind,Indicates motor speed,N7:2

Motor_Stop,Stops motor,B3:0/1

Motor_Start,Starts motor,B3:0/0

Motor_Speed,Controls motor speed,N7:1

Порядок редактора тегов по умолчанию

Для экспорта тегов с использованием порядка столбцов по умолчанию в редакторе

тегов выберите приведенные ниже опции диалогового окна Advanced Settings

(дополнительные настройки).

Тег импортируется с использованием порядка столбцов, показанного на стр. 9-11.

Следующие ключевые слова вставляются в первую строку исходного файла:

Name,Address,TagType,Description,ArrayLength,Node,Initial,Scale,Offset,Min,Max

Отмените выбор этой опции для экспорта тегов в целевой

файл без первой строки, показывающей порядок столбцов

Отмените выбор этой опции для экспорта тегов в целевой

файл без первой строки, показывающей порядок столбцов
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Использование проектов для совместного использования тегов

Каждое приложение имеет теги, которые сохраняются с приложением. Другими

словами, эта информация приватна и используется только приложением, в котором

она была определена.

Также с приложением сохраняется информация об устройствах, использующих теги,

включающая:

• имя узла логического контроллера

• имя терминала

• параметры сетевой связи для каждого устройства

Вы можете создать отдельный проект для сохранения тегов приложения и

информации об устройствах в файле базы данных на диске. Теги в этом файле базы

данных могут затем совместно использоваться другими приложениями PanelBuilder32.

База данных проекта сохраняется в папке на диске отдельно от вашего приложения.

Начальное местоположение по умолчанию для проектов – \PB32\Projects или

местоположение, введенное во время инсталляции.

Указание: Для изменения местоположения, где сохраняются проекты, выберите

закладку Save (сохранить) диалогового окна Tools (инструменты) >

Options (опции).

Для обеспечения возможности использования проектов щелкните закладку Projects

(проекты) диалогового окна Applications Settings (настройки приложения). Введите

имя проекта. Файл будет создан в \PB32\Projects с именем вашего проекта в качестве

имени файла. Также в Application Window (окне приложения) создается папка Project

(проект) с именем проекта в скобках. База тегов в этой папке используется текущим

приложением, но может также быть использована другими приложениями.

Для создания или редактирования тегов приложения, сохраненных в проекте, вы

можете открыть базу тегов в папке Project или выбрать Tools > Tag Editor (редактор

тегов).

Указание: Вы можете создавать, копировать, удалять или переименовывать

проекты в диалоговом окне Tools > Project Management (управление

проектами). Эта команда доступна, только когда нет открытых

приложений в PanelBuilder32.

Указание: Для копирования, удаления или переименования устройств,

используемых приложением или проектом, выберите диалоговое окно

Tools > Device Management (управление устройствами).
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10 Настройки приложения

В этой главе описано как:

• сконфигурировать связи вашего терминала или контроллера

• установить настройки по умолчанию при включении терминала

• изменить формат времени и даты терминала

• сконфигурировать порт RS-232 терминала для печати

• преобразовать приложение для запуска на другом терминале

• определить теги управления контроллера, которые можно использовать для

изменения текущих экрана, даты или времени

• определить теги статуса контроллера, которые можно использовать для чтения

текущих экрана, даты или времени

• предоставить возможность использования внешнего шрифтового файла для ввода

текста приложения на другом языке

• модифицировать дополнительные настройки терминала и дисплея

Для получения исчерпывающей информации о настройках терминала и приложения в

основной справочной системе откройте книгу Setting up the Terminal (настройка

терминала) на закладке Contents (содержание).

Конфигурация связей

Терминалы PanelView взаимодействуют с контроллерами и удаленными устройствами в

различных сетях, включающих: DH-485, DH+, Remote I/O, DF1, DeviceNet, ControlNet,

Modbus и другие протоколы.

Каждый терминал поддерживает конкретный протокол связи, который выбирается,

когда вы создаете приложение. Перед загрузкой приложения вы должны

сконфигурировать настройки терминала и контроллера для предоставления

возможности осуществления связей.

Для получения дополнительной информации о различных протоколах в основной

справочной системе откройте книгу Communications (связи) на закладке Contents

(содержание).
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Для конфигурирования связей:

• дважды щелкните пиктограмму Communications Setup (настройка связей) в папке

Application Settings (настройки приложения) окна Application (приложение) или

• выберите Application > Settings (настройки), а затем щелкните кнопку Comms.

Setup (настройка связей)

В открывшемся диалоговом окне показаны параметры, характерные для протокола

связи данного терминала. В большинстве случаев вы будете конфигурировать сетевые

параметры терминала и контроллера. Для получения информации о конкретном

диалоговом окне щелкните кнопку Help (справка), или нажмите F1 для получения

справки по конкретному полю.

Информация о логическом контроллере (имя узла, адрес узла, тип узла) обычно

вводится одинаковым способом для большинства протоколов. Под Network Nodes

(сетевые узлы) щелкните правой кнопкой в любом поле и выберите Insert Node

(вставить узел) в меню. Щелкните в поле для ввода данных или выберите некоторую

опцию. Звездочка (*) появляется слева от строки, которую вы редактируете.

Важно: Node Name (имя узла) введенное для контроллера под Network Nodes,

должно совпадать с Node Name, введенным в диалоговом окне Tag Form

(форма тегов) или в редакторе тегов.
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Настройка опций включения

Закладка Power-Up (включение) диалогового окна Application Settings (настройки

приложения) определяет настройки по умолчанию при включении терминала

PanelView. Для модификации этих настроек:

• дважды щелкните пиктограмму Power-Up в папке Application Settings или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Power-Up

Startup Screen (экран запуска; требуется)

Задает первый экран для отображения, когда приложение запускается на терминале.

Write to Controller on Startup (запись в контроллер при запуске)

Выбирает запись предустановленных значений объекта в контроллер при включении.

Терминалы Remote I/O, ControlNet и DeviceNet всегда записывают предустановленные

значения в контроллер.

Вы можете передать либо:

• Terminal Presets (предустановки терминала) – начальный набор значений,

настроенных приложением

• Last Terminal States (последние состояния терминала) – значения,

представленные ранее при включении

Предустановленные значения для объектов вводятся в диалоговом окне объекта. Эти

значения замещают начальные значения, введенные в редакторе тегов, за

исключением объектов числового ввода.

Display last user screen on restart (отображение последнего пользовательского
экрана при перезапуске)

Задает, что экран будет отображать при перезагрузке терминала: последний

отображенный экран или экран запуска. Отображение экрана запуска является

значением по умолчанию.

Memory Card (блок памяти)

Задает, какое действие следует выполнять, если блок памяти вставлен в терминал.

• Always Load from Card – загружает приложение блока, если приложение

сконфигурировано с этой настройкой. Это – значение по умолчанию.

• Never Load from Card – не загружает приложение блока, если приложение

сконфигурировано с этой настройкой. Оператор должен затем выгрузить

конкретное приложение.

• Load from Card if Invalid Application detected – загружает приложение блока,

только если текущее приложение некорректно.

Если блок памяти не вставлен, или если блок имеет более одного приложения,

терминал перезагружается с приложением, которое выполнялось перед

перезагрузкой.

Use downloaded configuration settings (использование загруженных настроек
конфигурации)

Задает, хотите ли вы или нет использовать настройки конфигурации, загруженные с

приложением после перезагрузки терминала. Это – значение по умолчанию.
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Изменение формата даты и времени

Вы можете изменить формат, в котором время и дата отображаются на терминале

PanelView. Изменения влияют на любой объект, содержащий переменные времени или

даты.

Время может отображаться в 12 или 24-часовом формате с ведущими нулями и

секундами или без них. Вы можете также добавить или изменить условные

обозначения. Что касается даты, вы можете изменять порядок месяца, дня, года и

задавать, будет ли год появляться в 2 или 4-значном формате.

Для модификации настроек времени и даты:

• дважды щелкните пиктограмму Time / Date (время / дата) в папке Application

Settings (настройки приложения) или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Time/Date

Форматы даты

Месяц/День/Год

7/3/99

День/Месяц/Год

3/7/99

Год/Месяц/День

99/7/3

с ведущими нулями

07/03/99

с 4-значным годом

3/7/1999

другой разделитель

7*3*99

Форматы времени

12-часовой формат

2:56

24-часовой формат

14:56

с секундами

14:56:29

с суффиксами

2:56 AM или 23:50 CST

с ведущими нулями

03:56

другой разделитель

14*56*29

Формат времени и даты загружается с приложением на терминал, если выбрано Use

downloaded configuration settings (использование загруженных настроек

конфигурации) на закладке Power-Up (включение).
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Конфигурирование принтерного порта

Закладка Printer (принтер) диалогового окна Application Settings (настройки

приложение) конфигурирует порт RS-232 терминала PanelView для печати и включает:

• настройки порта

• конфигурацию принтера

Для модификации настроек принтера:

• дважды щелкните пиктограмму Printer в папке Application Settings или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Printer

Ниже приведены настройки порта по умолчанию. Эти настройки должны совпадать с

настройками вашего принтера.

Baud Rate (скорость передачи)

Data Bits (биты данных)

Stop Bits (стоп-биты)

Parity (четность)

Handshaking (квитирование)

9600

8

1

None

None

Указание: Квитирование не активизируется до тех пор, пока вы не перезагрузите

терминал.

Конфигурация принтера по умолчанию такова:

Left Margin (левое поле)

Page Width (ширина страницы)

Perforation Skip Value (значение пропуска перфорации)

End of Line Char (символ конца строки)

Page Length (длина страницы)

New Page Control (элемент управления новой страницей)

Printer Initialization String (строка инициализации принтера)

0

80

6

CR

66

Form Feed

Null

Настройки принтерного порта загружаются с приложением на терминал, если выбрано

Use downloaded configuration settings (использование загруженных настроек

конфигурации) на закладке Power-Up (включение).
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Преобразование приложения для другого типа терминала

Вы можете преобразовать приложение для запуска на другом терминале. Однако, вам

может понадобиться модификация свойств приложения, для приведения его в

соответствие с этим терминалом.

Для преобразования приложения для запуска на другом терминале:

• дважды щелкните пиктограмму Terminal Setup (настройка терминала) в папке

Application Settings (настройки приложения) или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Terminal Setup

Выберите терминал, для которого вы хотите преобразовать приложение. Когда вы

щелкаете OK, проверяется правильность приложения. Любые возникающие ошибки

или предупреждения будут появляться в окне Exceptions (исключения).

При преобразовании
приложения от:

сенсорного экрана к

клавиатуре

терминала одного размера к

терминалу другого размера

одного протокола к другому

протоколу

монохромного к цветному

или полутоновому

цветного к полутоновому

цветного к монохромному

поддерживающего к не

поддерживающему печать

терминалу

поддерживающего к не

поддерживающего сигналы

тревоги терминалу

Выполните следующее:

Назначьте функциональные клавиши объектам управления.

Переместите / промасштабируйте объекты или

отрегулируйте шаг сетки. В большинстве случаев вам

необходимо уменьшить количество объектов на экране.

Текстовые размеры преобразуются к наиболее плотному

размеру.

Модернизируйте параметры связи терминала и контроллера.

Модернизируйте по необходимости теги (адрес и имя узла).

В открывшемся диалоговом окне выберите цвет заднего

плана для экрана и цвета по умолчанию переднего / заднего

плана объектов. Текстовые размеры преобразуются к

наиболее плотному размеру.

Цвет заднего плана экрана преобразуется в черный. Цвета

преобразуются в градации серого. Цветные растры

преобразуются в полутоновые. Текстовые размеры

преобразуются к наиболее плотному размеру.

Задний план экрана преобразуется в белый, объекты

преобразуются в белые или черные, цветные растры

преобразуются в монохромные. Текстовые размеры

преобразуются к наиболее плотному размеру.

Атрибуты печати удаляются из соответствующих объектов.

Сообщение об ошибках генерируется для объектов Print Only

(только для печати), используемых приложением. Это

сообщение указывает на объект.

Генерируется сообщение об ошибке, указывающее, что

целевой терминал не поддерживает сигналы тревоги.

Удалите сигналы тревоги из приложения.
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Определение тегов управления, используемых контроллером

Теги управления используются контроллером для изменения текущих экрана или даты

и времени, отображаемых на терминале. Изменение экрана контроллера замещает

любой экран, просматриваемый в данный момент оператором. Время и дата

обновляются каждую минуту.

Для определения тегов управления:

• дважды щелкните пиктограмму Control Tags (теги управления) в папке Application

Settings (настройки приложения) или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Control Tags

Тег управления

Screen number

(номер экрана)

Date

(дата)

Time

(время)

Описание

Имя адреса тега, по которому контроллер осуществляет

запись номера экрана для изменения текущего экрана. Для

изменений экрана, контролируемых оператором адрес тега

Screen Number должен быть 0.

Имя адресов тегов, по которым контроллер осуществляет

запись текущих года, месяца и дня для дисплеев даты.

Значение тега Year (год) должно быть 2-значным (90-99 для

1990-1999 или 00-89 для 2000-2089).

Для поддержки соответствия Y2K релейно-контактная

логика должна перед отправкой значений на терминал

преобразовывать их следующим образом:

• если год <= 1999, релейно-контактная логика должна

вычитать 1900

• если год > 1999, релейно-контактная логика должна

вычитать 2000

Имя адресов тегов, по которым контроллер осуществляет

запись текущих часа, минут и секунд для дисплеев времени.

После ввода имени тега щелкните кнопку Edit Tag (редактирование тега) диалогового

окна для ввода атрибутов тега. Тип данных тега должен быть беззнаковым целым.
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Определение тегов статуса, используемых контроллером

Теги статуса, используемые контроллером для осуществления контроля или чтения

номера экрана или даты и времени.

Время и дата обновляются каждую минуту. Вы можете изменить Time/Date Output

Interval (интервал вывода времени/даты) значением в диапазоне 1 – 60 минут.

Увеличение интервала уменьшает сетевой трафик, но также и точность времени.

Для определения тегов статуса:

• дважды щелкните пиктограмму Status Tags (теги статуса) в папке Application

Settings (настройки приложения) или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Status Tags

Тег статуса

Screen number

(номер экрана)

Date

(дата)

Time

(время)

Описание

Имя адреса тега, по которому терминал осуществляет запись

номера текущего экрана. Контроллер может осуществлять

чтение этого номера.

Имя адреса тега, по которому терминал осуществляет запись

текущих года, месяца и дня. Значение тега Year (год) должно

быть 2-значным (90-99 для 1990-1999 или 00-89 для

2000-2089).

Перед отправкой значений контроллеру релейно-контактная

логика должна преобразовывать их следующим образом:

• добавлять 1900 для 2-значного года (90-99)

• добавлять 2000 для 2-значного года (00-89)

Имя адресов тегов, по которым терминал осуществляет

запись текущих часа, минут и секунд для дисплеев времени.

После ввода имени тега щелкните кнопку Edit Tag (редактирование тега) диалогового

окна для ввода атрибутов тега. Тип данных тега должен быть беззнаковым целым.
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Предоставление возможности использования внешних шрифтов

Вы можете вводить текст приложения на другом языке (или символьном наборе),

используя шрифтовой файл (*.OTF), характерный для этого языка. Шрифтовой файл

создается вне PanelBuilder32 с использованием утилиты FontTool. Вы должны

предоставить возможность использования шрифтового файла в PanelBuilder32 перед

тем, как вы сможете использовать его символьный набор.

Для предоставления возможности использования шрифтового файла:

• дважды щелкните пиктограмму External Fonts (внешние шрифты) в папке

Application Settings (настройки приложения) или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку External Fonts

Выберите опцию External Fonts Enabled (разрешение внешних шрифтов), а затем под

External Font File (файл внешнего шрифта) выберите шрифтовой файл, который вы

хотите использовать.

На закладке External Fonts вы можете также преобразовать текст, который появляется

в Numeric Scratchpad (числовом блокноте) так, чтобы он появлялся на верном языке

на терминале PanelView. Выберите опцию Use Custom Text (использование

специального текста) для преобразования (или редактирования) текста числового

блокнота.

Текстовые размеры символьного набора шрифтового файла заключены в скобки в

нижней части меню текстовых размеров. В этом случае вы можете просто определить

текстовые размеры шрифтового файла из текстовых размеров PanelBuilder32 по

умолчанию.

См. главу 6 для получения более подробной информации по вводу текста на других

языках.
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Настройка дополнительных опций терминала

Закладка Advanced (дополнительные) диалогового окна Application Settings

(настройки приложения) определяет значения по умолчанию настроек конкретного

терминала. Вы не будете иметь доступа к этой закладке до тех пор, пока вы не

захотите:

• изменить настройки автоповтора функциональных клавиш / сенсорных ячеек

(используется только клавишами со стрелками вверх / вниз для перемещения

курсора по спискам)

• отрегулировать настройки интенсивности дисплея (интенсивность дисплея,

реверсивное изображение)

• предоставить возможность использования режима хранителя экрана

• выбрать язык, отличный от английского, для сообщений терминала

• изменить период квитирования, используемый объектами с тегами квитирования

• изменить график обслуживания для восстановления дисплея монохромного

терминала PanelView 900 или размагничивания PanelView 1400.

Для изменения любой из дополнительных настроек:

• дважды щелкните пиктограмму Advanced в папке Application Settings или

• выберите Application (приложение) > Settings (настройки), а затем щелкните

закладку Advanced

На появившейся закладке показаны поля, характерные для вашего терминала. Для

получения дополнительной информации о дополнительных опциях щелкните кнопку

Help (справка) диалогового окна или для получения более подробной информации о

конкретном поле нажмите F1, находясь в этом поле.

Любые сделанные вами изменения загружаются с приложением на терминал, если

выбрано Use downloaded configuration settings (использование загруженных настроек

конфигурации) на закладке Power-Up (включение).
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11 Передача приложений

В этой главе охвачены:

• способы передачи приложений

• использование блока памяти

• драйверы связи

• проверка приложения

• загрузка приложения непосредственно на терминал

• загрузка приложения по сети

• загрузка приложения в блок памяти

• выгрузка приложения непосредственно из терминала

• выгрузка приложения по сети

• использование File Transfer Utility (утилиты передачи файлов)

Для получения исчерпывающей информации о загрузке и выгрузке приложений в

основной справочной системе откройте книгу Transferring Applications (передача

приложений) на закладке Contents (содержание).

Способы передачи приложений

Вы можете передавать приложения между компьютером и терминалом PanelView или

блоком памяти, используя:

• команды File (файл) > Download (загрузить) или File > Upload (выгрузить) в

PanelBuilder32

• File Transfer Utility (утилиту передачи файлов) вне PanelBuilder32

В случае использования File Transfer Utility вы должны в первую очередь сохранить

ваше приложение как файл .PVA, используя команду File > Save As (сохранить как). File

Transfer Utility загружает файлы только в формате PanelView Terminal .PVA.

Указание: Вы можете также использовать команду File > Save As в PanelBuilder32

для сохранения файла .PVA непосредственно с помощью устройства для

блоков памяти ATA.
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Использование блока памяти

Приложения могут быть загружены в блок памяти на компьютере с DataBook

TMB240/TMB250 или ATA-совместимым устройством для блоков памяти.

• Устройства ATA поддерживают следующие блоки Allen-Bradley: -NM24, -NM28.

• Устройства DataBook поддерживают следующие блоки: 2711-NM11, -NM12, -NM13,

-NM14.

Вы можете вставить блок памяти в слот для блоков терминала PanelView и выгрузить

приложение на терминал в меню терминала Configuration Mode (режим

конфигурации). С помощью блоков памяти вы можете выгрузить приложение на

несколько терминалов системы без необходимости в компьютере.

Если ваш компьютер не имеет устройства для блоков ATA, вы все же можете

использовать блок памяти. Загрузите приложение на терминал. Осуществите передачу

загруженного на терминал приложения в блок памяти. Затем перенесите этот блок

памяти на другие терминалы системы и загрузите приложение.

Драйверы связи

Перед передачей приложений между компьютером и терминалом PanelView вы

должны иметь инсталлированный на ваш компьютер соответствующий драйвер связи.

Драйвер устанавливает связи, необходимые для передачи файлов. Требуемый драйвер

зависит от сетевой конфигурации.

Использование внутреннего драйвера DF1

Для передачи приложения типа точка-точка между последовательным COM-портом

вашего компьютера и портом RS-232/DF1 терминала PanelView используйте

внутренний PanelBuilder32 драйвер DF1. Этот драйвер доступен, когда вы загружаете

или выгружаете приложение. Вы не можете сделать ничего кроме этого. Драйвер DF1

использует фиксированные настройки, совпадающие с настройками терминала

PanelView.

Baud Rate (скорость передачи)

Parity (четность)

Error Detect (обнаружение ошибок)

Stop Bits (стоп-биты)

Protocol (протокол)

19200

None

CRC

1

Full Duplex
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Вы не можете использовать драйвер DF1 для передачи приложений между

компьютером и терминалом DH-485 или RS-232 (DH-485) PanelView. Вы должны

использовать драйвер RSLinx 1747-PIC Device.

Важно: Драйвер DF1 не будет доступен, если любой из последовательных

портов вашего компьютера сконфигурирован для использования

драйвера RSLinx.

Использование драйверов RSLinx

Для передачи приложений по сети или между двумя различными коммуникационными

сетями, вы должны сконфигурировать соответствующий драйвер RSLinx на вашем

компьютере. RSLinx инсталлируется как часть инсталляции PanelBuilder32.

Для доступа к RSLinx:

• щелкните кнопку Start (пуск), щелкните Programs (программы), щелкните Rockwell

Software, щелкните подменю RSLinx и выберите RSLinx.

• или в PanelBuilder32 щелкните File (файл) > Workstation Setup (настройка рабочей

станции).

Для получения более подробной информации о том, как сконфигурировать драйвер

RSLinx, обратитесь к интерактивной документации RSLinx. В основном, вы будете

конфигурировать драйвер, выбирая Communications (связи) > Configure Drivers

(драйверы конфигурации).



Передача приложений

11-4

Проверка приложения

Приложение автоматически проверяется на наличие ошибок при загрузке на

терминал. Вы можете также проверить приложение, выбрав команду Validate All

(проверить все) или Validate Changes (проверить изменения) в меню Application

(приложение). Если во время проверки возникает ошибка или предупреждение,

открывается окно Exceptions (исключения). Вы должны исправить ошибки;

предупреждения носят информативный характер. Предупреждения не влияют на

целостность приложения.

После открытия окна Exceptions меню Exceptions становится доступным. Это меню

имеет команды, которые действуют на ошибки / предупреждения в окне или на само

окно. Просто выберите ошибку или предупреждение, а затем выберите команду в

меню Exceptions (или щелкните правой кнопкой и выберите команду в контекстном

меню).

Выберите:

GoTo (переход)

Details (параметры)

Suppress Selected

Warning (подавление

выбранного

предупреждения)

Suppress Warnings

(подавление

предупреждений)

Print All (печать

всего)

Docking View

(пристыковка обзора)

Для:

Перемещения к источнику выбранной ошибки.

Отображения справки о выбранной ошибке.

Подавления отображения выбранного предупредительного

сообщения в окне Exceptions.

Подавления появления сообщений для конкретных кодов

предупреждения в окне Exceptions. Вы не можете подавлять

сообщения об ошибках.

Печати всех ошибок и предупреждений в окне Exceptions.

Пристыковки окна Exceptions к краю окна или для предоставления

окну возможности свободно перемещаться как любому другому

окну.

Меню Exceptions остается активным до тех пор, пока окно Exceptions не будет закрыто

с помощью меню View (обзор) или щелчком X в углу окна.
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Контроль хода загрузки или выгрузки

При загрузке и выгрузке приложения открывается диалоговое окно, так что вы можете

контролировать ход передачи.

• Область Download Tasks (выгрузка задач) контролирует каждый этап,

выполняемый во время передачи, и показывает текущую задачу.

• Область Status (статус) показывает любые ошибки, которые возникают во время

передачи. Вы можете дважды щелкнуть на любой ошибке для получения справки.

• Шкала Progress (прогресс) показывает ход передачи в процентах.

В ходе загрузки или выгрузки терминал PanelView также показывает статус передачи.

Показывает текущую задачу,

выполняемую во время

загрузки или выгрузки

Показывает статус каждой

задачи

Щелкните для отмены

передачи

Для получения справки

дважды щелкните на

любой появившейся

ошибке
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Загрузка приложения непосредственно на терминал

В этом разделе показано, как загрузить приложение от последовательного COM-порта
вашего компьютера к порту RS-232/DF1 терминала PanelView, используя соединение
точка-точка. Загрузка использует внутренний драйвер DF1 порта COM1-COM9 вашего
компьютера. Используйте кабель 2711-NC13 (9-контактный разъем) для соединения
точка-точка. Проверьте подсоединения кабеля перед началом загрузки.

Важно: Для передачи приложений между компьютером и терминалом DH-485
или RS-232 (DH-485) PanelView вы должны использовать драйвер RSLinx
1747-PIC Device, а не внутренний драйвер DF1.

Откройте приложение, которое вы хотите загрузить и выберите File (файл) > Download
(загрузить). Приложение проверяется во время загрузки. Любые ошибки, которые
появляются во время проверки, должны быть исправлены, перед тем как вы
продолжите загрузку.

По завершении загрузки терминал перезапускается, проверяет и запускает
приложение.

Имя загружаемого
приложения

Выберите COM-порт для
загрузки

Запуск загрузки



Передача приложений

11-7

Загрузка приложения по сети

Для загрузки приложения по сети или между различными сетями используются

драйверы RSLinx. Соответствующий драйвер RSLinx должен быть сконфигурирован и

запущен на вашем компьютере.

Для получения списка поддерживаемых сетевых конфигураций для терминалов

PanelView в основной справочной системе откройте книгу Transferring Applications

(загрузка приложений) на закладке Contents (содержание) и выберите RSLinx Network

Paths (сетевые пути RSLinx).

Откройте приложение, которое вы хотите загрузить и выберите File (файл) > Download

(загрузить). Приложение автоматически проверяется. Любые возникающие ошибки

должны быть исправлены перед тем, как вы сможете продолжить загрузку.

Указание: Вы можете также выгрузить файл в диалоговом окне запуска, когда вы

впервые входите в PanelBuilder32. Так как файл не открыт, вам будет

предложено ввести приложение, сохраненное в формате .PVA

терминала PanelView.

По завершении загрузки, терминал перезагружается, проверяет и запускает

приложение.

Имя загружаемого приложения

Выберите RSLinx Network (сеть

RSLinx) для загрузки приложения

по сети

Драйверы RSLinx на компьютере

Щелкните + для показа устройств

для каждого драйвера или - для

свертывания просмотра

Выберите целевой узел для

загрузки

Показывает список или графическое представление

устройств в сети для выбранного драйвера
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Использование Remote I/O Pass-Through

Для передачи приложения между компьютером и терминалом PanelView по сети

Remote I/O выберите Remote I/O Pass-Through в качестве Transfer Type (тип передачи)

в диалоговом окне Download (загрузка) или Upload (выгрузка). Щелкните кнопку Setup

(настройка) для конфигурации параметров, показанных ниже.

Важно: Опция Pass-Trought (ретрансляция) должна быть выбрана в диалоговом

окне Block Transfer (блочная передача) диалогового окна

Communication Setup (настройка связи).

 !
ВНИМАНИЕ:  Если загрузка с процессором находится в режиме

выполнения, проверьте адрес рэка RIO терминала загрузки. Загрузка

по неверному адресу рэка может привести к непредсказуемому

функционированию или повреждению оборудования.

Тип сканирования PLC или 1756-DH RIO

Тип сканирования SLC

Параметры PLC

Rack Address

(адрес рэка)

Starting Module

(модуль запуска)

Для PLC Scanner Type (тип сканера

PLC) выберите адрес рэка (0 – 76

восьм.) PanelView связи

Remote I/O.

Выберите группу модулей запуска

(0,1 2,3 4,5 или 6,7) PanelView рэка

Remote I/O.

Параметры SLC

SLC Scanner

Location

(местоположение

сканнера SLC)

Rack Address

(адрес рэка)

Starting Module

(модуль запуска)

Выберите номер слота, где

размещен сканнер SLC. Значение

по умолчанию – самый левый слот

(блок сканнера ближе всего к

процессору).

Задайте адрес рэка PanelView в

сети Remote I/O.

Выберите группу модулей запуска

(0,1 2,3 4,5 или 6,7) PanelView рэка

Remote I/O.
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Загрузка приложения в блок памяти

В этом разделе описано, как загрузить приложение в блок памяти. Откройте

приложение, которое вы хотите загрузить, и выберите File (файл) > Download

(загрузить). Приложение автоматически проверяется, преобразуется и копируется в

блок в формате .PVA терминала PanelView.

Указание: Вы можете также использовать команду File > Save As (сохранить как) в

PanelBuilder32 для сохранения файла .PVA непосредственно с помощью

устройства для блоков ATA.

Выберите Memory Card (блок

памяти) и щелкните Setup

(настройка)

Для блоков ATA
2711-NM22, -NM24, -NM26

Введите имя файла .PVA, предназначенного

для сохранения преобразованного

приложения .PBA, или щелкните Browse

(поиск) для поиска файла

Для линейных Flash-блоков
2711-NM11, -NM12, -NM13, -NM14

Для устройств для блоков DataBook TMB240

или TMB250 вы должны ввести следующую

командную строку:

CMD %s Drive:

CMD

%s

Drive:

Команда DOS, которая копирует файл в блок.

Команда характерна для конкретного

устройства. См. инструкции к вашему

устройству для блоков.

Символ-шаблон, который PanelBuilder32

заменяет именем файла приложения.

Устройство для блоков на вашем компьютере

(F:)

Пример: TCXCOPY %S F:

При последующей загрузке в блок памяти вы можете просто выбрать

командную строку в окне.
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Выгрузка приложения непосредственно с компьютера

В этом разделе показано, как выгрузить приложение из порта RS-232/DF1 терминала

PanelView в последовательный COM-порт вашего компьютера, используя соединение

точка-точка. При загрузке используется внутренний драйвер DF1 порта COM1 – COM9

вашего компьютера. Используйте кабель 2711-NC13 (9-контактный разъем) для

соединения точка-точка. Проверьте подсоединения кабеля перед началом загрузки.

Важно: Для передачи приложения между компьютером и терминалом DH-485

или RS-232 (DH-485) PanelView вы должны использовать драйвер RSLinx

1747-PIC Device, а не внутренний драйвер DF1.

Для выгрузки приложения выберите File (файл) > Upload (выгрузить). Вы можете

также выгрузить файл в диалоговом окне запуска при первом использовании

PanelBuilder32.

По завершении выгрузки приложение открывается в PanelBuilder32, если только вы не

выгружаете приложение в дисковый файл.

Выберите пункт назначения для выгружаемого файла:

• дисковый файл (без открытия в PanelBuilder32)

• дисковый файл с последующим открытием в PanelBuilder32

• открывается в PanelBuilder32 (без сохранения на диск)

Выгружает файл в местоположение по умолчанию или в

другое местоположение

Выгружает файл с исходным именем файла или задает

другое имя файла

Выберите COM-порт для использования при выгрузке

Выберите предустановленные значения для выгрузки с приложением
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Выгрузка приложения по сети

В этом разделе показано, как выгружать приложения по сети или между различными

сетями, используя драйверы RSLinx. Соответствующий драйвер RSLinx должен быть

сконфигурирован и запущен на вашем компьютере. Для выгрузки приложения

выберите File (файл) > Upload (выгрузить).

Для получения списка поддерживаемых сетевых конфигураций для терминалов

PanelView в основной справочной системе откройте книгу Transferring Application

(загрузка приложений) на закладке Contents (содержание) и выберите RSLinx Network

Paths (сетевые пути RSLinx).

По завершении выгрузки приложение открывается в PanelBuilder32, если только вы не

выгружаете приложение в дисковый файл.

Выберите пункт назначения для выгружаемого файла:

• дисковый файл (без открытия в PanelBuilder32)

• дисковый файл с последующим открытием в PanelBuilder32

• открывается в PanelBuilder32 (без сохранения на диск)

Выгружает файл в местоположение по умолчанию или в

другое местоположение

Выгружает файл с исходным именем файла или задает

другое имя файла

Выберите RSLinx Network (сеть RSLinx) для выгрузки

приложения по сети

Выберите предустановленные значения для выгрузки с

приложением

Драйверы RSLinx на компьютере

Щелкните + для показа устройств для каждого драйвера или

– для свертывания просмотра

Выберите узел PanelView, предназначенный для выгрузки

приложения

Показан список графических представлений устройств в

сети для выбранного драйвера
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Использование File Transfer Utility

Используйте File Transfer Utility (утилиту передачи файлов) для передачи приложений

между терминалом и компьютером в Windows без открытия PanelBuilder32.

Важно: File Transfer Utility загружает файлы только в формате .PVA терминала

PanelView. Используйте команду File (файл) > Save As (сохранить как) в

PanelBuilder32 для сохранения приложений в этом формате.

Для открытия File Transfer Utility выберите Programs (программы) > PanelBuilder >

WinPFT в меню Start (пуск).

Диалоговое окно Download File (загрузка файла) утилиты File Transfer Utility

одинаково с диалоговым окном, используемым в PanelBuilder32, с несколькими

исключениями.

• Вы должны ввести имя файла .PVA для загрузки, так как File Transfer Utility

загружает приложения только в формате .PVA терминала.

• Вы можете выбрать для загрузки приложение, только если оно отлично от

приложения, загруженного на целевой терминал PanelView.

Диалоговое окно Upload File (выгрузка приложения) идентично диалоговому окну

Upload File в PanelBuilder32.

Выгружает приложение с терминала на

ваш компьютер

Сравнивает приложение с

приложением на терминале или в

дисковом файле на различия

Выгружает файл .PVA на терминал или в блок памяти
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Проверка приложения

Щелкните Verify (проверить) в диалоговом окне File Transfer Utility (утилиты передачи

файлов) для сравнения приложения, которое вы хотите загрузить, с приложением,

загруженным на терминал PanelView или в дисковый файл. Вы можете осуществить

проверку на наличие различий перед загрузкой приложения на терминал. Вы также

имеете возможность загрузки приложения, если начальное приложение отлично от

приложения, загруженного на терминал.

Введите или выберите имя файла .PVA,

который вы хотите сравнить с

приложением на терминале или в

дисковом файле

Выберите целевое местопо-

ложение приложения для Verify

• DF1 Point-to-Point

• RSLinx Network или Remote I/O Pass-

Through

• Application on Disk

Введите или найдите дисковый

файл, который вы хотите сравнить с

эталонным приложением

Выберите узел терминала PanelView,

который вы хотите сравнить с эталонным

приложением

Выберите для загрузки приложения на терминал, если оно отлично от

загруженного на терминал приложения
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A

Ack alarm button, 5-6

Ack All alarm button, 5-6

alarm banner

adding an alarm list, 5-3

adding buttons, 5-3

clearing, 5-2

creating, 5-3

default colors, 5-3

description, 5-2

disabling objects when banner opens, 5-2

showing the location, 5-3

sizing, 5-3

which objects are disabled, 5-7

alarm buttons

Ack, 5-6

Ack All, 5-6

Clear, 5-6

Clear Alarm List, 5-6

Print, 5-6

Print Alarm List, 5-6

where you can use them, 5-6

alarm list

changing the default size, 5-7

creating, 5-5

defining data to include with each alarm, 5-5

description, 5-4

maximum size, 5-4

multiple display options, 5-5

printing, 5-5

what happens when its full, 5-5

alarm messages

attributes, 5-9

defining, 5-9

alarm triggers, 5-8

alarms, 4-4

data to print with triggered alarms, 5-7

defaults that apply to all alarms, 5-7

defining triggers, 5-8

descriptions, 5-1

examples, 5-9

messages, 5-9

remote tags used by controller to clear or

acknowledge alarms, 5-7

safety, 5-1

aligning

objects, 4-7

text, 6-7

application window

alarms folder, 2-3

application settings folder, 2-3

docked or floating, 2-2

screens folder, 3-4

system folder, 2-3

what it is and what it looks like, 2-2

applications

closing, 3-8

converting, 10-6

creating, 3-2

default save location, 2-9

defining the startup screen, 3-4

displaying version number, 3-7

downloading, 11-1

enabling font file, 10-9

entering a description, 3-2

entering text in another language, 6-14

network communciation settings, 10-1

opening, 3-3

power-up settings, 10-3

renaming, 3-2

reports, 3-8

save date, 3-7

save defaults, 2-9

saving, 3-7

saving backup files, 2-9, 3-7

screens, 3-4
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uploading, 11-1

validating, 11-4

ASCII entry controls, 4-3

cursor point, 4-18

initial value, 4-18

keypad enable button, 4-18

scratchpad, 4-19

B

Backup .BAK files, 3-1

bar graphs, 4-24

bitmaps

adding to a screen, 7-2

copying to the clipboard, 7-5

deleting from graphics list, 7-6

exporting, 7-4

importing, 7-4

inserting in object, 7-3

pasting from the clipboard, 7-5

removing from an object, 7-3

blinking

objects, 8-2

text, 6-7

block write data, 4-15

C

character variable

adding to text, 6-5

Clear alarm button, 5-6

Clear Alarm List button, 5-6

color

applying to graphics, 8-5

applying to objects, 8-4

applying to text, 8-4

color palette, 8-3

color palette, 2-7, 8-3

communication drivers

DF1, 11-2

RSLinx, 11-3

communications

supported protocols, 10-1

contents of manual, P-2

control list selectors, 4-2

editing states, 4-15

list keys, 4-14

piloted, 4-14

standard, 4-14

control tags, 10-7

converting applications for other terminals, 10-6

cursor point

ASCII entry controls, 4-18

numeric entry, 4-16

D

data displays, 4-3

bar graphs, 4-24

list indicators, 4-25

multistate indicators, 4-24

numeric data displays, 4-25

scaling, 4-25

data tips

defining for objects, 2-9, 4-8

displaying, 4-8

description

for a screen, 3-4

for an object, 4-10

for application, 3-2

downloading applications

communication drivers, 11-2

direct connection, 11-6, 11-10

over a network, 11-7

Remote I/O Pass-Through, 11-8

using a memory card, 11-9

using WinPFT File Transfer utility, 11-12

validating, 11-4

dragging

objects, 4-8

screens, 3-6

dropping objects

changing the default drop mode, 4-9

default mode, 4-9

on a function key, 4-9

on a screen, 4-9
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E

exiting PanelBuilder32, 1-3

exporting

bitmaps, 7-4

tags, 9-8

F

file types

.BAK, 3-1

.OTF, 6-14

.PBA, 3-1

.PVA, 3-1

flipping objects horizontally or vertically, 4-7

font files

creating, 6-15

enabling, 6-18, 10-9

running application with a font file, 6-18

saving to disk or memory card, 6-17

to create text in another language, 6-14

using in PanelBuilder32, 6-18

FontTool utility, 6-14

creating a font file, 6-15

enabling font files in PanelBuilder32, 6-18

saving font files, 6-17

format toolbar, 8-2

formatting objects

changing fill, 8-2

changing line type, 8-2

changing shape, 8-2

format toolbar, 8-2

making them blink, 8-2

toggling the foreground and background, 8-2

function keys

auto-assigning, 4-10

enabling or disabling auto-assignment, 2-9

G

global objects

description, 4-26

making an object global, 4-10

reusing, 4-26

goto config screen button, 4-20

goto screen button, 4-20

graphic tools

circle, 7-1

connected line, 7-1

ellipse, 7-1

graphic image, 7-1

line, 7-1

rectangle, 7-1

graphics, 4-4

adding bitmaps to a screen, 7-2

applying color, 8-5

changing background color, 8-5

changing foreground color, 8-5

exporting, 7-4

importing, 7-4

inserting a bitmap in an object, 7-3

removing from an object, 7-3

reversing foreground/background colors, 8-5

grid

changing the default spacing, 2-4, 3-4

default grid spacing, 2-4

showing or hiding, 2-4

grouping and ungrouping objects, 4-6

H

help

available, 2-10

context-sensitive, 2-11

context-senstive help for menu commands and

icons, 2-5

dialog, 2-11

general, 2-10
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I

importing

bitmaps, 7-4

tags, 9-8

inactive states, piloted control list, 4-15

indicators, 4-3

inner text

adding variables, 6-3

changing background color, 8-4

changing foreground color, 8-4

default, 6-1

editing, 6-2

inner text toolbar, 6-7

Input Method Editor, 6-14

installation

16-bit version, 1-1

32-bit version, 1-1

CD ROM, 1-2

setup options, 1-2

system requirements, 1-1

ISA symbols

adding to a screen, 7-2

showing the toolbox, 7-2

K

keypad enable button

ASCII entry, 4-18

numeric entry, 4-16

L

language support, 6-14

latched push button, 4-12

list indicators, 4-25

list keys, 4-4, 4-21

logic controller

defining network communications, 10-2

M

maintained push button, 4-12

manuals

related, P-3

memory card, 11-2

message displays, 4-22

configuring messages to print only, 4-23

editing messages, 4-23

triggering, 4-22

momentary push button, 4-12

multistate indicators, 4-24

multistate objects

configuring states, 4-11

multistate push button, 4-12

N

numeric data displays, 4-25

numeric entry controls, 4-2

initial value, 4-16

keypad enable button, 4-16

scaling data, 4-17

scratchpad, 4-17

numeric variable

adding to text, 6-4

editing, 6-4

format, 6-4

O

objects

accessing, 2-4

activating blinking, 8-2

aligning horizontally or vertically, 4-7

changing background color, 8-4

changing fill, 8-2

changing foreground color, 8-4

changing line type, 8-2

changing shape, 8-2

changing the drop mode, 2-9

configuring properties, 4-10

configuring states, 4-11
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copying or moving, 4-8

creating, 4-9

data tips, 4-8

default drop mode, 4-9

dragging, 4-8

enabling or disabling data tips, 2-9

entering a description, 4-10

entering tag names, 4-10

entering tags, 4-10

flipping horizontally or vertically, 4-7

formatting, 8-1

graphics, 7-1

grouping/ungrouping, 4-6

hiding its view, 4-10

making it global, 4-10, 4-26

moving, 4-5

overview, 4-2

selecting and deselecting, 4-5

sizing, 4-5

spacing, 4-7

stacking, 4-6

toggling foreground/backround colors, 8-2

type and description, 4-2

zooming in or out, 4-7

P

PanelBuilder Selected Tags Format

exporting tags, 9-12

importing tags, 9-10

piloted control list

block write data, 4-15

inactive states, 4-15

restricting access, 4-15

power-up settings

display screen on a restart, 10-3

if memory card loaded, 10-3

object preset values, 10-3

startup screen, 10-3

use terminal defaults or settings downloaded

with application, 10-3

preset values for objects, 10-3

Print alarm button, 5-6

Print Alarm List button, 5-6

print only messages, 4-23

printer port

configuring, 10-5

defaults, 10-5

properties

objects, 4-10

screens, 3-4

publications

related, P-3

push buttons, 4-2

latched, 4-12

maintained, 4-12

momentary, 4-12

multistate, 4-12

safety considerations, 4-13

states, 4-13

text, 4-13

R

remote alarm tags used by logic controller, 5-7

reports

changing the format, 2-9, 3-8

defining topics to include, 2-9

printing, 3-8

topics to include, 3-8

return screen button, 4-20

S

saving

16-bit .PVA file, 3-7

as a 16-bit .PBA file, 3-7

standard .PBA file, 3-7

scratchpad

ASCII entry controls, 4-19

numeric entry, 4-17

screen list selector, 4-20

editing screen entries, 4-21

linking screens to entries in list, 4-21

list keys, 4-20, 4-21

selecting a screen, 4-20
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У-6

screen saver, 10-10

screen selectors, 4-3

goto config screen button, 4-20

goto screen button, 4-20

return screen button, 4-20

screen lists, 4-20

screen window, 2-4

screens

activating, 3-5

changing properties, 3-5

changing the properties, 3-4

closing, 3-5

controller screen changes, 4-21, 10-7

copying,cutting,pasting, 3-5

creating, 3-4, 3-5

deleting, 3-5

dragging and dropping, 3-6

monitoring screens by controller, 10-8

opening, 3-5

properties, 3-4

screen folder, 3-4

selecting, 3-5

startup screen, 3-4

workbook mode, 3-6

zooming in or out, 4-7

spacing objects, 4-7

stacking objects, 4-6

standard control lists, 4-14

starting PanelBuilder32, 1-3

startup dialog, 2-1

disabling or enabling, 2-1, 2-9

status tags, 10-8

T

tag editor

copying, cutting, pasting, deleting tags, 9-6

defining defaults for tag fields, 2-9

duplicating tags, 9-6

exiting, 9-2

feezing columns, 9-2

finding text, 9-7

moving columns, 9-2

opening, 9-1

printing tags, 9-7

saving tags, 9-5

selecting tags, 9-5

showing extended attributes, 9-4

sorting tags, 9-7

tag attributes, 9-4

Tag Form dialog, 9-3

Tag Form dialog, 9-3

tags

adding, 9-5

attributes, 9-4

copying,cutting, pasting, deleting, 9-6

defining defaults for duplicating, 2-9

duplicating, 9-6

entering, 9-3

entering in Tag Form dialog, 9-3

exporting, 9-8

finding text in column, 9-7

importing, 9-8

printing, 9-7

project folder, 9-14

saving, 9-5

selecting, 9-5

sharing, 9-14

showing extended attributes, 9-4

sorting a single or multiple columns, 9-7

using a project, 9-14

terminal

adjusting display intensity, 10-10

adjusting display maintenance schedule, 10-10

autorepeat settings for keys, 10-10

changing language for terminal messages, 10-10

configuring printer port, 10-5

defining network communications, 10-2

selecting a default, 2-9

time and date format, 10-4

using a screen saver, 10-10
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text

activating blinking, 6-7

adding to screen, 6-6

adding variables, 6-3

aligning, 6-7

changing background color, 8-4

changing foreground color, 8-4

changing size, 6-7

default inner text, 6-1

editing for multistate objects, 6-2

entering in an object, 6-2

inner text toolbar, 6-7

object, 4-4

sizing, 6-7

toggling foreground/background, 6-7

underlining, 6-7

using the text editor, 6-9

text editor, 6-9

adding or editing text, 6-10

copying text into objects, 6-13

deleting text, 6-12

inserting variables in text, 6-10

moving text, 6-12

printing text, 6-12

renumbering text strings, 6-11

sorting text, 6-11

time or date

adding a variable to text, 6-3

changing from controller, 10-7

changing the format, 10-4

default format, 6-3

monitoring from controller, 10-8

toolbars

color palette, 2-7

docked or floating, 2-5

format, 2-6

graphic, 2-6

inner text, 2-6

ISA symbols, 2-6

showing or hiding, 2-5

standard, 2-6

state, 2-6

toolbox, 2-7

toolbox, 2-7

tooltips

enabling or disabling, 2-5

how to use, 2-5

touch grid, 2-4

U

underlining text, 6-7

uploading applications

direct connection, 11-10

over a network, 11-11

Remote Pass-Through, 11-8

using WinPFT File Transfer utility, 11-12

validating, 11-4

V

validating application, 11-4

variables, 4-3

character, 6-5

numeric, 6-4

time or date, 6-3

W

WinPFT File Transfer utility, 11-1

downloading applications, 11-12

uploading applications, 11-12

verifying applications, 11-13

workbook mode

enabling or disabling, 3-6

screens, 3-6

Z

zooming, 4-7
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